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About the Documentation
ix

This guide contains an overview of Attachmate’s INFOConnect 
suite, including general information about each component. (This 
guide covers the entire suite, so it might include information about 
products you have not purchased.)

This preface includes the following headings:

Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . x

Related Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xi



About the Documentation

Conventions

This guide uses the following documentation conventions:

■ Text that you type as well as messages and prompts that 
appear on the screen appear in this type style .

■ In addition to emphasizing text and highlighting terms used for 
the first time, italics indicate variables. For example, if you 
x Conventions

were asked to type drive:\directory\filename.ext, you would 
enter the actual drive, directory, and file name in place of the 
italicized words.

■ When you see two keys shown one after another connected by a 
plus sign, as in Alt+h, press and hold down the first key (Alt), 
then press the second key (h). Then release both keys.

When you see two keys separated by a space, as in Ctrl Delete, 
press and release the first key (Ctrl), then press and release the 
second key (Delete).

■ The word PC refers to any personal computer running 
Windows® 95 or Windows NT®.

■ The word host refers to any mainframe, mini-computer, or 
information hub with which the PC communicates within the 
INFOConnect framework.

■ Windows often provides several ways to select an option. For 
example, you can click a button using a mouse, press Enter 
when a particular button has the focus, or press an accelerator 
key. Even though other ways might exist, this guide usually 
explains how to select options by clicking a mouse.
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Related Documentation

Additional information exists in the form of Readme files, guides, 
online Help.

Readme Files Each product has its own Readme file. This file includes important 
notices, known limitations, and the latest information that could 
not be included in the guides or online Help. Most Readme file 
Related Documentation xi

names begin with README followed by a unique extension. For 
example, the Readme file for Accessory Manager is 
README.ACM.

If you double-click these files in My Computer or File Manager, 
your PC might not recognize the file extension. Select Notepad as 
the application to use to read the file.

Guides Your INFOConnect emulators come with the following additional 
documentation:

■ The INFOConnect Getting Started guide explains how to install 
your INFOConnect products and get them up and running.

■ The INFOConnect CASL Script Language Guide describes the 
procedures and language used in creating CASL macros.

■ The INFOConnect Connectivity Services Installation, 
Configuration, and Operations Guide provides information 
about INFOConnect paths, path templates, libraries, and 
accessories.

Online Help The online Help provides detailed information about each product, 
including conceptual overviews and step-by-step procedures for 
configuring and using the products.
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Emulator Help If you purchased an emulator (such as InterCom or PEP), you can 
access the online Help using any of the following methods:

■ From the Help menu on the Accessory Manager application 
window, click the desired item:

This item Displays this

Accessory Manager Help The table of contents, index, and full text 
search options for the online Help for 
Accessory Manager, all emulators, and 32-bit 
xii Related Documentation

■ On the application window, click on the toolbar. The cursor 
changes into an arrow and a question mark. When you click any 
menu item, toolbar button, or other component of the 
application window, online Help for that item appears.

■ On any dialog box, click  in the upper right corner of the 
title bar. The cursor changes into an arrow and a question 
mark. When you click any item on the dialog box, online Help 
for that item appears.

■ On any dialog box, press F1. This displays context-sensitive 
Help for the item where the cursor is located.

■ On the application window or any dialog box, right click the 
item you want more information about and click What’s This 
from the pop-up menu.

■ On any dialog box, click Help (when a Help button is available).

■ From My Computer or File Manager, double-click the desired 
Help file in the ACCMGR32 folder.

transports

Administrative Help The table of contents, index, and full text 
search options for the online Help for security 
and remote and local folder settings

Note: This item appears in the Help menu only 
if you performed a standalone installation or a 
shared installation. Users who run 
NETSETUP or USRSETUP do not have 
access to this menu item.

Using Help Instructions for using Windows online Help
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Transport Help If you purchased a transport system (such as the Open Transport 
System or the Proprietary Transport System), you can access the 
online Help using any of the following methods:

■ From the Help menu on the Accessory Manager application 
window, click Accessory Manager Help. The table of contents 
focuses primarily on Accessory Manager, but the index and full 
text search facility provide access to information about all the 
32-bit transports that you have installed.
Related Documentation xiii

■ From the Help menu on the Database Editor application 
window, click Database Editor Help. The table of contents 
focuses primarily on the Database Editor, but the index and full 
text search facility provide access to information about all the 
32-bit transports that you have installed.

■ From the INFOConnect Manager application window, click 
Packages or Libraries from the Install menu, click the desired 
package or library from the list, and click Selected Package or 
Selected Library from the Help menu.

■ On any dialog box, click in the upper right corner of the title 
bar. The cursor changes into an arrow and a question mark. 
When you click any item on the dialog box, online Help for that 
item appears.

■ On any dialog box, press F1. This displays context-sensitive 
Help for the item where the cursor is located.

■ On any dialog box, right click the item you want more 
information about and click What’s This from the pop-up menu.

■ On any dialog box, click Help (when a Help button is available).

■ From My Computer or File Manager, double-click the desired 
Help file icon in the INFOConnect folder.
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In This Chapter This chapter includes the following headings:

About INFOConnect  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
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INFOConnect Solutions for IBM and DEC Hosts . . . . . . . . . . . . . 5
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Chapter 1  INFOConnect Solutions: An Overview

About INFOConnect

INFOConnect is an open platform that enables communication 
between PCs running Microsoft Windows 95 or Windows NT and a 
wide variety of hosts. It can also facilitate communication between 
programs running on your PC.

The INFOConnect framework is designed so that you can “plug-
and-play” any piece of INFOConnect software with any other 
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compatible piece. This provides maximum flexibility to create a 
communications environment that meets your specific needs.

Commonly Used 
Terms

Throughout this guide and other documentation for your 
INFOConnect products, you’ll see references to the following 
terms:

■ Host—the mainframe, mini-computer, or information hub with 
which a PC communicates. Unisys® A Series and 1100/2200 
Series mainframes are both hosts.

■ Terminal emulator—the software that makes a PC operate 
like a host terminal. InterCom® is a T 27 terminal emulator; 
PEP™ is a UTS 20/40/60 terminal emulator.

■ Transport—the communication software that enables a PC to 
communicate with a host via a specific type of network. For 
example, the INFOConnect TCP/IP Transport enables 
communication via a TCP/IP network.

This release includes both 32-bit and 16-bit transports.

■ Session—a named communication connection between a PC 
and a host that operates according to specified configuration 
settings. To enable communication between a PC and a host, 
you must create at least one session.

■ Path—a named set of configuration data that controls 
communication between a PC and a host. To enable 
communication between a PC and a host, you must create at 
least one path.
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INFOConnect Solutions for Unisys A Series Hosts

The following figure shows the transports that you can use with 
INFOConnect InterCom to connect to a Unisys A Series host. The 
transports interface with your network software, such as TCP/IP, 
IPX/SPX, NetBIOS, or Poll/Select.
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INFOConnect Solutions for Unisys 1100/2200 Series Hosts

The following figure shows the transports that you can use with 
INFOConnect PEP to connect to a Unisys 1100/2200 Series host. 
The transports interface with your network software, such as 
TCP/IP, IPX/SPX, NetBIOS, or Uniscope®.
4 INFOConnect Solutions for Unisys 1100/2200 Series Hosts
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INFOConnect Solutions for IBM and DEC Hosts

The following figure shows the connection tools that you can use 
with EXTRA!® Office for Accessory Manager to connect to an 
IBM® mainframe, IBM AS/400®, or DEC® host.

These connection tools are not INFOConnect transports; their 
configuration data is stored in the session profile rather than an 
INFOConnect path.
INFOConnect Solutions for IBM and DEC Hosts 5

The connection tools interface with your network software, such as 
TCP/IP.
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INFOConnect Solutions for Computer Reservation Systems

The following figure shows the transports that you can use with 
INFOConnect ALC to connect to a Computer Reservation System 
(such as Apollo®, AMADEUS, SABRE®, or SHARES). The 
transports interface with your network software, such as 
NetBIOS.
6 INFOConnect Solutions for Computer Reservation Systems
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About Accessory Manager

INFOConnect Accessory Manager for Windows 95 and Windows 
NT is an application that you can use to concurrently run different 
types of terminal emulators to connect to different types of hosts, 
all within a single framework.

The relationship between Accessory Manager and emulators is 
similar to the relationship between a word processor and 
8 About Accessory Manager

documents. When you run a word processor, you have a single 
application window, and no matter which document you open, 
there are functions that are common to all the documents. 
Likewise, when you run Accessory Manager, you have a single 
application window, and no matter which terminal emulation 
session you open, there are functions that are common to all the 
emulators.

Just as a word processor can open multiple documents at once, 
Accessory Manager can run multiple terminal emulation sessions 
at once. For example, using Accessory Manager, you can open one 
session using PEP to connect to a Unisys 1100/2200 Series host, 
and open a second session using InterCom to connect to an A 
Series host. Or you can open multiple sessions using one emulator, 
such as four sessions using PEP.

Running 
Accessory 
Manager

To run Accessory Manager (and therefore your terminal emulation 
sessions), use either of these procedures:

■ If you’re using Windows 95 or Windows NT 4.0, click the Start 
button, point to Programs, point to INFOConnect, and click 
Accessory Manager 32-bit.

■ If you’re using Windows NT 3.51, double-click Accessory 
Manager 32-bit in the INFOConnect program group.
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Sessions

A session is a named communication connection with a host.

Once you have opened a session, you can run applications on the 
host, transfer data between the host and your PC, link your PC 
applications with host applications, and perform any other task 
that requires interaction with the host.
Sessions 9

Session Profiles Each session has a session profile (.ADP file), which is a 
configuration file that defines how the session operates.

You can simplify the host connection process by creating a session 
profile for each host or host application you plan to access on a 
regular basis.

All session profiles contain the following information:

■ A host connection (either a specific INFOConnect path or a 
group of paths to select from)

■ A terminal type

■ A file transfer protocol (if supported by the emulator)

■ Other configuration settings, such as which keyboard map to 
use

Default Session 
Profiles

As shown in the following table, each emulator comes with its own 
default session profile, which is located in the TEMPLATE 
subfolder of the ACCMGR32 folder:

These session profiles have all the default configuration settings 
associated with that emulator. For example, UTS60.ADP uses the 
UTS 60 terminal type, no file transfer protocol, and the 
PEPWIN.EKM keyboard map. MT.ADP uses the T 27 terminal 
type, the CANDE file transfer protocol, and the T27.EM keyboard 
map.

This emulator Comes with this session profile

PEP UTS60.ADP

InterCom MT.ADP

ALC ALC.ADP
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You can change the configuration settings associated with each 
default accessory session profile simply by opening a session using 
the default session profile, making the desired configuration 
changes, and then saving the session.

Each time you create a session, the new session will automatically 
have all the configuration settings associated with the default 
session profile.

It is recommended that you use the default session profiles only as 
10 Sessions

a template for creating new sessions and not as a working session.

Normal Session 
Profile

The NORMAL.ADP session profile is used internally when you 
create new sessions.

If you accidentally delete this session profile, simply open a 
different session and save it as NORMAL.ADP.

Creating a Session To create a session, click New Session from the File menu. This 
runs the New Session Wizard.

Using this wizard, you can create sessions for any host. You can 
run this wizard when you first run Accessory Manager or 
whenever a session is open, and you can create as many sessions 
as your hard disk space allows.

To create a session, you must provide the following information:

■ Host type

■ Terminal type (only if your emulator supports multiple 
terminal types)

■ INFOConnect path to use for this session

■ File transfer protocol

If you have not yet created any INFOConnect paths for the 
specified terminal type, the New Session Wizard automatically 
launches the Add Path Wizard so that you can create an 
INFOConnect path.

Note:  If you’re sharing your INFOConnect products and ran 
NETSETUP or USRSETUP to access them, you can select but 
not create an INFOConnect path. Ask your administrator to 
create paths for you.
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The wizard creates a session with the same settings as the default 
session profiles described earlier in this guide. You can later edit 
these settings to accommodate your preferences.

Opening a Session To open a session, click Open Session from the File menu and 
complete the Open Session dialog box.

For other alternatives, as well as for information on connecting to 
a host, refer to the online Help.
Sessions 11

Session Window When you create or open a session, a window similar to the one 
shown below appears:

For information about configuring sessions, refer to the online 
Help.
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Layout Files

If you repeatedly open the same sessions each time you run 
Accessory Manager or if you have sized your session windows to 
meet your personal needs, you might want to create layout files to 
make working with Accessory Manager even easier.

Using layout files, you can save information about all open session 
windows and their current positions. When you open a layout file, 
12 Layout Files

all the session windows are displayed in the same size and 
position in which they were saved.

Any PEP, InterCom, or ALC sessions included in a layout file 
should be configured to use a specific INFOConnect path. If the 
session is not configured to use a specific INFOConnect path, be 
sure to select a unique path for each session when prompted. 
When you open a layout file, paths in use by other sessions in the 
layout file are not omitted from the Select INFOConnect Path 
dialog box. If you select a path in use, an error message appears, 
and you must click the session, click Connect from the Session 
menu, and double-click a valid path in order to connect to the host.

If you are upgrading from the Windows 3.1 version of Accessory 
Manager, you can still use your existing workspace (.XWW) files. 
All the sessions in the workspace file will be automatically 
converted from .XWP files to .ADP files (if they haven't been 
converted already), and the workspace file will be converted from 
an .XWW file to an .AWW file. However, if the .XWW file opened 
any KeyMap Editor, QuickPad Editor, Script Editor, or Text 
Editor windows, these windows will not be opened. Layout files 
can contain only session windows.

For information about saving and opening layout files, refer to the 
online Help.
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Keyboard Maps

Terminal keyboards are different than PC keyboards. For 
example, many terminal keyboards have a Transmit key, which 
PC keyboards do not have.

To enable your PC to communicate with a host in the same way as 
a terminal, each terminal emulator has a built-in set of default 
keystrokes that perform terminal functions. For example, you 
Keyboard Maps 13

might perform the function associated with the Transmit key by 
pressing the plus key (+) on the numeric keypad.

You can use the default keystrokes, or you can load a keyboard 
map for each session. (By default, each session uses a particular 
keyboard map.)

A keyboard map is a file (.EKM) that defines what function each 
key on a PC keyboard performs. For example, the F2 key might be 
mapped to send the Transmit keystroke, run a macro, or perform 
some other function.

You can configure almost any key or keystroke combination to 
perform any of the following functions:

■ Send keystrokes

■ Run a macro

■ Run an application

■ Load a scheme (such as a particular combination of colors)

■ Perform any function that can be performed using Accessory 
Manager’s menus

Most emulators come with several keyboard maps that are 
already set up and ready to use. For information about the 
keyboard maps that come with your emulator, refer to the chapter 
on that emulator later in this guide. You can use the predefined 
keyboard maps, or you can edit them or create new ones to meet 
your needs.

Accessory Manager supports keyboard maps for 84-, 101-, 102-, 
and 122-key keyboards.
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Loading a 
Keyboard Map

To load a keyboard map, follow these steps:

1 With a session open, click Settings from the Options menu.

2 From the Categories list box, click Keyboard Maps.

3 Select the check box in front of the keyboard map that you want to 
load.
14 Keyboard Maps

The Settings dialog box displays only those keyboard maps that 
are appropriate for the current session. For example, if you 
installed both InterCom and PEP and you’re currently using 
InterCom, only InterCom keyboard maps appear in this list box.

Keyboard maps preceded by exist in the local folder specified on 
the Global Preferences dialog box. Keyboard maps preceded by 

exist in the remote folder. To select a keyboard map located in 
a different folder, you must move it to the local or remote folder or 
change the remote folder on the Global Preferences dialog box. 
(For information on this procedure, refer to the online Help.)

If you select the check box in front of the Default item, you will use 
the emulator’s default keystrokes rather than the keystrokes 
associated with a particular keyboard map, and you will not be 
able to use blind key programming.

4 Do one of the following:

If you save the session, the selected keyboard map will load 
automatically the next time you open the session.

To do this Click this

Load the keyboard map and close the Settings dialog box OK

Load the keyboard map but not close the Settings dialog box Apply

Note:  If you load a keyboard map for a type of keyboard that is 
not appropriate for your PC, a warning message appears after 
you click OK or Apply. For example, if your PC is configured for 
a 101-key keyboard and you load a 122-key keyboard map, the 
warning message appears. You can still load the keyboard map, 
but some keystrokes might not work.
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Creating and 
Editing Keyboard 
Maps

To create or edit a keyboard map, follow these steps:

1 With a session open, click Settings from the Options menu.

2 From the Categories list box, click Keyboard Maps.

3 Do one of the following:
Keyboard Maps 15

You can create or edit a keyboard map for any type of keyboard. 
For example, even if you’re using a 101-key keyboard, you can 
create or edit a keyboard map for a 122-key keyboard.

When you create or edit a keyboard map, the Keyboard Map 
Editor displays a window similar to the one shown below. The 
actual graphic varies, depending on whether you’re working with 
an 84-, 101, 102, or 122-key keyboard map and which emulator 
you’re using.

For information about using the Keyboard Map Editor, refer to the 
online Help.

To do this Do this

Create a keyboard map Click New, click the type of keyboard 
that you're creating this keyboard map 
for, and click OK.

Edit an existing keyboard map Double-click the name of the keyboard 
map, or click the keyboard map and 
click Edit.
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Using Blind Key 
Programming

Blind key programming is a mechanism for changing the function 
of a keystroke on a keyboard map without using the Keyboard 
Map Editor.

Because blind key programming does modify the keyboard map, 
the following criteria must be met before you can use blind key 
programming:

■ The session must be using a keyboard map.

To check this, click Settings from the Options menu, click 
16 Keyboard Maps

Keyboard Maps from the Categories list box, and verify that a 
keyboard map other than Default is selected.

■ Security must be disabled for the following commands:

❏ Tools/Start/Stop Blind Key Programming

❏ Application Commands/Run Keyboard Map Editor

❏ Change Settings/Keyboard Maps

By default, security for these commands is disabled. For more 
information about security, click Administrative Help from 
Accessory Manager’s Help menu. (If you ran NETSETUP or 
USRSETUP, this item is not available; contact your 
administrator for assistance.)

You can initiate blind key programming from the Tools menu. You 
can also add the Start/Stop Blind Key Programming action to a 
keystroke, toolbar, QuickPad, or HotSpot.

A message appears in the status bar when keystrokes are being 
recorded. In addition, if you click a blind key programming button 
on a toolbar, the button remains in the down state while 
keystrokes are being recorded.

You can associate as many keystrokes as you want with any key or 
combination keystroke. For example, you can program Ctrl+u to 
type your user name, tab, your password, and transmit.

The only key you cannot program using blind key programming is 
the key used to initiate blind key programming (by default, this is 
Ctrl+F12).
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Programming a 
Keystroke

To program a keystroke using blind key programming, follow 
these steps:

1 From the Tools menu, click Start Blind Key Programming, or 
press Ctrl+F12.

If this menu item is dimmed, the session might not be using a 
keyboard map, or security might be enabled for required 
functions. Refer to the preceding page for details.
Keyboard Maps 17

2 Press the key or combination keystroke that you want to program.

3 Perform the functions that you want to assign to the key or 
combination keystroke that you pressed in step 2.

For example, suppose the + key performs the transmit function. If 
you initiate blind key programming, press F2, press +, and then 
stop blind key programming, the F2 key will then perform the 
transmit function.

To stop blind key programming at any time without saving your 
changes, press Esc.

4 From the Tools menu, click Stop Blind Key Programming, or press 
Ctrl+F12.
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Deleting an Action 
from a Keystroke

To delete an action from a keystroke using blind key 
programming, follow these steps:

1 From the Tools menu, click Start Blind Key Programming, or 
press Ctrl+F12.

If this menu item is dimmed, the session might not be using a 
keyboard map, or security might be enabled for required 
functions.
18 Keyboard Maps

2 Press the key or combination keystroke whose function you want 
to delete.

3 From the Tools menu, click Stop Blind Key Programming, or press 
Ctrl+F12.

Note:  This procedure eliminates all functionality from the key 
or combination keystroke. For example, if the + key performs 
transmit, and you delete this action, the + key will not perform 
transmit, nor will it perform the plus symbol. No action will be 
associated with that key.
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QuickPads

A QuickPad is a small window that can contain a variety of 
objects—buttons, text, boxes, group boxes, bitmaps, and icons. The 
following figures show some sample QuickPads; they can be any 
shape or size, and as simple or as complex as desired. 
QuickPads 19

The buttons and icons on a QuickPad can perform any of the 
following functions:

■ Send keystrokes

■ Run a macro

■ Run an application

■ Load a scheme (such as a particular combination of colors)

■ Perform any function that can be performed using Accessory 
Manager’s menus

QuickPads are also useful if you prefer to execute commands using 
a mouse rather than the keyboard or if you need quick access to 
functions that are not on the menu or toolbar.

During a session you can load one or more QuickPads. For 
example, you might have one QuickPad that performs editing 
keystrokes and another QuickPad that runs file transfer macros.

Most emulators come with several QuickPads that are already set 
up and ready to use. For information about the QuickPads that 
come with your emulator, refer to the chapter on that emulator 
later in this guide.

You can use these predefined QuickPads, or you can edit them or 
create new ones to meet your needs.
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Loading a 
QuickPad

To load a QuickPad, follow these steps:

1 With a session open, click Settings from the Options menu.

2 From the Categories list box, click QuickPads.

3 Click the QuickPads to load.

All the QuickPads with selected check boxes in front of them will 
20 QuickPads

be loaded.

4 Do one of the following:

Creating and 
Editing QuickPads

To create or edit a QuickPad, follow these steps:

1 With a session open, click Settings from the Options menu.

2 From the Categories list box, click QuickPads.

3 Do one of the following:

Note:  If you save the session, the selected QuickPads will load 
automatically the next time you open the session.

To do this Click this

Load the QuickPads and close the Settings dialog box OK

Load the QuickPads but keep the Settings dialog box open Apply

To do this Do this

Create a QuickPad Click New.

Edit an existing QuickPad Double-click the name of the QuickPad, or click 
the QuickPad and click Edit.
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When you create or edit a QuickPad, the QuickPad Editor opens, 
displaying a window similar to the one shown below:
QuickPads 21

For information about using this editor, refer to the online Help.
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Toolbars

Each emulator comes with a default toolbar that provides many 
standard functions (such as New Session, Open Session, Save 
Session) as well as functions unique to that emulator (such as 
putting an InterCom session in local mode, or displaying the PEP 
Control Page).

You can customize this toolbar in a number of ways:
22 Toolbars

■ Display color or monochrome buttons

■ Display large or small buttons

■ Show or suppress ToolTips

You can also create your own toolbars and load different toolbars 
for different sessions or load multiple toolbars for a single session. 
The toolbar to use is saved as part of the session profile when you 
save the session, so it will appear each time you open the session.

You can also move the toolbar to different locations on the screen.
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Loading a Toolbar To load a toolbar, follow these steps:

1 With a session open, click Settings from the Options menu.

2 From the Categories list box, click Toolbars.

3 Select the check box in front of the toolbar that you want to load.

4 Do one of the following:
Toolbars 23

Creating and 
Editing Toolbars

To create or edit a toolbar, follow these steps:

1 With a session open, click Settings from the Options menu.

2 From the Categories list box, click Toolbars.

3 Do one of the following:

To do this Click this

Load the toolbar and close the Settings dialog box OK

Load the toolbar but keep the Settings dialog box open Apply

Note:  If you save the session, this toolbar will load 
automatically the next time you open the session.

To do this Do this

Create a toolbar Click New.

Edit an existing toolbar Double-click the name of the toolbar, 
or click the toolbar and click Edit.
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When you create or edit a toolbar, the Toolbar Editor opens, 
displaying a window similar to the one shown below:
24 Toolbars

For information about using the Toolbar Editor, refer to the online 
Help.
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HotSpots

A HotSpot is a portion of the session window that, when you 
double-click it using the left mouse button, performs any of the 
following functions:

■ Sends keystrokes

■ Runs a macro
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■ Runs an application

■ Loads a scheme (such as a particular combination of colors)

■ Performs any function that can be performed using Accessory 
Manager’s menus

Text HotSpots Text HotSpots are HotSpots that are associated with any single 
character or group of characters, such as the letter x or the word 
Enter. For example, if you define the word Enter as a text HotSpot, 
that word will be a HotSpot on every host screen in which that 
word appears. Whenever you double-click the word Enter using 
the left mouse button, the action associated with that HotSpot will 
be performed.

When you define a text HotSpot, you can specify whether all 
matching characters should be HotSpots, or only matching 
characters that occur in a specific column or row. You can also 
specify whether a text HotSpot is case-sensitive, preceded or 
followed by a space, or automatically invoked whenever it appears 
on the screen. (If a HotSpot is automatically invoked, you do not 
have to double-click it to make it perform its action; it performs 
the action as soon as it appears on the screen.)

Region HotSpots Region HotSpots are rectangular areas of the screen that might or 
might not contain text. When you enlarge or reduce the size of the 
session window, the HotSpot enlarges or reduces proportionally. 
However, since HotSpots are in fixed locations, if Autosize 
Window is cleared on the Font tab you might not be able to access 
certain HotSpots when you resize the session window.

Region HotSpots remain in the same position and perform the 
same functions no matter what display appears on the screen. For 
example, if you configure HotSpots to perform certain functions on 
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a particular host screen, they will always perform that function, 
even if the host screen changes.

HotSpot 
Appearance

When HotSpots are enabled, you can make either type visible or 
invisible. For example, you might make text HotSpots visible, but 
region HotSpots invisible. Even when a HotSpot is invisible, the 
mouse pointer turns into an up arrow when it is over a HotSpot.

Visible text HotSpots can appear on the screen in three ways:
26 HotSpots

■ Filled rectangle

■ Outline rectangle

■ Recessed panel

Visible region HotSpots can appear as outline rectangles or 
recessed panels.

Creating a HotSpot To create a HotSpot, follow these steps:

1 With a session open, click Settings from the Options menu.

2 From the Categories list box, click HotSpots.

3 Click the Assignments tab.

4 Click Add.

5 Complete the Add HotSpot dialog box.

For information about any item on this dialog box, click  in the 
upper right corner of the dialog box and then click the desired 
item.

How HotSpots 
Work

HotSpots take precedence over any other left mouse button 
double-click functions. For example, if you configure the left 
mouse button double-click to select a word, enable HotSpots, and 
then double-click a word that is a HotSpot, Accessory Manager 
performs the action associated with the HotSpot rather than 
selecting the word.

Normally, HotSpots are saved as part of the session profile and 
can be used whenever that session is open. However, you can also 
save one or more HotSpots as a scheme that can be invoked by any 
session or associated with a particular host screen.
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If you no longer want to use one or more HotSpots, you can remove 
them from the session profile or scheme. However, if the HotSpot 
is saved in the session profile, it remains there until you save the 
session again without the HotSpots.
HotSpots 27
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CASL Macros

A macro is a series of instructions for performing specified tasks. 
These instructions are written using the Common Accessory 
Script Language (CASL™).

Using macros, you can do any of the following:

■ Perform keystroke sequences
28 CASL Macros

■ Run another PC application

■ Perform almost any function that can be performed using 
Accessory Manager, such as loading a QuickPad

■ Create dialog boxes so that you can request user input

You can also use macros to perform traditional programming 
tasks, such as the following:

■ Manage variables and constants

■ Manipulate or set date and time values

■ Perform mathematical calculations

■ Manipulate strings

Options for 
Running Macros

You can run macros at any of the following times:

■ When you start Accessory Manager (application start- macro)

■ When you open a session (session start-up macro)

■ When you click CASL Macro from the Tools menu, click the 
desired macro, and click Run

■ When you click a toolbar or QuickPad button, press a key, or 
double-click a HotSpot that has been configured to run a macro

■ When the left mouse double-click has been configured to run a 
macro with the same name as the word under the mouse 
pointer

■ When you click Run from the CASL Macro Editor’s Macro menu
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Creating a 
CASL Macro

You can create a CASL macro in two ways:

■ Learn Mode—you perform the actions that you want to include 
in the macro, and Accessory Manager records those actions in a 
CASL macro file, which you can then edit if needed

■ CASL Macro Editor—you open the CASL Macro Editor and 
write the macro using the CASL script language

Using Learn Mode To create a CASL macro using Learn Mode, follow these steps:
CASL Macros 29

1 With a session open, click Learn CASL Script from the Tools 
menu.

The CASL Macro Editor starts in a minimized state.

2 Perform the tasks that you want to include in the macro.

3 When you have finished, click Stop CASL Learn from the Tools 
menu.

4 When you are prompted about saving the CASL macro, do one of 
the following:

If you need to edit the CASL macro, you can do so using the CASL 
Macro Editor. Refer to the online Help for detailed information.

To do this Do this

Save the 
CASL macro

Click Yes, type a name for the macro in the File Name text box 
(you do not have to include a file extension), and click Save on 
the Save As dialog box.

The CASL Macro Editor closes automatically.

Not save the 
CASL macro

Click No.

The CASL Macro Editor closes automatically.
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Using the CASL 
Macro Editor

To create a CASL macro using the CASL Macro Editor, follow 
these steps:

1 With a session open, click CASL Macro from the Tools menu.

2 Click New.

The CASL Macro Editor starts, displaying a window similar to the 
one shown below:
30 CASL Macros

For information about using this editor, refer to the online Help.

For information about the CASL script language, refer to the 
CASL Script Language Guide.
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Host Screen Recordings

You can record a series of host screens simply by using the 
procedures you would normally use to navigate through a host 
application.

Recording host screens offers a number of advantages:

■ You can go to a recorded host screen simply by clicking the 
Host Screen Recordings 31

name of the screen from a list of recorded screens. You no 
longer have to navigate through the host application; Accessory 
Manager does it for you.

■ If you specify that a recorded host screen is a bookmark, you 
can go directly to that host screen by clicking Go To from the 
Tools menu and then clicking the name of the screen from the 
submenu.

■ If you create a bookmark file, you can go directly to a recorded 
host screen host screen by double-clicking the bookmark file in 
My Computer or File Manager. You can also create an icon on 
your desktop for that bookmark file. Double-clicking the icon 
starts Accessory Manager, opens the appropriate session, and 
navigates to that host screen automatically.

■ You can associate a color scheme, HotSpot scheme, macro, 
QuickPad, or toolbar with a specific host screen or group of host 
screens. (If you purchased HiBrow, you can also associate a 
URL with a host screen.) Any time you access that host screen, 
the associated item is invoked automatically (for example, the 
colors are applied, the macro starts, the QuickPad appears, 
etc.). This occurs whether you access the host screen via the Go 
To menu item or the way you normally would.

■ You can copy data from a recorded host screen and paste it into 
another document, such as an Excel spreadsheet, thus creating 
a dynamic link between the spreadsheet and the host 
application. The next time you open the spreadsheet, it 
automatically starts Accessory Manager, opens the appropriate 
session, navigates to the correct host screen, and updates the 
data in the spreadsheet. Using this technique, you can have a 
single spreadsheet retrieve data from multiple host screens, 
multiple host applications, or even multiple hosts. Refer to 
“Object Linking and Embedding (OLE)” on page 43 for more 
information.
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Recording host screens works best with host applications that 
handle data in large blocks. These applications typically display 
data as forms on the screen. Unisys and IBM host applications 
typically operate in this way. However, Demand sessions and 
VT™ terminal emulation sessions do not. This might cause 
problems when you try to access the recorded host screen.

How Recording 
Host Screens 

When you record host screens, Accessory Manager waits 6 to 12 
seconds after you display each screen before actually recording it. 
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Works This ensures that all the data buffers have been received from the 
host. (The amount of time varies for each emulator, and you can 
modify this delay on the Settings dialog box. For more 
information, refer to “Specifying the Recording Delay” on page 34.)

Once the delay has elapsed, Accessory Manager decides which 
words or phrases to use to identify the screen. (These words or 
phrases are called identification fields.) Normally, three protected 
fields at the top of the screen and three at the bottom are used, but 
if six protected fields are not available, then Accessory Manager 
uses fewer, preferably protected fields.

As you move from one host screen to another, Accessory Manager 
records your keystrokes as navigation paths. These navigation 
paths include all the data that you type to move from one screen to 
another, including user IDs and passwords. However, once you 
complete the recording, you can edit it to substitute prompts for 
this data, thereby ensuring that host applications remain secure.

Whenever a new screen appears, the process of waiting for the 
delay to elapse and determining identification fields begins again.

Once a host screen has been recorded, the name of that host 
screen appears in the status bar each time that screen appears. 
This occurs whether you access the host screen using the Go To 
menu item or the way you normally would.

When you use the Go To menu item to go to a recorded host 
screen, Accessory Manager determines the best navigation path to 
use from the current location and performs the necessary 
keystrokes, verifying as it goes that each screen that appears is 
what was expected.
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Bookmarks and 
Bookmark Files 

When you record host screens, you can specify that certain screens 
should be bookmarks. A bookmark is simply a host screen that you 
want to access directly from the Go To menu.

You can create a bookmark in two ways:

■ As you record host screens, click on the control bar. The 
currently displayed screen becomes a bookmark. (This button 
remains in the down position when the host screen is a 
bookmark.)
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■ You can select which screens to use as bookmarks on the Page 
Settings dialog box.

Specifying that certain screens are bookmarks makes it easier to 
access those screens. When you point to Go To in the Tools menu, 
the submenu displays a list of up to 50 bookmarks. In addition, 
when you click More from the submenu, you can specify whether 
you want the Bookmarks/Pages dialog box to display a list of all 
the recorded host screens or only the bookmarks. Viewing only the 
bookmarks makes the list more manageable.

When you create bookmarks, you can also create bookmark 
(.BKM) files. A bookmark file contains instructions to start 
Accessory Manager, open the appropriate session, and navigate to 
a specific bookmark automatically. You can control whether a 
bookmark file is created automatically by selecting or clearing 
Automatically Create Bookmark Files on the Global Preferences 
dialog box.

Using bookmark files, you can go directly to a recorded host screen 
by double-clicking the bookmark file in My Computer or File 
Manager. You can also create an icon on your desktop for a 
bookmark file and double-click the icon to access the bookmark.
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Specifying the 
Recording Delay

The default amount of time that Accessory Manager waits while 
recording a host screen varies, depending on which emulator 
you’re using. However, you might need to modify this default, 
depending on depending on the speed of your PC and the 
mechanism that you use to communicate with the host. For 
example, it takes less time to receive all the data from the host 
over a TCP/IP connection than a Poll/Select or modem connection.

To modify the recording delay, follow these steps:
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1 Open a session.

2 From the Options menu, click Settings.

3 From the Categories list box, click Navigation.

4 Move the slider to specify the number of seconds that the screen 
must be stable during host screen recording.

The following are recommended values for each emulator:

If you specify too few seconds, Accessory Manager might not have 
sufficient time to record the host screen, and you might experience 
problems when you try to access the recorded host screen. If you 
specify too many seconds, the process of recording host screen 
might be unnecessarily long. You might have to adjust this setting 
until you find the optimum speed for your situation.

Emulator Number of Seconds

InterCom, PEP, and ALC 10

3270 emulator 6

5250 emulator 8

VT emulator 12
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Recording Host 
Screens

To record host screens, follow these steps:

1 Open a session and connect to a host.

Refer to the online Help for instructions on these procedures.

2 From the Tools menu, click Record Pages.

A check mark appears next to this menu item when recording is 
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occurring.

A control bar at the bottom of the application window displays 
Stop, Pause, and Add Bookmark buttons, as well as a text box 
with the name of the host screen. (By default, this is Page001, 
Page002, etc. If Accessory Manager recognizes the current screen 
as one that has already been recorded, the name associated with 
that screen appears in this text box.)

You can move the control bar to the top of the application window 
or make it a free-floating window.

3 In the text box in the control bar, type the name to use to identify 
this screen. (If desired, you can omit this step and rename the 
screen later using the Page Settings dialog box.)

It takes several seconds for the screen name to appear on the 
control bar. (To modify this delay, refer to “Specifying the 
Recording Delay” on page 34.) Wait until the name appears before 
changing it or performing any other action.

4 To specify that the displayed host screen should be a bookmark, 
click on the control bar. (If desired, you can omit this step and 
specify which screens should be bookmarks later using the Page 
Settings dialog box.)

If you do create a bookmark and Automatically Create Bookmark 
Files is selected on the Global Preferences dialog box, a bookmark 
file is created automatically.

Note:  It is recommended that you begin your recording with 
the logon screen and that you end the recording on the same 
screen that you started from. This ensures that you will be able 
to get to any recorded screen in the sequence.
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5 Use your usual procedures for navigating through the host 
application, repeating steps 3 and 4 for each host screen.

Note:  When recording screens, be sure to wait until the screen 
name appears in the control bar before pressing keys to access 
another screen. Taking any action while the first screen is still 
being recorded will cause problems with the recording.

The recording will include all the data that you type to move 
from one screen to another, including user IDs and passwords. 
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6 When you have navigated through all the host screens that you 
want to record, click Record Pages from the Tools menu.

The check mark next to this menu item disappears when 
recording has stopped, and the control bar disappears.

However, once the recording is completed, you can edit it to 
substitute prompts for this data, thereby ensuring that host 
applications remain secure.

If you need to pause the recording for any reason (for example, 
to test what the next screen will be before proceeding), click 

on the control bar. However, be very careful when using this 
feature. If you pause on one host screen and then resume the 
recording on another, there will be navigation gaps in the 
recording, and you will have problems accessing the recorded 
host screen.
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Accessing a 
Recorded Host 
Screen

To access a recorded host screen, follow these steps:

1 Open a session and connect to a host.

Refer to the online Help for instructions on these procedures.

2 Click Tools, point to Go To, and do one of the following:
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To do this Do this

Access a bookmark that 
appears in the submenu

Click the name of the bookmark in the 
submenu.

Access a bookmark that does 
not appear in the submenu, or 
access a recorded host 
screen that is not a bookmark

Click More.

On the Bookmarks/Pages dialog box, click 
View All Pages (to see a list of all recorded host 
screens) or View Bookmarks (to see a list of 
only bookmarks). Then double-click the host 
screen that you want to access.

Note:  Click to keep the Bookmarks/
Pages dialog box visible as you access various 
host screens.

Click to access the Page Settings dialog 
box. Using this dialog box, you can rename 
host screens; specify which screens should be 
bookmarks; assign settings (such as 
QuickPads, toolbars, HotSpots, macros, and 
schemes) to host screens; and perform other 
related tasks.
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Accessing a 
Bookmark Using a 
Bookmark File

Use any of these procedures:

■ Click Open Session from the File menu, click Bookmark Files 
(*.BKM) from the Files Of Type list box, double-click the 
Bookmarks folder, and then double-click the desired bookmark 
file.

■ Right-click Accessory Manager’s application window, click 
Open Session from the pop-up menu, click Bookmark Files 
(*.BKM) from the Files Of Type list box, double-click the 
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Bookmarks folder, and then double-click the desired bookmark 
file.

■ Using My Computer or File Manager, go to the 
ACCMGR32\BOOKMARKS folder in your INFOConnect folder 
and double-click the desired bookmark file.

■ If you’re using Windows 95 or Windows NT 4.0, create a 
shortcut for the bookmark file on the desktop and double-click 
the shortcut. (Refer to your Windows documentation for 
information on this procedure.)

■ If you’re using Windows NT 3.51, create a program icon for the 
bookmark file in one of your program groups and double-click 
the program icon. (Refer to your Windows documentation for 
information on this procedure.)

The default name for each bookmark file is the recorded host 
screen name plus the session name, followed by the .BKM 
extension. For example, if you created a bookmark for a screen 
named Main Menu using SESSION1.ADP, the bookmark file 
name would be MAIN MENU_SESSION1.BKM.
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Modifying Host 
Screen 
Recordings

Once you have recorded host screens, you can click Page Settings 
from the Tools menu and perform the following tasks:

■ Rename the host screen (for example, from Page001 to Logon 
Screen, from Page002 to Main Menu, etc.)

■ Create groups of host screens that you want to handle in a 
similar way. For example, if you want a particular group of host 
screens to use a specific color scheme, you can put those host 
screens together in a group and apply the color scheme to the 
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group, rather than applying it to each host screen one at a time.

■ Associate a color scheme, HotSpot scheme, macro, QuickPad, or 
toolbar with a specific host screen or group of host screens.

■ Specify which host screens to use as bookmarks. For example, 
you might record ten host screens, but only be interested in 
navigating to the last one. When you specify that the last 
screen is a bookmark, only that screen appears in the submenu 
when you point to Go To from the Tools menu.

■ Perform advanced functions, such as customizing how the host 
screen is accessed or identified.

For example, while recording host screens, you might have 
typed a password to access a particular host application. To 
ensure the security of the host application, you can edit the 
recording and insert a prompt for the password rather than the 
actual password itself.

You can also change how the host screen is identified. For 
example, when Accessory Manager records the fields used to 
identify the screen, it might include data that changes, such as 
the time or date. When you next try to access this screen, since 
the time or date will have changed, Accessory Manager will 
respond as if the screens do not match properly, and an error 
will occur. To correct this, you can manually determine which 
fields should be used to identify each screen. For more 
information, refer to the online Help.
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Copying Host 
Screen 
Recordings

Host screen recordings are saved on a per-session basis in two files 
(.QPR and .ENV) whose names match that of the session. For 
example, if the session name is SESSION1.ADP, then the 
recording is saved in SESSION1.QPR and SESSION1.ENV. (If 
you have not modified the recording in any way, only a .QPR file 
exists.)

To make the recording available for other sessions, you can copy 
the .QPR and .ENV files using the appropriate session names (for 
example, copy SESSION1.QPR and SESSION1.ENV to 
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SESSION2.QPR and SESSION2.ENV for use with 
SESSION2.ADP).

If you’re using file names that are longer than eight characters, be 
sure to copy the files using My Computer or File Manager rather 
than the DOS COPY command. In addition, if the recording 
includes any user IDs or passwords, you might want to edit the 
recording to substitute prompts for actual data if you plan to share 
the recording among multiple users.
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Internet Support

With Accessory Manager, you can interact with the Internet in 
two ways:

■ ActiveTerm—you can open a session as a terminal plug-in 
within any Internet browser that can host an ActiveX 
document, such as Internet Explorer.

ActiveTerm is useful if you prefer to use a browser as your 
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primary application (for example, when you’re working with a 
corporate intranet) and you only occasionally need access to 
host data.

■ INFOConnect Host Internet Browser (HiBrow)—you can open a 
URL within Accessory Manager.

HiBrow is useful if you want to integrate Internet sites or other 
HTML pages into Accessory Manager. For example, you can 
link a recorded host screen in an Intercom session to a URL so 
that, when you display that host screen, a HiBrow session 
opens and displays that URL. Using this technique, you can 
display context-sensitive online Help for specific host screens, 
graphics that host applications don’t support, or other 
information that would otherwise not be accessible.

ActiveTerm is included as a feature of Accessory Manager and is 
described below; HiBrow is purchased separately and is described 
in Chapter 7, “INFOConnect Host Internet Browser (HiBrow).”

ActiveTerm Using ActiveTerm, you can open a session as a terminal plug-in 
within any Internet browser that can host an ActiveX document, 
such as Internet Explorer.

When you open a session within a browser, most of the browser’s 
menu items remain the same. However, some functions (such as 
Find in the Edit menu) do not apply to Accessory Manager 
sessions, and these items are dimmed. Accessory Manager’s Edit 
and View menus replace the browser’s Edit and View menus. 
Several Accessory Manager menus (such as Tools, Session, and 
Options) are also added to the browser’s menu bar. However, the 
browser’s File menu remains intact, as do any other menus. (You 

Note:  Netscape Navigator does not currently support this 
feature.
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can access some of the functions of Accessory Manager’s File menu 
using the default toolbar. All other File menu functions can be 
accessed by mapping these functions to a toolbar, keyboard map, 
QuickPad, or HotSpot. However, opening and saving layout files 
does not work within a browser.)

The browser’s toolbar remains on the application window, and the 
emulator’s toolbar also appears above the session window. You can 
also click the emulator’s toolbar and move it anywhere on your 
desktop.
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You can use the browser’s mechanisms for browsing forward and 
backward, switching between the session and other URLs. You 
can also open multiple sessions within the browser (such as an 
InterCom and a PEP session, or two InterCom sessions) and 
switch between them.

Opening an 
ActiveTerm Session

To open a session within another application, follow these steps:

1 Run the application that you want to use to open the session.

You can open a session within any application that can host an 
ActiveX document, such as Internet Explorer or any Microsoft 
Office application.

2 From the File menu, click Open.

3 Type the file name of the session that you want to open within the 
browser. Be sure to include the drive and directory. For example, 
you might type C:\INFOCN32\ACCMGR32\INT1_1.ADP.

You can also click Browse and select the desired file. If you do this, 
be sure to click All Files from the Files Of Type list box, or type 
*.ADP in the File Name text box and click OK. This ensures that 
.ADP files appear.

You can open session (.ADP) files, but not layout (.AWW) files.

When you click OK on the Open dialog box, the specified session 
opens within the application window.
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Object Linking and Embedding (OLE)

Through OLE (Object Linking and Embedding) technology, 
Accessory Manager integrates host applications with PC 
applications, such as Excel, Word, and any other application that 
supports OLE linking.

Data from multiple host applications or even multiple hosts can be 
brought together in a single spreadsheet or document, providing 
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consolidated access to information from diverse locations. In 
addition, this data can change dynamically. As the data is updated 
on the host, it can be automatically updated in the PC application.

For example, a bank might have information on savings and 
checking accounts in one host application, and mortgages in 
another. However, the loan processor might want to see all of this 
information in one place and perform calculations on the data. 
This can be done simply by copying the desired data from the 
terminal emulation screens and pasting it into a single Excel 
spreadsheet.

This procedure does not paste the specific host data into the Excel 
cell, but rather pastes a formula necessary to retrieve the data. 
Whenever you open the spreadsheet, this formula specifies which 
session to open, which host screen to navigate to, and which data 
to display in the Excel cell. Whenever the data is updated on the 
host—for example, when the balance in the savings account 
increases—the corresponding cell in the Excel spreadsheet is also 
updated. Once the links are set up, all you have to do to 
subsequently access the host data is simply open the Excel 
spreadsheet.

For OLE linking to work, you must record the host screens that 
you navigate through to get to the screen that you want to link 
with the PC application. It is recommended that you not load any 
settings (such as QuickPads) for the screens that you want to link 
to PC applications. In addition, when you open a PC application 
that contains an OLE link, you cannot run Accessory Manager and 
open the same session for other emulation tasks.
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Linking 
Applications

To link host data with another application (such as Excel), follow 
these steps:

1 With a session open and a host connection established, navigate to 
the host screen that contains the data that you want to link.

This screen must be a recorded screen. For instructions on 
recording host screens, refer to “Recording Host Screens” on 
page 35.
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2 Open the spreadsheet or document that you want to link with the 
host data.

3 Select the host data that you want to link with the PC application 
and click Copy from the Edit menu.

4 In the PC application, select the location where you want the host 
data to appear and click Paste Special from the Edit menu.

5 On the Paste Special dialog box, click Paste Link.

6 Click OK.

The host data appears in the PC application, along with a formula 
that indicates how to retrieve the data the next time you open this 
spreadsheet or document.

The data will also be updated dynamically as it changes in the 
host application.
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About the INFOConnect Database Editor

The INFOConnect Database Editor is installed when you install 
any of Attachmate’s INFOConnect emulators (such as InterCom, 
PEP, or ALC).

Using the Database Editor, you can view the contents of your 
INFOConnect database and add, modify, or delete the paths and 
path-related information. (If you have 16-bit transports, the 
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Database Editor can display the contents of both your 16-bit 
database and your 32-bit database simultaneously.)

The Database Editor can be used not only with Attachmate’s 
transports, but also any INFOConnect-compatible library, 
including those included with INFOConnect Connectivity Services 
(such as TELNET) and any custom or third-party libraries 
developed by other vendors.

Starting the 
Database Editor

You can start the Database Editor in several ways:

■ If you’re using Windows 95 or Windows NT 4.0, click the Start 
button, point to Programs, point to INFOConnect, and click 
Database Editor. If you’re using Windows NT 3.51, double-click 
Database Editor in the INFOConnect program group.

■ If you run Accessory Manager and open a session that does not 
have a path specified in its configuration, the Select 
INFOConnect Path dialog box appears. This dialog box includes 
an Edit button. When you click Edit, Accessory Manager runs 
the Database Editor.

■ If you run Accessory Manager and configure the connection 
settings for the session, the Settings - Connection dialog box 
appears. This dialog box also includes an Edit button that runs 
the Database Editor.

Note:  In a shared or multi-user installation, the Database 
Editor does not appear in the Start menu or INFOConnect 
program group for users who run NETSETUP or USRSETUP, 
and the Edit button is dimmed on the Select INFOConnect Path 
and Settings - Connection dialog boxes. For more information, 
refer to “Shared and Multi-User Installations” on page 51.



Chapter 3  INFOConnect Database Editor and Utilities

Standalone Installations of the Database Editor

In a standalone installation, the top portion of the Database 
Editor application window displays a list of installed transports 
(Connection Type) and a list of paths that use that transport. The 
lower portion of the window displays configuration information for 
the selected path.

The appearance of the lower portion of the application window 
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changes, depending on which item is selected from the Connection 
Type list box. The following figure shows the appearance of the 
window for an A Series TCP/IP path. 
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Shared and Multi-User Installations of the Database Editor

In a shared or multi-user installation, the left half of the Database 
Editor application window displays a tree view of the users who 
share the INFOConnect database. If you have two databases (one 
for 16-bit transports and one for 32-bit transports), both appear in 
the application window as separate trees. If you have only one 
database, only one tree appears.
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Initially, as shown in the preceding figure, each tree displays an 
icon for the database (such as \\SERVER1\INFOCN32 or 
\\SERVER1\INFOCN16), one unnamed group, and one user (the 
person who installed the products). This user is the administrator.

Eventually, the tree will include an icon for each user who will be 
running the shared products (as shown in the following figure). 
You can add users to the tree manually, or you can wait until each 
user runs NETSETUP or USRSETUP. When a user runs 
NETSETUP or USRSETUP, that user is automatically added to 
the tree. (You must restart the Database Editor in order to see the 
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additions to the tree.) If you have two databases—and therefore 
two trees—the user is added to each one.
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Once your tree contains users, you can create groups and arrange 
the users in various groups. For example, you can create groups 
that reflect your company’s organization hierarchy (such as 
Accounting, Personnel, and Sales) or groups that reflect various 
network protocols (such as TCP/IP and Uniscope). All groups are 

Note:  If you don’t know a user’s Windows or network logon 
name, do not add that user to the tree manually. If you add a 
user manually and the name you use differs from the user’s 
Windows or network user name, you will have duplicate icons 
on the tree (the one you added manually and the one placed on 
the tree by NETSETUP or USRSETUP), and any paths you 
create for the incorrect name will not be available to the user.
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listed alphabetically on the tree, and all users are listed 
alphabetically within each group.
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Levels of Paths In a shared or multi-user installation, you can create 
INFOConnect paths on three different levels:

■ Database level (these paths are available to all users on the 
tree)

■ Group level (these paths are available to all users in the 
specified group)

■ User level (these paths are available only to the specified user)

When a user opens a terminal emulation session that is not 
configured to use a specific path, the Select INFOConnect Path 
dialog box appears, displaying the database-level, group-level, and 
user-level paths available to the user.

For example, in the preceding figure, Bernard would see a list of 
the paths created for him, the paths created for the Accounting 
group, and the paths created for the \\SERVER1\INFOCN32 
database.

Note:  If you create terminal emulation sessions for users, do 
not configure the session to automatically use a database-level 
or group-level path, since these paths might be in use by other 
users. You should configure the session to use only user-level 
paths.
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Database Editor Security

The Database Editor offers two levels of security:

■ Administrator

■ User

Each level has a separate login procedure and a separate 
password. (By default, there are no passwords.)
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The only difference between administrator-level security and 
user-level security is that only the administrator can change the 
administrator password, and only the user can change the user 
password. Whether you log in as an administrator or a user, you 
have full access to all Database Editor functions.

If you change the administrator or user password in the Database 
Editor, the corresponding change is also made in the 
INFOConnect Manager. Likewise, if you change the administrator 
or user password in INFOConnect Manager, the corresponding 
change is also made in the Database Editor.

Standalone 
Installations

In a standalone installation, when you run the Database Editor, 
you are automatically logged in as a user.

If you add a user password, you are prompted for it when you run 
the Database Editor. You are prompted for an administrator 
password only when you try to log in as an administrator.

Shared and Multi-
User Installations

In a shared or multi-user installation, the person who installed 
the products is automatically logged in as an administrator.

If you add an administrator password, you are prompted for it 
when you run the Database Editor. You are prompted for a user 
password only when you try to log in as a user.

Users who run NETSETUP or USRSETUP cannot access the 
Database Editor from the Start menu or INFOConnect program 
group, nor can they can access it by clicking Edit on the Select 
INFOConnect Path or Settings - Connection dialog boxes. 
However, unless prevented by restrictions in the operating 
system, they can go to the ACCMGR32 folder and double-click 
DBED32.EXE. If no passwords have been added, the application 
window is blank, and the users cannot log in as either a user or an 
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administrator. To provide users with access to Database Editor 
functions, the person who installed the products must add either 
an administrator or user password and provide the user with both 
the correct user name and password.

To ensure the security of the INFOConnect database, it is strongly 
recommended that you add both an administrator and user 
password.

Users who run NETSETUP or USRSETUP also cannot run the 
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Add Path Wizard from within Accessory Manager. They must run 
the Database Editor and log in as an administrator or a user in 
order to run the Add Path Wizard from within the Database 
Editor.

In a shared or multi-user installation, when you are prompted for 
a password, you are also prompted for a user name. The user 
name and password must match in order to gain access. The 
administrator password is associated only with the 
administrator’s user name. The user password is associated with 
only one user name. For example, if the person who installed the 
products has a Windows logon name of ABC, and the 
administrator password is ADMIN, to log on as the administrator 
you must type both ABC and ADMIN at the prompt. If the user 
password is assigned to user DEF, and the user password is 
USER, to log on as a user you must type both DEF and USER at 
the prompt. Anyone logged on to the PC can log in as either an 
administrator or a user, as long as the user name and password 
match.
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Export/Import Utility

The INFOConnect CD includes a UTILITY folder that contains 
the Export/Import Utility. Using this utility, you can export data 
from any INFOConnect database into an .INI or .CSV file, as well 
as import data from an .INI or .CSV file into an INFOConnect 
database. You can also create a detail file that provides 
information about each field in the .INI or .CSV file (such as the 
maximum number of bytes allowed in each field).
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You can use this utility to perform a number of tasks:

■ Export path data from a 16-bit database (INFOCONN.CFG) 
and import it into a 32-bit database (IC32.CFG)

■ Create a backup copy of your INFOConnect database so that 
you can easily restore it 

■ Create and edit INFOConnect paths in an .INI or .CSV file that 
you can subsequently import into an INFOConnect database

■ Export path data from multiple INFOConnect databases and 
then import the data into a single master database

■ Modify the organization of groups and users in the tree in the 
shared version of the INFOConnect Database Editor

For detailed information about this utility, refer to its online Help.

Note:  If you installed only 32-bit transports on the PC running 
this utility, you can export and import data for 32-bit databases 
only. Likewise, if you installed only 16-bit transports on the PC 
running this utility, you can export and import data for 16-bit 
databases only. To export or import data for both 32-bit and 16-
bit databases, you must install at least one 32-bit transport and 
one 16-bit transport on the PC running this utility.

In addition, to import data into an INFOConnect database, the 
library for which you are importing data must already be 
installed in the destination database. For example, to import 
16-bit TCP-A paths into a 32-bit INFOConnect database, the 
32-bit INFOConnect A Series TCP/IP Transport must already 
be installed.
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Running the 
Export/Import 
Utility

Before you can run the Export/Import Utility, you must install at 
least one INFOConnect product. Once you have done this, you can 
run this utility from the INFOConnect CD or from a PC using the 
procedures described below.

Running from the CD To run the Export/Import Utility from the CD, follow these steps:

1 Hold down the Shift key and insert the CD into a CD-ROM drive.
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2 Using My Computer or File Manager, go to the 32\UTILITY 
folder on the CD (for example, D:\32\UTILITY).

3 Double-click EXPIMP32.EXE.

Running from a 
PC Hard Disk

To run the Export/Import Utility from your PC hard disk, follow 
these steps:

1 Hold down the Shift key and insert the CD into a CD-ROM drive.

2 Using My Computer or File Manager, go to the 32\UTILITY 
folder on the CD (for example, D:\32\UTILITY).

3 Copy the following files from the CD to a folder on the PC:

4 Go to the folder where you copied these files.

5 Double-click EXPIMP32.EXE. 

■ EXPIMP32.CNT ■ EXPIMP32.HLP
■ EXPIMP32.EXE ■ ATMTHK16.DLL 
■ EXPIMP32.FTS ■ ATMTHK32.DLL 
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Copy ICS Database Utility

Using the Copy ICS Database Utility, you can create a copy of an 
INFOConnect database that is identical to the original database 
except for the name of the location of the executable files. This can 
be helpful if you share your INFOConnect products on multiple 
file servers and want a copy of the same database on each server, 
with the only difference being the name of the server where the 
executable files are located.
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You can use this utility in conjunction with the Export/Import 
Utility to help install your INFOConnect products throughout a 
large network. For example, once you install the products on one 
file server, you can use the Copy ICS Database Utility to create 
multiple databases that include only information about the 
products that have been installed. Then you can use the Export/
Import Utility to add appropriate path information to each of the 
databases. In this way, an administrator in one central location 
can create databases for multiple file servers.

For detailed information about this utility, refer to its online Help.

Note:  For the Copy ICS Database Utility to work properly, 
each INFOConnect library registered in the database must 
exist in the location that you want to specify for the executable 
files. For example, if you want to change the location of the 
executable files from \\Server1\INFOCN32 to G:\INFOCN32, 
G:\INFOCN32 must be a mapped directory on the PC running 
this utility, and it must contain all of the libraries registered in 
the INFOConnect database.

To determine the names of the registered libraries, run the 
INFOConnect Manager, click Libraries from the Install menu, 
click a library, and then click Examine. The Filename field 
indicates the name of the file. For example, the file name for the 
Local library is ICLCL32.DLL.



Chapter 3  INFOConnect Database Editor and Utilities

Running the Copy 
ICS Database 
Utility

Before you can run the Copy ICS Database Utility, you must 
install at least one INFOConnect product. Once you have done 
this, you can run this utility from the INFOConnect CD or from 
your PC using the procedures described below.

Running from the CD To run the Copy ICS Database Utility from the CD, follow these 
steps:

1 Hold down the Shift key and insert the CD into a CD-ROM drive.
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2 Using My Computer or File Manager, go to the 32\UTILITY 
folder on the CD (for example, D:\32\UTILITY).

3 Double-click COPICS32.EXE.

Running from a 
PC Hard Disk

To run the Copy ICS Database Utility from your PD hard disk, 
follow these steps:

1 Hold down the Shift key and insert the CD into a CD-ROM drive.

2 Using My Computer or File Manager, go to the 32\UTILITY 
folder on the CD (for example, D:\32\UTILITY).

3 Copy the following files from the CD to a folder on the PC:

4 Go to the folder on the PC where you copied the files.

5 Double-click COPICS32.EXE. 

■ COPICS32.CNT ■ COPICS32.HLP
■ COPICS32.EXE ■ ATMTHK16.DLL 
■ COPICS32.FTS ■ ATMTHK32.DLL 
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About InterCom

INFOConnect InterCom for Windows 95 and Windows NT is a 
terminal emulation program that makes your PC operate like a 
Unisys T 27 terminal. When you run InterCom, your PC can 
communicate with a Unisys A Series host.

InterCom runs within Accessory Manager. The relationship 
between the two is similar to the relationship between a document 
58 About InterCom

and a word processor. When you run a word processor, you have a 
single application window, and no matter which document you 
open, there are functions that are common to all the documents. 
Likewise, when you run Accessory Manager, you have a single 
application window, and no matter which terminal emulation 
session you open, there are functions that are common to all the 
emulators.

Just as a word processor can open multiple documents at once, 
Accessory Manager can open multiple terminal emulation sessions 
at once. For example, using Accessory Manager, you can open one 
session using InterCom to connect to a Unisys A Series host, then 
open a second session using PEP to connect to a Unisys 1100/2200 
Series host. Or you can open multiple sessions using one emulator, 
such as four sessions using InterCom.

InterCom also provides the following features:

■ Default terminal keystrokes that let you perform T 27 functions

■ Pre-defined keyboard maps 

■ Pre-defined QuickPads 

■ CANDE file transfer protocol
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InterCom Keyboard Maps

With InterCom, you can use the default keystrokes to perform 
various terminal emulation tasks, or you can load one of two 
custom keyboard maps that are also provided. Each keyboard map 
associates T 27 functions with specific keys on the PC keyboard. 
You can select whichever one is most familiar and best suited to 
your needs.
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By default, the T27.EKM keyboard map is automatically loaded 
for each new session.

The default keystrokes are listed in “InterCom Default 
Keystrokes” on page 60. The T27.EKM keystrokes are listed in 
“T27.EKM Keystrokes” on page 63. The HSW.EKM keystrokes are 
listed in “HSW.EKM Keystrokes” on page 66. In addition, 
InterCom’s control mode keystrokes are listed in “InterCom 
Control Mode Keystrokes” on page 70.

This keyboard map
Contains keystroke definitions for users 
accustomed to these products

T27.EKM T 27 terminals and previous releases of InterCom

HSW.EKM Handshake and Handshake/Plus



Chapter 4  INFOConnect InterCom

InterCom Default Keystrokes

The following tables list InterCom’s default keystrokes.

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key. For all 
keystrokes that involve the numeric keypad, Num Lock must be 
off.
60 InterCom Default Keystrokes

Note:  If you’re using a keyboard map that has defined these 
keystrokes to perform different functions, the functions 
associated with the keyboard map override the default 
functions described here.

Keystroke Name Description Default Keystroke

BackSpace Moves the cursor left (no characters are erased) Backspace

Bound Marks the end of text to be copied into the data-
sharing buffer

Ctrl+b

CarriageReturn Moves the cursor to the first column of the next line or 
the first column of the current line, depending on the 
session configuration

Enter

ClearPageCursorHome Deletes all text on the page and moves the cursor 
home

In forms mode, this keystroke deletes either text in 
unprotected fields or all text, depending on the 
session configuration. Subsequently, the cursor 
moves to the first unprotected field.

Shift+Home

ClearToEndOfLine Deletes all text from the cursor to the end of the line

In forms mode, this keystroke deletes all text from the 
cursor to the end of the field.

Ctrl+Delete

ClearToEndOfPage Deletes all text from the cursor to the end of the page Ctrl+Shift+Delete

Ctrl Puts the session in control mode Ctrl

CursorToEndOfLine Moves the cursor to the last position on the line Ctrl+End

CursorToEndOfPage Moves the cursor to the last position on the page End

CursorWordLeft Moves the cursor to the first character of the previous 
word

Ctrl+Left Arrow

CursorWordRight Moves the cursor to the first character of the next word Ctrl+Right Arrow
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DeleteFromLine Deletes the character at the cursor location and shifts 
the remaining characters on the line to the left

Delete

DeleteLine Deletes the line where the cursor is located Ctrl+d

Down Moves the cursor down Down Arrow

F1 ... F10 Perform a host-defined function Ctrl+1 ... Ctrl+0

Home Moves the cursor home Home

Keystroke Name Description Default Keystroke
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Ins Toggles between overwrite mode and insert-in-line 
mode

This keystroke might also insert a space at the cursor 
location, depending on the session configuration.

Insert

InsertLine Inserts a line at the cursor location, moving all 
subsequent lines down and moving the cursor to the 
first column of the new line

Any data that was on the last line of the page is lost.

Ctrl+i

Left Moves the cursor left Left Arrow

Local Puts the session in local mode / on the numeric keypad

Mark Marks the beginning of text to be copied into the data-
sharing buffer

Ctrl+m

PageDown Displays the next page

If the last page already is displayed, this keystroke 
displays the first page.

Page Down

PageUp Displays the previous page

If the first page already is displayed, this keystroke 
displays the last page.

Page Up

PutETX Inserts an end-of-text (ETX) character at the cursor 
location and moves the cursor home

In insert-in-line or insert-in-page mode, characters 
after the ETX character shift to the right. In overwrite 
mode, the  ETX character replaces any character at 
the cursor location.

Ctrl+Print Screen

Recall Pastes text copied using Mark and Bound at the 
cursor location

Ctrl+r

Receive Puts the session in receive mode * on the numeric keypad

Right Moves the cursor right Right Arrow
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ShiftF1 ... ShiftF10 Perform a host-defined function Ctrl+Shift+1 ... 
Ctrl+Shift+0

Specify Transmits the cursor location to the host

This keystroke might also send the page number, 
depending on the session configuration. The session 
configuration also determines whether the data is sent 
in hexadecimal or ASCII format.

F5

Keystroke Name Description Default Keystroke
62 InterCom Default Keystrokes

Store Copies text selected using Mark and Bound to the 
data-sharing buffer

Ctrl+s

Tab Moves the cursor to the next tab stop or unprotected 
field

Tab

TabBack Moves the cursor to previous tab stop or unprotected 
field

Shift+Tab

Transmit Transmits data to the host

Depending on the session configuration, this 
keystroke sends the data from home to the cursor 
position or from home to the end of the page.

+ on the numeric keypad

TransmitLine Transmits the data from the beginning of the line to the 
cursor location on the numeric keypad

- on the numeric keypad

Up Moves the cursor up Up Arrow

VertTabReverse Moves the cursor to the previous vertical tab stop

If tabs were not set, this keystroke moves the cursor 
home.

In forms mode, this keystroke moves the cursor to the 
previous unprotected field.

Print Screen
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T27.EKM Keystrokes

The following table lists the keystrokes that you can use with the 
T 27 keyboard map (T27.EKM).

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key. For all 
keystrokes that involve the numeric keypad, Num Lock must be 
off.
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Keystroke Name Description T27.EKM Keystroke

BackSpace Moves the cursor left (no characters are erased) Backspace

Bound Marks the end of text to be copied into the data-
sharing buffer

Ctrl+b

CarriageReturn Moves the cursor to the first column of the next line or 
the first column of the current line, depending on the 
session configuration

Enter

ClearPageCursorHome Deletes all text on the page and moves the cursor 
home

In forms mode, this keystroke deletes either text in 
unprotected fields or all text, depending on the 
session configuration. Subsequently, the cursor 
moves to the first unprotected field.

Shift+Home

ClearToEndOfLine Deletes all text from the cursor to the end of the line

In forms mode, this keystroke deletes all text from the 
cursor to the end of the field.

Ctrl+Delete

ClearToEndOfPage Deletes all text from the cursor to the end of the page Ctrl+Shift+Delete

Ctrl Puts the session in control mode Ctrl

CursorToEndOfLine Moves the cursor to the last position on the line Ctrl+End

CursorToEndOfPage Moves the cursor to the last position on the page End

CursorWordLeft Moves the cursor to the first character of the previous 
word

Ctrl+Left Arrow

CursorWordRight Moves the cursor to the first character of the next word Ctrl+Right Arrow

DeleteFromLine Deletes the character at the cursor location and shifts 
the remaining characters on the line to the left

Delete

DeleteLine Deletes the line where the cursor is located Ctrl+d

Down Moves the cursor down Down Arrow
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F1 ... F10 Perform a host-defined function Ctrl+1 ... Ctrl+0

Home Moves the cursor home Home

Ins Toggles between overwrite mode and insert-in-line 
mode

This keystroke might also insert a space at the cursor 
location, depending on the session configuration.

Insert

Keystroke Name Description T27.EKM Keystroke
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InsertLine Inserts a line at the cursor location, moving all 
subsequent lines down and moving the cursor to the 
first column of the new line

Any data that was on the last line of the page is lost.

Ctrl+i

Left Moves the cursor left Left Arrow

Local Puts the session in local mode F4
/ on the numeric keypad

Mark Marks the beginning of text to be copied into the data-
sharing buffer

Ctrl+m

PageDown Displays the next page

If the last page already is displayed, this keystroke 
displays the first page.

Page Down

PageUp Displays the previous page

If the first page already is displayed, this keystroke 
displays the last page.

Page Up

PutETX Inserts an end-of-text (ETX) character at the cursor 
location and moves the cursor home

In insert-in-line or insert-in-page mode, characters 
after the ETX character shift to the right. In overwrite 
mode, the ETX character replaces any character at 
the cursor location.

Ctrl+Print Screen

Recall Pastes text copied using Mark and Bound at the 
cursor location

Ctrl+r

Receive Puts the session in receive mode F3
* on the numeric keypad

Right Moves the cursor right Right Arrow

ShiftF1 ... ShiftF10 Perform a host-defined function Ctrl+Shift+1 ... 
Ctrl+Shift+0
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Specify Transmits the cursor location to the host

This keystroke might also send the page number, 
depending on the session configuration. The session 
configuration also determines whether the data is sent 
in hexadecimal or ASCII format.

F5

Start/Stop Blind Key 
Programming

Starts or stops blind key programming

If blind key programming is not in progress, this 

Ctrl+F12

Keystroke Name Description T27.EKM Keystroke
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keystroke initiates it. If blind key programming is in 
progress, this keystroke ends it.

Store Copies text selected using Mark and Bound to the 
data-sharing buffer

Ctrl+s

Tab Moves the cursor to the next tab stop or unprotected 
field

Tab

TabBack Moves the cursor to previous tab stop or unprotected 
field

Shift+Tab

ToggleTtyMode Toggles between teletype mode and normal terminal 
emulation

This is used primarily for Poll/Select connections 
using a modem.

Ctrl+t

Transmit Transmits data to the host

Depending on the session configuration, this 
keystroke sends the data from home to the cursor 
position or from home to the end of the page.

F2
+ on the numeric keypad

TransmitLine Transmits the data from the beginning of the line to the 
cursor location

Ctrl+F2
- on the numeric keypad

Up Moves the cursor up Up Arrow

VertTabReverse Moves the cursor to the previous vertical tab stop

If tabs were not set, this keystroke moves the cursor 
home.

In forms mode, this keystroke moves the cursor to the 
previous unprotected field.

Print Screen
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HSW.EKM Keystrokes

The following table lists the keystrokes that you can use with the 
Handshake Windows keyboard map (HSW.EKM).

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key. For all 
keystrokes that involve the numeric keypad, Num Lock must be 
off.
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Keystroke Name Description HSW.EKM Keystroke

BackSpace Moves the cursor left (no characters are erased) Backspace

CarriageReturn Moves the cursor to the first column of the next line or 
the first column of the current line, depending on the 
session configuration

Enter

ClearPageCursorHome Deletes all text on the page and moves the cursor 
home

In forms mode, this keystroke deletes either text in 
unprotected fields or all text, depending on the 
session configuration. Subsequently, the cursor 
moves to the first unprotected field.

Shift+Home

ClearToEndOfLine Deletes all text from the cursor to the end of the line. 
In forms mode, this keystroke deletes all text from the 
cursor to the end of the field.

F8
Ctrl+Delete

ClearToEndOfPage Deletes all text from the cursor to the end of the page Ctrl+Shift+Delete

Ctrl Puts the session in control mode Ctrl

Ctrl h . Starts reverse video Ctrl+n

Ctrl h / Starts underlined video Ctrl+o

Ctrl h : Starts bright video Ctrl+z

Ctrl h 8 Starts blinking video Ctrl+x

Ctrl h 9 Starts secure video Ctrl+y

Ctrl h < Inserts a protected field delimiter Ctrl+\

Ctrl h ? Inserts a left-justified field delimiter Ctrl+ -

Ctrl h = Inserts a right-justified field delimiter Ctrl+]

Ctrl h 7 End all highlights (reverse video, underlined video, 
bright video, blinking video, secure video)

Ctrl+w

Ctrl h > Inserts an end field delimiter Ctrl+6
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CursorToEndOfLine Moves the cursor to the last position on the line Ctrl+End

CursorToEndOfPage Moves the cursor to the last position on the page End

CursorWordLeft Moves the cursor to the first character of the previous 
word

Ctrl+Left Arrow

CursorWordRight Moves the cursor to the first character of the next word Ctrl+Right Arrow

DeleteFromLine Deletes the character at the cursor location and shifts Delete

Keystroke Name Description HSW.EKM Keystroke
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the remaining characters on the line to the left

DeleteLine Deletes the line where the cursor is located F10

Down Moves the cursor down Down Arrow

F1 Performs a host-defined function F1
Ctrl+ ~

F2 Performs a host-defined function F2
Ctrl+1

F3 Performs a host-defined function Ctrl+2

F4 Performs a host-defined function Ctrl+3

F5 Performs a host-defined function Ctrl+4

F6 Performs a host-defined function Ctrl+5

F7 Performs a host-defined function F7

F8 Performs a host-defined function Ctrl+7

F9 Performs a host-defined function Ctrl+8

F10 Performs a host-defined function Ctrl+9

Home Moves the cursor home Home

Ins Toggles between overwrite mode and insert-in-line 
mode. This keystroke might also insert a space at the 
cursor location, depending on the session 
configuration.

Insert

InsertLine Inserts a line at the cursor location, moving all 
subsequent lines down and moving the cursor to the 
first column of the new line. Any data that was on the 
last line of the page is lost.

F9

Left Moves the cursor left Left Arrow

LF Inserts a line feed character at the cursor location Ctrl+j
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Local Puts the session in local mode F6
* on the numeric keypad

PageDown Displays the next page. If the last page already is 
displayed, this keystroke displays the first page.

Page Down

PageUp Displays the previous page. If the first page already is 
displayed, this keystroke displays the last page.

Page Up

PutETX Inserts an end-of-text (ETX) character at the cursor Ctrl+Print Screen

Keystroke Name Description HSW.EKM Keystroke
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location and moves the cursor home

In insert-in-line or insert-in-page mode, characters 
after the ETX character shift to the right. In overwrite 
mode, the ETX character replaces any character at 
the cursor location.

F5
Ctrl+c

Receive Puts the session in receive mode - on the numeric keypad

Right Moves the cursor right Right Arrow

ShiftF1 ... ShiftF10 Perform a host-defined function Shift+F1 ... Shift+F10

Specify Transmits the cursor location to the host. This 
keystroke might also send the page number, 
depending on the session configuration. The session 
configuration also determines whether the data is sent 
in hexadecimal or ASCII format.

F3
/ on the numeric keypad

Start/Stop Blind Key 
Programming

Starts or stops blind key programming

If blind key programming is not in progress, this 
keystroke initiates it. If blind key programming is in 
progress, this keystroke ends it.

Ctrl+F12

Tab Moves the cursor to the next tab stop or unprotected 
field

Tab

TabBack Moves the cursor to previous tab stop or unprotected 
field

F4

ToggleTtyMode Toggles between teletype mode and normal terminal 
emulation

This is used primarily for Poll/Select connections 
using a modem.

Ctrl+t

Transmit Transmits data to the host. Depending on the session 
configuration, this keystroke sends the data from 
home to the cursor position or from home to the end 
of the page.

+ on the numeric keypad
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Up Moves the cursor up Up Arrow

VertTabReverse Moves the cursor to the previous vertical tab stop. If 
tabs were not set, this keystroke moves the cursor 
home. In forms mode, this keystroke moves the 
cursor to the previous unprotected field.

Print Screen

Keystroke Name Description HSW.EKM Keystroke
HSW.EKM Keystrokes 69
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InterCom Control Mode Keystrokes

The following table lists the InterCom keystrokes that you can use 
while in control mode.

For these keystrokes, press and release the first key (Ctrl), then 
press and release any subsequent keys.

Description Keystroke
70 InterCom Control Mode Keystrokes

Moves the cursor to the same location as the Datacomm pointer (DCP) Ctrl >

Toggles the cursor location alarm on or off Ctrl ?

Clears all variable tabs Ctrl o

Deletes the character at the cursor location and shifts the remaining characters 
on the page to the left

In forms mode, this keystroke shifts only the remaining characters in the field to 
the left.

Ctrl Delete

Puts the session in nonforms mode Ctrl q

Disables lowercase characters Ctrl y

Exits search mode Ctrl s

Puts the session in forms mode Ctrl w

Enables lowercase characters Ctrl t

Puts the session in search mode Ctrl a

Puts the session in insert-in-page mode (nonforms mode only) Ctrl Insert

Exchanges the line where the cursor is located with the line below Ctrl b

Exchanges the line where the cursor is located with the line above Ctrl v

Prints all data Ctrl ]

Prints all data and add a form feed at the end of the data Ctrl ;

Print only the data in unprotected fields and add a form feed at the end of the data Ctrl :

Moves the cursor to the first column on the screen without displaying the carriage 
return symbol

Ctrl Enter

Rolls the page down Ctrl m

Rolls the page up Ctrl n

Searches for the next occurrence of the specified character Ctrl Tab
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Sets the mobile home on the page

This indicates where data transmission will begin, but it does not affect cursor 
movement.

Ctrl Home

Sets or clears a variable tab at the cursor location Ctrl p

Moves the cursor to column c, row r, using ASCII characters Ctrl < c r

Moves the cursor to column xx, row yy, using hexadecimal numbers Ctrl @ xx yy

Description Keystroke
InterCom Control Mode Keystrokes 71

Inserts a line feed at the cursor location Ctrl h Enter

Starts reverse video Ctrl h .

Starts underlined video Ctrl h /

Starts bright video Ctrl h :

Starts blinking video Ctrl h 8

Starts secure video Ctrl h 9

Inserts a protected field delimiter Ctrl h <

Inserts a left-justified field delimiter Ctrl h ?

Inserts a right-justified field delimiter Ctrl h =

Ends all highlights (reverse video, underlined video, bright video, blinking video, 
secure video)

Ctrl h 7

Inserts an end field delimiter Ctrl h >

Activates reverse video page Ctrl u

Activates normal video page Ctrl i

Fills the screen with lowercase z characters Ctrl Space m

Specifies which character (x) to search for. (X is case-sensitive.) Ctrl e x

Resets the session Ctrl Space d

Displays the ASCII character set Ctrl Space c

Displays the InterCom version number Ctrl Space v
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InterCom QuickPads

The following table describes the predefined QuickPads that come 
with InterCom. You can load these QuickPads whenever an 
InterCom session is open and perform various terminal emulation 
tasks simply by clicking the buttons on the QuickPad.

File Name Function
72 InterCom QuickPads

T27EDIT.EQP Provides buttons that perform editing functions, such as 
clearing to the end of the line

T27TERM.EQP Provides buttons that perform T 27 terminal functions, such 
as Transmit

T27DISP.EQP Provides buttons that insert control characters that 
determine how the fields look on the screen (reverse video, 
blinking, bright, etc.)

T27KEYBD.EQP Provides buttons that perform cursor movement and 
keyboard functions, such as aligning the cursor to the 
Datacomm pointer (DCP) and setting the mobile home

T27FUNC.EQP Provides buttons representing the T 27 function keys F1 
through F10 and Shift+F1 through Shift+F10

T27.EQP Provides buttons that perform host login and window 
functions. You must modify these buttons for use at your 
site.

T27B.EQP Provides buttons that perform host connect/disconnect 
functions. You must modify these buttons for use at your 
site.

T27MARC.EQP Provides buttons that perform a variety of functions related 
to MARC screens on the host. You must modify these 
buttons for use at your site.

T27TB_H.EQP Provides the toolbar buttons that were originally included 
with InterCom 4.x. This QuickPad displays the buttons 
horizontally on your screen.

T27TB_V.EQP Provides the toolbar buttons that were originally included 
with InterCom 4.x. This QuickPad displays the buttons 
vertically on your screen.
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InterCom File Transfer Protocols

InterCom comes with a CANDE file transfer protocol that you can 
use to transfer text files between your PC and CANDE on the host.

You should be able to transfer files using this protocol without 
making any modifications to the default configuration. However, if 
your host application uses a language other than English, you will 
need to specify the names of certain CANDE commands that are 
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used internally by the file transfer protocol.

Configuring the 
CANDE File 
Transfer Protocol

To configure the CANDE file transfer protocol, follow these steps:

1 With an InterCom session open, click Session Type from the 
Options menu and verify that CANDE is selected as the File 
transfer protocol.

2 With the focus on the File transfer protocol list box, click Settings.

3 Click the desired tabs and complete each one.

For information about any item on this dialog box, click  in the 
upper right corner of the dialog box and then click the desired 
item.

Note:  Once you have selected CANDE as the file transfer 
protocol, you can access the configuration settings by clicking 
Settings from the Options menu and clicking File Transfer from 
the Categories list box.
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Sending a File 
Using CANDE

To send a file, follow these steps:

1 With an InterCom session open and connected to the host, get on 
the CANDE window.

2 From the Tools menu, click Send File.

3 Complete the Cande Send File dialog box.
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For information about any item on this dialog box, click  in the 
upper right corner of the dialog box and then click the desired 
item.

4 Click Transfer.

The status line displays the progress of the transfer. If you have 
configured the CANDE file transfer protocol to display the 
contents of the file, that information also appears on the screen 
during the transfer.

Receiving a File 
Using CANDE

To receive a file, follow these steps:

1 With an InterCom session open and connected to the host, get on 
the CANDE window.

2 From the Tools menu, click Receive File.

3 Complete the Cande Receive File dialog box.

For information about any item on this dialog box, click  in the 
upper right corner of the dialog box and then click the desired 
item.

4 Click Transfer.

The status line displays the progress of the transfer. If you have 
configured the CANDE file transfer protocol to display the 
contents of the file, that information also appears on the screen 
during the transfer.
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InterCom Print Services

InterCom Print Services is a printer emulator that is installed 
automatically when you install InterCom. With Print Services, 
you can use a printer attached to your PC as a host printer.

When you run Print Services, the application window lists the 
print environments that exist in the current configuration file 
(specified in the title bar):
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Each configuration file can contain up to eight print 
environments. Each print environment represents one host 
connection, and the configuration of the print environment 
determines how printing operates.

For example, you can configure a print environment to use a 
particular INFOConnect path and to activate automatically. That 
way, you can begin printing host data simply by running Print 
Services.

The configuration options also determine whether Print Services 
sends the data to a printer as it is received, stores the data in a PC 
file to be printed manually later, or sends the data to a temporary 
spooled file that can be manually saved, printed, or deleted.

You can configure print environments using either Print Services 
or the InterCom Print Services Configuration Utility (described on 
the following page). However, you must use the Configuration 
Utility to create, copy, or delete print environments.

For information about Print Services, refer to the online Help.
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InterCom Print 
Services 
Configuration 
Utility

Using the InterCom Print Services Configuration Utility, you can 
control how InterCom Print Services operates. For example, you 
can specify how Print Services communicates with the host, what 
printer is used, and what translation table is used.

When you run the Configuration Utility, the application window 
displays a column of buttons for each print environment that has 
been defined for the specified configuration file. (The names of the 
print environments do not appear in the application window. 
Instead, each print environment is identified as Ev 1, Ev 2, etc.)
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The configuration settings for each print environment can be 
modified using either Print Services or the Configuration Utility. 
The following are the differences between the two programs:

■ With Print Services, you can modify only the configuration file 
that loads automatically. With the Configuration Utility, you 
can modify any configuration file, as well create and delete files.

■ With Print Services, you can only modify the listed print 
environments. With the Configuration Utility, you can create, 
copy, modify, and delete print environments.

For information about the Configuration Utility, refer to the 
online Help.
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About PEP

INFOConnect PEP for Windows 95 and Windows NT is a terminal 
emulation program that makes your PC operate like a Unisys 
UTS 20/40/60 terminal.  When you run PEP, your PC can 
communicate with a Unisys 1100/2200 Series or System 80 host.

PEP runs within Accessory Manager.  The relationship between 
the two is similar to the relationship between a document and a 
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word processor.  When you run a word processor, you have a single 
application window, and no matter which document you open, 
there are functions that are common to all the documents.  
Likewise, when you run Accessory Manager, you have a single 
application window, and no matter which terminal emulation 
session you open, there are functions that are common to all the 
emulators.

Just as a word processor can open multiple documents at once, 
Accessory Manager can open multiple terminal emulation sessions 
at once. For example, using Accessory Manager, you can open one 
session using PEP to connect to a Unisys 1100/2200 Series host, 
then open a second session using InterCom to connect to a Unisys 
A Series host. Or you can open multiple sessions using one 
emulator, such as four sessions using PEP.

PEP also provides the following features:

■ Default terminal keystrokes that let you perform almost all 
UTS 20/40/60 functions

■ Pre-defined keyboard maps 

■ Pre-defined QuickPads

■ Pre-defined HotSpot schemes

■ OS 2200 Editor and MAPPER file transfer protocols, as well as 
other file transfer mechanisms
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PEP Keyboard Maps

With PEP, you can use the default keystrokes to perform various 
terminal emulation tasks, or you can load one of five custom 
keyboard maps that are also provided.

Each keyboard map associates UTS functions with specific keys on 
the keyboard.  You can select whichever one is most familiar and 
best suited to your needs.
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By default, the PEPWIN.EKM keyboard map is associated with 
each new session profile.

The default PEP keystrokes, as well as the keystrokes associated 
with each of these keyboard maps, appear in the subsequent pages 
of this chapter.

This keyboard map Contains keystrokes for users accustomed to this

PEPWIN.EKM UTS 20/40/60 terminals and previous releases of PEP

UTSWIN.EKM UniStation® (Windows)

UTSDOS.EKM UniStation (DOS)

STEPDOS.EKM STEP (DOS)

LINKUP.EKM LinkUp
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PEP Default Keystrokes

The following table lists PEP’s default keystrokes. 

Note:  If you’re using a keyboard map that has defined these 
keystrokes to perform different functions, the functions 
associated with the keyboard map override the default 
functions described here.
80 PEP Default Keystrokes

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key. For all 
keystrokes that involve the numeric keypad, Num Lock must be 
off.

Keystroke Name Description Default Keystroke

BackSpace Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If the cursor is 
home, it moves to the last column of the last row of the 
page.

Backspace

CancelTransfer Cancels in-progress Extended Control Page file 
transfers for System 80 hosts

Alt+Shift+c

CarriageReturn Moves the cursor to the first column of the next row Enter

ClearChange Resets the changed-field indicator to zero on all FCC  
fields, thereby indicating that all the fields are 
unchanged and should not be transmitted

F4

ClearPageAndFCCs Deletes all protected and unprotected data and all 
FCCs from the cursor to the end of the page

Ctrl+Page Up

ClearPageCursorHome Deletes all text and FCC fields in the current page and 
moves the cursor home

Ctrl+Home

ClearToEndOfField Deletes all unprotected characters in an FCC field 
from the cursor to the end of the FCC field

Ctrl+End

ClearToEndOfLine Deletes all text from the cursor to the end of the row or 
the end of an FCC field, whichever comes first

Ctrl+Shift+End

ClearToEndOfPage Deletes all text from the cursor to the end of the page 
except protected fields

Ctrl+Page Down
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ClearUnprotCharacter Deletes the unprotected character at the cursor 
position

If emphasis is protected, the emphasis characteristic 
isn't removed.

Shift+Space

CloseHostApplication Closes the host application Alt+Shift+x

ColumnSeparatorLeft Places a vertical bar in the leftmost area of a character 
position

Ctrl+j

Keystroke Name Description Default Keystroke
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ColumnSeparatorRight Places a vertical bar in the rightmost area of a 
character position

Ctrl+h

ControlPageToggle Displays or hides the Control Page or Extended 
Control Page, depending on how the session is 
configured

Ctrl+F1

CursorToEndOfField Moves the cursor to the end of the FCC field

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte.

If the last position is protected, the cursor moves to the 
next unprotected character.

Shift+End

CursorToEndOfLine Moves the cursor to the last position of the current row

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte.

If the last position is protected, the cursor moves to the 
next unprotected character.

End

CursorToEndOfPage Moves the cursor to the last position on the current 
page

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte.

If the last position is protected, the cursor moves to the 
next unprotected character.

Ctrl+Right Arrow

CursorToEOPAndXmit Moves the cursor to the end of the page and transmits 
the screen

- on the numeric keypad

CursorToStartOfField Moves the cursor to the first position in the FCC field 
in which the cursor is located

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte.

If the first position is protected, the cursor moves to the 
next unprotected character.

Shift+Home
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CursorToStartOfLine Moves the cursor to the first position on the same row

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte.

If the first position is protected, the cursor moves to the 
next unprotected character.

Ctrl+Left Arrow

DeleteFromLine Deletes the character that the cursor is on, shifts the 
remaining characters on the row to the left, and inserts 

Delete

Keystroke Name Description Default Keystroke
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a space in the last column of the row

In an FCC field, this keystroke deletes the character, 
shifts the remaining characters in that field to the left, 
and inserts a space in the last column of the field. 
Emphasis is unchanged, and the characters in the 
rest of the row aren’t shifted.

DeleteFromPage Deletes the character that the cursor is on and shifts 
all the remaining characters one position to the left

If the cursor is in an FCC field, the characters in that 
field are shifted to the left, but the characters beyond 
the current field aren’t shifted. A space is inserted in 
the last position of the page or field.

Ctrl+Delete

DeleteLine Deletes the row containing the cursor

Subsequent rows move up one row. The bottom row 
is filled with spaces.

Ctrl+Shift+Delete

Down Moves the cursor down one row in the same column

If the cursor is in the bottom row of a page, it moves to 
the top row. 

If there is a protected character below, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Down Arrow

DuplicateLine Copies the row containing the cursor to the row below, 
overwriting whatever was on that row

The cursor moves to the same column on the 
duplicated row.

Ctrl+Down Arrow

F1 ... F10 Perform host-defined functions Ctrl+1 ... Ctrl+0

F11 Performs the host-defined function Ctrl+ -

F12 Performs the host-defined function Ctrl+ =

F13 Performs the host-defined function Ctrl+q

F14 Performs the host-defined function Ctrl+w
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F15 Performs the host-defined function Ctrl+e

F16 Performs the host-defined function Ctrl+r

F17 Performs the host-defined function Ctrl+t

F18 Performs the host-defined function Ctrl+y

F19 Performs the host-defined function Ctrl+u

Keystroke Name Description Default Keystroke
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F20 Performs the host-defined function Ctrl+i

F21 Performs the host-defined function Ctrl+o

F22 Performs the host-defined function Ctrl+p

FCCClear Deletes all text in the FCC field at the cursor location

If there isn’t an FCC at the cursor location, this 
keystroke clears the closest FCC to the left of the 
cursor.

F7

FCCDialogBox Displays the Generate FCC dialog box used to create 
FCCs

Alt+Shift+g

FCCEnable Re-enables FCCs so that you can enter data in them F8

FCCGenerate Initiates the FCC definition process using the 
keyboard instead of the Generate FCC dialog box

F9

FCCLocate Moves the cursor to the first character of the next 
FCC, whether it is protected or not

If this character is protected, protection is cleared.

F5

FileToPage Displays the File To Page dialog box Alt+Shift+f

FormFeed Inserts a form feed character at the cursor location

The cursor moves to the next unprotected position.

Shift+F3

Home Moves the cursor home

If the home position is protected, this keystroke moves 
the cursor to the first unprotected field on the page.

Home

Ins Toggles insert mode on and off Insert
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InsertInLine Inserts a space at the cursor location, moving 
subsequent characters in the row one column to the 
right

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the row aren’t shifted. 

If there is a character in the last column of the row or 

Ctrl+Shift+Space

Keystroke Name Description Default Keystroke
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FCC field, it is lost.

InsertInPage Inserts a space at the cursor location, moving 
subsequent characters on the page one column to the 
right

Any character in the rightmost column moves to the 
first position on the next row. 

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the page aren't shifted. 

If there is a character in the last column in the page or 
field, it is lost.

Ctrl+Space

InsertLine Inserts a row at the cursor location and shifts 
subsequent rows down one

The last row on the page is lost.

Ctrl+Shift+Insert

Left Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If it is in the first 
column of the first row of the page, it moves to the last 
column of the last row of the page. 

If there is a protected character to the left, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Left Arrow

LineFeed Inserts a line feed character at the cursor position

The cursor moves to the next unprotected position.

Shift+F2

MessageWait Displays the waiting host message F3

PageDown Displays the next page

If the last page already is displayed, this keystroke 
displays the first page.

Page Down

PageToFile Displays the Page To File dialog box Alt+Shift+p
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PageUp Displays the previous page

If the first page already is displayed, this keystroke 
displays the last page.

Page Up

PrintRange Performs the equivalent of a host print command * on the numeric keypad

Right Moves the cursor one column to the right

If the cursor is in the last column of a row, it moves to 

Right Arrow

Keystroke Name Description Default Keystroke
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the first column of the next row. If it is in the last 
column of the last row of the page, it moves to the first 
column of the first row of the page.

If there is a protected character to the right, the cursor 
moves to the next unprotected character to the left of 
the protected character.

SelectHostApplication Displays the Open Application dialog box, which lists 
available host applications

This list of applications is specified in the UTS Host 
Applications key in the Windows registry.

Alt+Shift+a

SetStartOfEntry Inserts a start-of-entry (SOE) character at the cursor 
position

In insert mode, characters after the SOE character 
shift to the right. In overwrite mode, the SOE character 
replaces any character at the cursor position.

5 on the numeric keypad

Strikethrough Places a horizontal line through the middle of the 
character at the cursor position

Strikethroughs are the full width of the character and 
connect with adjacent strikethroughs (if any) to form a 
continuous line.

Ctrl+l

SystemMode Puts the session in system mode so that you can send 
and receive certain commands to and from a System 
80 host

Ctrl+[

Tab Moves the cursor to the next tab stop (either an FCC 
tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Tab

TabBack Moves the cursor to the previous tab stop (either an 
FCC tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Shift+Tab
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TabSet Places a tab on the screen at the cursor location and 
moves the cursor one column to the right

Ctrl+5 on the numeric 
keypad

ToggleMsgWaitBeep Toggles the message wait beep on and off

If the beep is turned off, NoBp appears on the status 
line.

Print Screen

Transmit Sends data to the host + on the numeric keypad

Keystroke Name Description Default Keystroke
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Depending on the session configuration, this 
keystroke sends either all data, only unprotected data, 
or only changed data.

Underscore Places a horizontal line under the character at the 
cursor position and moves the cursor to the right

Underscores are the full width of the character and 
connect with adjacent underscores (if any) to form a 
continuous line.

Ctrl+k

UnlockKeyboard Restores keyboard functionality when it is locked due 
to a communication error

Esc

Up Moves the cursor up one row in the same column

If the cursor is in the top row of a page, it moves to the 
bottom row. 

If there is a protected character above, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Up Arrow

Upperscore Places a horizontal line over the character at the 
cursor position and moves the cursor to the right

Upperscores are the full width of the character and 
connect with adjacent upperscores (if any) to form a 
continuous line.

Ctrl+g

WorkstationMode Exits system mode and restores the session page Ctrl+] 
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PEPWIN.EKM Keystrokes

The following table lists the keystrokes that you can use with the 
PEP Windows keyboard map (PEPWIN.EKM).

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key. For all 
keystrokes that involve the numeric keypad, Num Lock must be 
off.
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Keystroke Name Description
PEPWIN.EKM 
Keystroke

BackSpace Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If the cursor is 
home, it moves to the last column of the last row of the 
page.

Backspace
Alt+Shift+b

CancelTransfer Cancels in-progress Extended Control Page file 
transfers for System 80 hosts

Ctrl+Alt+c

CarriageReturn Moves the cursor to the first column of the next row Enter

ClearChange  Resets the changed-field indicator to zero on all FCC 
fields, thereby indicating that all the fields are 
unchanged and should not be transmitted

Ctrl+r

ClearPageAndFCCs Deletes all protected and unprotected data and all 
FCCs from the cursor to the end of the page

Alt+e
Alt+ =
Ctrl+Page Up

ClearPageCursorHome Deletes all text and FCC fields in the current page and 
moves the cursor home

Alt+h
Ctrl+Home on the 
numeric keypad

ClearToEndOfField Deletes all unprotected characters in an FCC field 
from the cursor to the end of the FCC field

Alt+f
Alt+o
Ctrl+End

ClearToEndOfLine Deletes all text from the cursor to the end of the row or 
the end of an FCC field, whichever comes first

Ctrl+Delete
Ctrl+Shift+End

ClearToEndOfPage Deletes all text from the cursor to the end of the page 
except protected fields

Alt+g
Alt+ -
Ctrl+Right Arrow
Ctrl+Page Down on the 
numeric keypad
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ClearUnprotCharacter Deletes the unprotected character at the cursor 
position

If emphasis is protected, the emphasis characteristic 
isn’t removed.

Alt+Space
Shift+Space

CloseHostApplication Closes the host application Alt+Shift+x

ColumnSeparatorLeft Places a vertical bar in the leftmost area of a character Ctrl+j

Keystroke Name Description
PEPWIN.EKM 
Keystroke
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position

ColumnSeparatorRight Places a vertical bar in the rightmost area of a 
character position

Ctrl+h

ControlPageToggle Displays or hides the Control Page or Extended 
Control Page, depending on how the session is 
configured

Ctrl+F1
Alt+Shift+c

Copy Copies the selected text and puts it on the PC 
Clipboard

Ctrl+Alt+Insert

CursorToEndOfField Moves the cursor to the end of the FCC field

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte.

If the last position is protected, the cursor moves to the 
next unprotected character.

Shift+End

CursorToEndOfLine Moves the cursor to the last position of the current row

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte. 

If the last position is protected, the cursor moves to the 
next unprotected character.

End

CursorToEOPAndXmit Moves the cursor to the end of the page and transmits 
the screen

- on the numeric keypad

CursorToStartOfField Moves the cursor to the first position in the FCC field 
in which the cursor is located 

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte. 

If the first position is protected, the cursor moves to the 
next unprotected character.

Shift+Home
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CursorToStartOfLine Moves the cursor to the first position on the same row

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte. 

If the first position is protected, the cursor moves to the 
next unprotected character.

Home
Ctrl+Left Arrow

DeleteFromLine Deletes the character that the cursor is on, shifts the Delete

Keystroke Name Description
PEPWIN.EKM 
Keystroke
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remaining characters on the row to the left, and inserts 
a space in the last column of the row

In an FCC field, this keystroke deletes the character, 
shifts the remaining characters in that field to the left, 
and inserts a space in the last column of the field. 
Emphasis is unchanged, and the characters in the 
rest of the row aren’t shifted.

DeleteFromPage Deletes the character that the cursor is on and shifts 
all the remaining characters one position to the left

If the cursor is in an FCC field, the characters in that 
field are shifted to the left, but the characters beyond 
the current field aren’t shifted. A space is inserted in 
the last position of the page or field.

Shift+Delete
Ctrl+Delete on the 
numeric keypad

DeleteLine Deletes the row containing the cursor

Subsequent rows move up one row. The bottom row 
is filled with spaces.

Ctrl+d
Ctrl+Shift+Delete on the 
numeric keypad

Down Moves the cursor down one row in the same column

If the cursor is in the bottom row of a page, it moves to 
the top row. 

If there is a protected character below, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Down Arrow

F1 ... F10 Perform host-defined functions Ctrl+1 ... Ctrl+0

F11 Performs the host-defined function Alt+1
Shift+F1

F12 Performs the host-defined function Alt+2
Shift+F2

F13 Performs the host-defined function Alt+3
Shift+F3

F14 Performs the host-defined function Alt+4
Shift+F4
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F15 Performs the host-defined function Alt+5
Shift+F5

F16 Performs the host-defined function Alt+6
Shift+F6

F17 Performs the host-defined function Alt+7
Shift+F7

Keystroke Name Description
PEPWIN.EKM 
Keystroke
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F18 Performs the host-defined function Alt+8
Shift+F8

F19 Performs the host-defined function Alt+9
Shift+F9

F20 Performs the host-defined function Alt+0
Shift+F10

F21 Performs the host-defined function Alt+F1
Alt+Shift+1

F22 Performs the host-defined function Alt+F2
Alt+Shift+2

FCCClear Deletes all text in the FCC field at the cursor location

If there isn’t an FCC at the cursor location, this 
keystroke clears the closest FCC to the left of the 
cursor.

Alt+k
Ctrl+c

FCCEnable Re-enables FCCs so that you can enter data in them Alt+b

FCCGenerate Initiates the FCC definition process using the 
keyboard instead of the Generate FCC dialog box

Alt+q
Ctrl+g

FCCLocate Moves the cursor to the first character of the next 
FCC, whether it is protected or not

If this character is protected, protection is cleared.

Alt+t
Ctrl+o

FileToPage Displays the File To Page dialog box Alt+Shift+f

FormFeed Inserts a form feed character at the cursor location

The cursor moves to the next unprotected position.

Ctrl+f

Home Moves the cursor home

If the home position is protected, this keystroke moves 
the cursor to the first unprotected field on the page.

Ctrl+Home
Home on the numeric 
keypad

Ins Toggles insert mode on and off Insert
Ctrl+Insert
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InsertInLine Inserts a space at the cursor location, moving 
subsequent characters in the row one column to the 
right

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the row aren’t shifted. 

Ctrl+Shift+Space

Keystroke Name Description
PEPWIN.EKM 
Keystroke
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If there is a character in the last column of the row or 
FCC field, it is lost.

InsertInPage Inserts a space at the cursor location, moving 
subsequent characters on the page one column to the 
right

Any character in the rightmost column moves to the 
first position on the next row. 

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the page aren't shifted. 

If there is a character in the last column in the page or 
field, it is lost.

Shift+Insert

InsertLine Inserts a row at the cursor location and shifts 
subsequent rows down one

The last row on the page is lost.

Ctrl+Page Down
Ctrl+Shift+Insert on the 
numeric keypad

Left Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If it is in the first 
column of the first row of the page, it moves to the last 
column of the last row of the page. 

If there is a protected character to the left, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Left Arrow

LineFeed Inserts a line feed character at the cursor position

The cursor moves to the next unprotected position.

Ctrl+l

MessageWait Displays the waiting host message Ctrl+m

PageDown Displays the next page

If the last page already is displayed, this keystroke 
displays the first page.

Page Down

PageDownFile Displays the first page of a file-to-page file Ctrl+Shift+Page Down
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PageToFile Displays the Page To File dialog box Alt+Shift+p

PageUp Displays the previous page

If the first page already is displayed, this keystroke 
displays the last page.

Page Up
Shift+Page Up

PrintRange Performs the equivalent of a host print command Alt+r
Alt+Print Screen

Keystroke Name Description
PEPWIN.EKM 
Keystroke
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* on the numeric keypad

Right Moves the cursor one column to the right

If the cursor is in the last column of a row, it moves to 
the first column of the next row. If it is in the last 
column of the last row of the page, it moves to the first 
column of the first row of the page. 

If there is a protected character to the right, the cursor 
moves to the next unprotected character to the left of 
the protected character.

Right Arrow

SelectHostApplication Displays the Open Application dialog box, which lists 
available host applications

This list of applications is specified in the UTS Host 
Applications key in the Windows registry.

Alt+Shift+a

SetStartOfEntry Inserts a start-of-entry (SOE) character at the cursor 
position

In insert mode, characters after the SOE character 
shift to the right. In overwrite mode, the SOE character 
replaces any character at the cursor position.

Alt+Shift+o
5 on the numeric keypad

Start/Stop Blind Key 
Programming

Starts or stops blind key programming

If blind key programming is not in progress, this 
keystroke initiates it. If blind key programming is in 
progress, this keystroke ends it.

Ctrl+F12

Strikethrough Places a horizontal line through the middle of the 
character at the cursor position

Strikethroughs are the full width of the character and 
connect with adjacent strikethroughs (if any) to form a 
continuous line.

Ctrl+Shift+l

SystemMode Puts the session in system mode so that you can send 
and receive certain commands to and from a System 
80 host

Alt+Shift+y
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Tab Moves the cursor to the next tab stop (either an FCC 
tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Tab

TabBack Moves the cursor to the previous tab stop (either an 
FCC tab or a tab on the screen)

Shift+Tab

Keystroke Name Description
PEPWIN.EKM 
Keystroke
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If tabs were not set, this keystroke moves the cursor 
home.

TabSet Places a tab on the screen at the cursor location and 
moves the cursor one column to the right

Ctrl+5 on the numeric 
keypad

ToggleMsgWaitBeep Toggles the message wait beep on and off

If the beep is turned off, NoBp appears on the status 
line.

Print Screen

Transmit Sends data to the host

Depending on the session configuration, this 
keystroke sends either all data, only unprotected data, 
or only changed data.

Alt+Shift+t 
Scroll Lock 
+ on the numeric keypad
Enter on the numeric 
keypad

Underscore Places a horizontal line under the character at the 
cursor position and moves the cursor to the right

Underscores are the full width of the character and 
connect with adjacent underscores (if any) to form a 
continuous line.

Ctrl+k

UnlockKeyboard Restores keyboard functionality when it is locked due 
to a communication error

Esc
Ctrl+ + on the numeric 
keypad
Ctrl+Enter on the 
numeric keypad

Up Moves the cursor up one row in the same column

If the cursor is in the top row of a page, it moves to the 
bottom row. 

If there is a protected character above, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Up Arrow

WorkstationMode Exits system mode and restores the session page Alt+Shift+w
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UTSWIN.EKM Keystrokes

The following table lists the keystrokes that you can use with the 
UniStation Windows keyboard map (UTSWIN.EKM).

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key. For all 
keystrokes that involve the numeric keypad, Num Lock must be 
off. 
94 UTSWIN.EKM Keystrokes

Keystroke Name Description
UTSWIN.EKM 
Keystroke

BackSpace Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If the cursor is 
home, it moves to the last column of the last row of the 
page.

Backspace
Ctrl+Backspace

CancelTransfer Cancels in-progress Extended Control Page file 
transfers for System 80 hosts

Alt+Shift+c

CarriageReturn Moves the cursor to the first column of the next row Enter

ClearChange Resets the changed-field indicator to zero on all FCC 
fields, thereby indicating that all the fields are 
unchanged and should not be transmitted

F4

ClearPageAndFCCs Deletes all protected and unprotected data and all 
FCCs from the cursor to the end of the page

Alt+e

ClearPageCursorHome Deletes all text and FCC fields in the current page and 
moves the cursor home

Ctrl+Home

ClearToEndOfField Deletes all unprotected characters in an FCC field 
from the cursor to the end of the FCC field

Ctrl+End

ClearToEndOfLine Deletes all text from the cursor to the end of the row or 
the end of an FCC field, whichever comes first

Ctrl+Shift+End

ClearToEndOfPage Deletes all text from the cursor to the end of the page 
except protected fields

Ctrl+Page Up

ClearUnprotCharacter Deletes the unprotected character at the cursor 
position

If emphasis is protected, the emphasis characteristic 
isn’t removed.

Ctrl+Page Down 
Shift+Space

CloseHostApplication Closes the host application Alt+Shift+x
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ColumnSeparatorLeft Places a vertical bar in the leftmost area of a character 
position

Ctrl+j

ColumnSeparatorRight Places a vertical bar in the rightmost area of a 
character position

Ctrl+h

ControlPageToggle Displays or hides the Control Page or Extended 
Control Page, depending on how the session is 

Ctrl+F1

Keystroke Name Description
UTSWIN.EKM 
Keystroke
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configured

CursorToEndOfField Moves the cursor to the end of the FCC field

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte. 

If the last position is protected, the cursor moves to the 
next unprotected character.

Shift+End

CursorToEndOfLine Moves the cursor to the last position of the current row 

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte. 

If the last position is protected, the cursor moves to the 
next unprotected character.

End

CursorToEndOfPage Moves the cursor to the last position on the current 
page

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte. 

If the last position is protected, the cursor moves to the 
next unprotected character.

Ctrl+Right Arrow

CursorToEOPAndXmit Moves the cursor to the end of the page and transmits 
the screen

- on the numeric keypad

CursorToStartOfField Moves the cursor to the first position in the FCC field 
in which the cursor is located

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte. 

If the first position is protected, the cursor moves to the 
next unprotected character.

Shift+Home

CursorToStartOfLine Moves the cursor to the first position on the same row

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte.

If the first position is protected, the cursor moves to the 
next unprotected character.

Ctrl+Left Arrow



Chapter 5  INFOConnect PEP

DeleteFromLine Deletes the character that the cursor is on, shifts the 
remaining characters on the row to the left, and inserts 
a space in the last column of the row

In an FCC field, this keystroke deletes the character, 
shifts the remaining characters in that field to the left, 
and inserts a space in the last column of the field. 
Emphasis is unchanged, and the characters in the 

Delete

Keystroke Name Description
UTSWIN.EKM 
Keystroke
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rest of the row aren’t shifted.

DeleteFromPage Deletes the character that the cursor is on and shifts 
all the remaining characters one position to the left

If the cursor is in an FCC field, the characters in that 
field are shifted to the left, but the characters beyond 
the current field aren’t shifted. A space is inserted in 
the last position of the page or field.

Ctrl+Delete

DeleteLine Deletes the row containing the cursor

Subsequent rows move up one row. The bottom row 
is filled with spaces.

Ctrl+Shift+Delete

Down Moves the cursor down one row in the same column

If the cursor is in the bottom row of a page, it moves to 
the top row. 

If there is a protected character below, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Down Arrow

DuplicateLine Copies the row containing the cursor to the row below, 
overwriting whatever was on that row

The cursor moves to the same column on the 
duplicated row.

Ctrl+Down Arrow

F1 ... F10 Perform host-defined functions Ctrl+1 ... Ctrl+0

F11 Performs the host-defined function Ctrl+ -

F12 Performs the host-defined function Ctrl+ =

F13 Performs the host-defined function Ctrl+q

F14 Performs the host-defined function Ctrl+w

F15 Performs the host-defined function Ctrl+e

F16 Performs the host-defined function Ctrl+r

F17 Performs the host-defined function Ctrl+t
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F18 Performs the host-defined function Ctrl+y

F19 Performs the host-defined function Ctrl+u

F20 Performs the host-defined function Ctrl+i

F21 Performs the host-defined function Ctrl+o

F22 Performs the host-defined function Ctrl+p

Keystroke Name Description
UTSWIN.EKM 
Keystroke
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FCCClear Deletes all text in the FCC field at the cursor location

If there isn’t an FCC at the cursor location, this 
keystroke clears the closest FCC to the left of the 
cursor.

F7

FCCEnable Re-enables FCCs so that you can enter data in them F8

FCCGenerate Initiates the FCC definition process using the 
keyboard instead of the Generate FCC dialog box

F9
Alt+Shift+g

FCCLocate Moves the cursor to the first character of the next 
FCC, whether it is protected or not

If this character is protected, protection is cleared.

F5

FileToPage Displays the File To Page dialog box Alt+Shift+p

FormFeed Inserts a form feed character at the cursor location

The cursor moves to the next unprotected position.

Shift+F3

Home Moves the cursor home

If the home position is protected, this keystroke moves 
the cursor to the first unprotected field on the page.

Home

Ins Toggles insert mode on and off Insert

InsertInLine Inserts a space at the cursor location, moving 
subsequent characters in the row one column to the 
right

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the row aren’t shifted. 

If there is a character in the last column of the row or 
FCC field, it is lost.

Ctrl+Shift+Space
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InsertInPage Inserts a space at the cursor location, moving 
subsequent characters on the page one column to the 
right

Any character in the rightmost column moves to the 
first position on the next row. 

If the cursor is in an FCC field, the subsequent 

Ctrl+Space

Keystroke Name Description
UTSWIN.EKM 
Keystroke
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characters in that field are shifted to the right, but the 
characters in the rest of the page aren’t shifted. 

If there is a character in the last column in the page or 
field, it is lost.

InsertLine Inserts a row at the cursor location and shifts 
subsequent rows down one

The last row on the page is lost.

Ctrl+Shift+Insert

Left Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If it is in the first 
column of the first row of the page, it moves to the last 
column of the last row of the page. 

If there is a protected character to the left, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Left Arrow

LineFeed Inserts a line feed character at the cursor position

The cursor moves to the next unprotected position.

Shift+F2

MessageWait Displays the waiting host message F3

PageDown Displays the next page

If the last page already is displayed, this keystroke 
displays the first page.

Page Down

PageToFile Displays the Page To File dialog box Alt+Shift+f

PageUp Displays the previous page

If the first page already is displayed, this keystroke 
displays the last page.

Page Up

PrintRange Performs the equivalent of a host print command * on the numeric keypad
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Right Moves the cursor one column to the right

If the cursor is in the last column of a row, it moves to 
the first column of the next row. If it is in the last 
column of the last row of the page, it moves to the first 
column of the first row of the page.

If there is a protected character to the right, the cursor 

Right Arrow

Keystroke Name Description
UTSWIN.EKM 
Keystroke
UTSWIN.EKM Keystrokes 99

moves to the next unprotected character to the left of 
the protected character.

SelectHostApplication Displays the Open Application dialog box, which lists 
available host applications

This list of applications is specified in the UTS Host 
Applications key in the Windows registry.

Alt+Shift+a

SetStartOfEntry Inserts a start-of-entry (SOE) character at the cursor 
position

In insert mode, characters after the SOE character 
shift to the right. In overwrite mode, the SOE character 
replaces any character at the cursor position.

Ctrl+ \
5 on the numeric keypad

Start/Stop Blind Key 
Programming

Starts or stops blind key programming

If blind key programming is not in progress, this 
keystroke initiates it. If blind key programming is in 
progress, this keystroke ends it.

Ctrl+F12

Strikethrough Places a horizontal line through the middle of the 
character at the cursor position

Strikethroughs are the full width of the character and 
connect with adjacent strikethroughs (if any) to form a 
continuous line.

Ctrl+l

SystemMode Puts the session in system mode so that you can send 
and receive certain commands to and from a System 
80 host

Ctrl+[

Tab Moves the cursor to the next tab stop (either an FCC 
tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Tab

TabBack Moves the cursor to the previous tab stop (either an 
FCC tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Shift+Tab
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TabSet Places a tab on the screen at the cursor location and 
moves the cursor one column to the right

Ctrl+5 on the numeric 
keypad

ToggleMsgWaitBeep Toggles the message wait beep on and off

If the beep is turned off, NoBp appears on the status 
line.

Print Screen

Transmit Sends data to the host F2

Keystroke Name Description
UTSWIN.EKM 
Keystroke
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Depending on the session configuration, this 
keystroke sends either all data, only unprotected data, 
or only changed data.

Scroll Lock 
Ctrl+Enter 
+ on the numeric keypad

Underscore Places a horizontal line under the character at the 
cursor position and moves the cursor to the right

Underscores are the full width of the character and 
connect with adjacent underscores (if any) to form a 
continuous line.

Ctrl+k

UnlockKeyboard Restores keyboard functionality when it is locked due 
to a communication error

Esc

Up Moves the cursor up one row in the same column

If the cursor is in the top row of a page, it moves to the 
bottom row. 

If there is a protected character above, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Up Arrow

WorkstationMode Exits system mode and restores the session page Ctrl+]
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UTSDOS.EKM Keystrokes

The following table lists the keystrokes that you can use with the 
UniStation DOS keyboard map (UTSDOS.EKM).

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key. For all 
keystrokes that involve the numeric keypad, Num Lock must be 
off.
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Keystroke Name Description
UTSDOS.EKM 
Keystroke

BackSpace Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If the cursor is 
home, it moves to the last column of the last row of the 
page.

Backspace
Shift+Backspace

CancelTransfer Cancels in-progress Extended Control Page file 
transfers for System 80 hosts

Alt+Shift+c

CarriageReturn Moves the cursor to the first column of the next row Enter
Enter on the numeric 
keypad

ClearChange Resets the changed-field indicator to zero on all FCC 
fields, thereby indicating that all the fields are 
unchanged and should not be transmitted

F4
Ctrl+x 

ClearPageAndFCCs Deletes all protected and unprotected data and all 
FCCs from the cursor to the end of the page

Ctrl+F1
Ctrl+Page Up

ClearPageCursorHome Deletes all text and FCC fields in the current page and 
moves the cursor home

Ctrl+c
Ctrl+Home

ClearToEndOfField Deletes all unprotected characters in an FCC field 
from the cursor to the end of the FCC field

F1
Ctrl+End
Shift+End

ClearToEndOfLine Deletes all text from the cursor to the end of the row or 
the end of an FCC field, whichever comes first

F2
Ctrl+Shift+End

ClearToEndOfPage Deletes all text from the cursor to the end of the page 
except protected fields

Ctrl+F2
Ctrl+Page Down

ClearUnprotCharacter Deletes the unprotected character at the cursor 
position

If emphasis is protected, the emphasis characteristic 
isn’t removed.

Shift+Space
Alt+Space
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CloseHostApplication Closes the host application Alt+Shift+x

ColumnSeparatorLeft Places a vertical bar in the leftmost area of a character 
position

Ctrl+q

ColumnSeparatorRight Places a vertical bar in the rightmost area of a 
character position

Ctrl+w

ControlPageToggle Displays or hides the Control Page or Extended Alt+c

Keystroke Name Description
UTSDOS.EKM 
Keystroke
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Control Page, depending on how the session is 
configured

CursorToEndOfField Moves the cursor to the end of the FCC field

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte. 

If the last position is protected, the cursor moves to the 
next unprotected character.

Shift+End

CursorToEndOfLine Moves the cursor to the last position of the current row

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte. 

If the last position is protected, the cursor moves to the 
next unprotected character.

End

CursorToEndOfPage Moves the cursor to the last position on the current 
page

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte. 

If the last position is protected, the cursor moves to the 
next unprotected character.

Ctrl+Right Arrow

CursorToEOPAndXmit Moves the cursor to the end of the page and transmits 
the screen

- on the numeric keypad

CursorToStartOfField Moves the cursor to the first position in the FCC field 
in which the cursor is located

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte. 

If the first position is protected, the cursor moves to the 
next unprotected character.

Shift+Home
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CursorToStartOfLine Moves the cursor to the first position on the same row

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte. 

If the first position is protected, the cursor moves to the 
next unprotected character.

Ctrl+Left Arrow

Cut Removes the selected text and puts it on the PC Shift+Delete

Keystroke Name Description
UTSDOS.EKM 
Keystroke
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Clipboard

DeleteFromLine Deletes the character that the cursor is on, shifts the 
remaining characters on the row to the left, and inserts 
a space in the last column of the row

In an FCC field, this keystroke deletes the character, 
shifts the remaining characters in that field to the left, 
and inserts a space in the last column of the field. 
Emphasis is unchanged, and the characters in the 
rest of the row aren’t shifted.

Delete

DeleteFromPage Deletes the character that the cursor is on and shifts 
all the remaining characters one position to the left. 

If the cursor is in an FCC field, the characters in that 
field are shifted to the left, but the characters beyond 
the current field aren’t shifted. A space is inserted in 
the last position of the page or field.

Ctrl+d
Ctrl+Delete

DeleteLine Deletes the row containing the cursor

Subsequent rows move up one row. The bottom row 
is filled with spaces.

Ctrl+y
Ctrl+Shift+Delete

Down Moves the cursor down one row in the same column

If the cursor is in the bottom row of a page, it moves to 
the top row. 

If there is a protected character below, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Down Arrow

DuplicateLine Copies the row containing the cursor to the row below, 
overwriting whatever was on that row

The cursor moves to the same column on the 
duplicated row.

Ctrl+F5 
Ctrl+Down Arrow

F1 ... F10 Perform host-defined functions Alt+1 ... Alt+0

F11 Performs the host-defined function Alt+ -
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F12 Performs the host-defined function Alt+ =

F13 Performs the host-defined function Alt+q

F14 Performs the host-defined function Alt+w

F15 Performs the host-defined function Alt+e

F16 Performs the host-defined function Alt+r

Keystroke Name Description
UTSDOS.EKM 
Keystroke
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F17 Performs the host-defined function Alt+t

F18 Performs the host-defined function Alt+y

F19 Performs the host-defined function Alt+u

F20 Performs the host-defined function Alt+i

F21 Performs the host-defined function Alt+o

F22 Performs the host-defined function Alt+p

FCCClear Deletes all text in the FCC field at the cursor location

If there isn’t an FCC at the cursor location, this 
keystroke clears the closest FCC to the left of the 
cursor.

Shift+F7

FCCDialogBox Displays the Generate FCC dialog box used to create 
FCCs

Alt+Shift+g

FCCEnable Re-enables FCCs so that you can enter data in them F8
Shift+F5

FCCGenerate Initiates the FCC definition process using the 
keyboard instead of the Generate FCC dialog box

F9
Shift+F4

FCCLocate Moves the cursor to the first character of the next 
FCC, whether it is protected or not

If this character is protected, protection is cleared.

F5
Shift+F6

FileToPage Displays the File To Page dialog box Alt+F5
Alt+Shift+f

FormFeed Inserts a form feed character at the cursor location

The cursor moves to the next unprotected position.

Alt+l
Shift+F3

Home Moves the cursor home

If the home position is protected, this keystroke moves 
the cursor to the first unprotected field on the page.

Home

Ins Toggles insert mode on and off Ctrl+Insert
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InsertInLine Inserts a space at the cursor location, moving 
subsequent characters in the row one column to the 
right

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the row aren’t shifted. 

Insert
Ctrl+Shift+Space

Keystroke Name Description
UTSDOS.EKM 
Keystroke
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If there is a character in the last column of the row or 
FCC field, it is lost.

InsertInPage Inserts a space at the cursor location, moving 
subsequent characters on the page one column to the 
right

Any character in the rightmost column moves to the 
first position on the next row. 

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the page aren’t shifted. 

If there is a character in the last column in the page or 
field, it is lost.

Ctrl+i

InsertLine Inserts a row at the cursor location and shifts 
subsequent rows down one

The last row on the page is lost.

Ctrl+n
Ctrl+Shift+Insert

Left Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If it is in the first 
column of the first row of the page, it moves to the last 
column of the last row of the page. 

If there is a protected character to the left, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Left Arrow

LineFeed Inserts a line feed character at the cursor position

The cursor moves to the next unprotected position.

Ctrl+j
Shift+F2

MessageWait Displays the waiting host message F3
Shift+Scroll Lock 

PageDown Displays the next page

If the last page already is displayed, this keystroke 
displays the first page.

Page Down

PageDownFile Displays the first page of a file-to-page file Shift+Page Down
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PageToFile Displays the Page To File dialog box Alt+F6
Alt+Shift+p

PageUp Displays the previous page

If the first page already is displayed, this keystroke 
displays the last page.

Page Up
Shift+Page Up

Paste Pastes the cut or copied text at the cursor location Shift+Insert

Keystroke Name Description
UTSDOS.EKM 
Keystroke
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PrintRange Performs the equivalent of a host print command Ctrl+p
* on the numeric keypad

Right Moves the cursor one column to the right

If the cursor is in the last column of a row, it moves to 
the first column of the next row. If it is in the last 
column of the last row of the page, it moves to the first 
column of the first row of the page. 

If there is a protected character to the right, the cursor 
moves to the next unprotected character to the left of 
the protected character.

Right Arrow

SelectDown Selects the character where the cursor is currently 
located and the character beneath it

Shift+Down Arrow

SelectHostApplication Displays the Open Application dialog box, which lists 
available host applications

This list of applications is specified in the UTS Host 
Applications key in the Windows registry.

Alt+Shift+a

SelectLeft Selects the character where the cursor is currently 
located and the character to the left of it

Shift+Left Arrow

SelectRight Selects the character where the cursor is currently 
located and the character to the right of it

Shift+Right Arrow

SelectUp Selects the character where the cursor is currently 
located and the character above it

Shift+Up Arrow

SetStartOfEntry Inserts a start-of-entry (SOE) character at the cursor 
position

In insert mode, characters after the SOE character 
shift to the right. In overwrite mode, the SOE character 
replaces any character at the cursor position.

5 on the numeric keypad
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Start/Stop Blind Key 
Programming

Starts or stops blind key programming

If blind key programming is not in progress, this 
keystroke initiates it. If blind key programming is in 
progress, this keystroke ends it.

Ctrl+F12

Strikethrough Places a horizontal line through the middle of the 
character at the cursor position

Ctrl+z

Keystroke Name Description
UTSDOS.EKM 
Keystroke
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Strikethroughs are the full width of the character and 
connect with adjacent strikethroughs (if any) to form a 
continuous line.

SystemMode Puts the session in system mode so that you can send 
and receive certain commands to and from a System 
80 host

Alt+s

Tab Moves the cursor to the next tab stop (either an FCC 
tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Tab

TabBack Moves the cursor to the previous tab stop (either an 
FCC tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Shift+Tab

TabSet Places a tab on the screen at the cursor location and 
moves the cursor one column to the right

Ctrl+t 
Ctrl+F6
Ctrl+5 on the numeric 
keypad

ToggleMsgWaitBeep Toggles the message wait beep on and off

If the beep is turned off, NoBp appears on the status 
line.

Print Screen
Ctrl+Shift+F9

Transmit Sends data to the host

Depending on the session configuration, this 
keystroke sends either all data, only unprotected data, 
or only changed data.

Scroll Lock 
+ on the numeric keypad

Underscore Places a horizontal line under the character at the 
cursor position and moves the cursor to the right

Underscores are the full width of the character and 
connect with adjacent underscores (if any) to form a 
continuous line.

Ctrl+a
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UnlockKeyboard Restores keyboard functionality when it is locked due 
to a communication error

Esc

Up Moves the cursor up one row in the same column

If the cursor is in the top row of a page, it moves to the 
bottom row. 

If there is a protected character above, the cursor 

Up Arrow

Keystroke Name Description
UTSDOS.EKM 
Keystroke
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moves to the next unprotected character to the right of 
the protected character.

WorkstationMode Exits system mode and restores the session page Alt+d 
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STEPDOS.EKM Keystrokes

The following table lists the keystrokes that you can use with the 
STEP DOS keyboard map (STEPDOS.EKM).

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key. For all 
keystrokes that involve the numeric keypad, Num Lock must be 
off.
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Keystroke Name Description
STEPDOS.EKM 
Keystroke

BackSpace Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If the cursor is 
home, it moves to the last column of the last row of the 
page.

Backspace 
Alt+Shift+b

CancelTransfer Cancels in-progress Extended Control Page file 
transfers for System 80 hosts

Alt+Shift+c

CarriageReturn Moves the cursor to the first column of the next row Enter

ClearChange Resets the changed-field indicator to zero on all FCC 
fields, thereby indicating that all the fields are 
unchanged and should not be transmitted

Ctrl+r

ClearPageAndFCCs Deletes all protected and unprotected data and all 
FCCs from the cursor to the end of the page

Alt+ = 
Alt+e
Ctrl+Page Up

ClearPageCursorHome Deletes all text and FCC fields in the current page and 
moves the cursor home

Alt+h
Ctrl+Home

ClearToEndOfField Deletes all unprotected characters in an FCC field 
from the cursor to the end of the FCC field

Alt+f 
Alt+o
Ctrl+End

ClearToEndOfLine Deletes all text from the cursor to the end of the row or 
the end of an FCC field, whichever comes first

Alt+9
Ctrl+Shift+End

ClearToEndOfPage Deletes all text from the cursor to the end of the page 
except protected fields

Alt+g 
Alt+ -
Ctrl+Page Down

ClearUnprotCharacter Deletes the unprotected character at the cursor 
position

If emphasis is protected, the emphasis characteristic 
isn’t removed.

Alt+Space
Shift+Space
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CloseHostApplication Closes the host application Alt+Shift+x

ColumnSeparatorLeft Places a vertical bar in the leftmost area of a character 
position

Ctrl+j

ColumnSeparatorRight Places a vertical bar in the rightmost area of a 
character position

Ctrl+h

ControlPageToggle Displays or hides the Control Page or Extended Alt+3

Keystroke Name Description
STEPDOS.EKM 
Keystroke
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Control Page, depending on how the session is 
configured

Ctrl+F1

Copy Copies the selected text and puts it on the PC 
Clipboard

Ctrl+Alt+Insert

CursorToEndOfField Moves the cursor to the end of the FCC field

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte. 

If the last position is protected, the cursor moves to the 
next unprotected character.

Shift+End

CursorToEndOfLine Moves the cursor to the last position of the current row

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte.

If the last position is protected, the cursor moves to the 
next unprotected character.

End

CursorToEndOfPage Moves the cursor to the last position on the current 
page

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte.

If the last position is protected, the cursor moves to the 
next unprotected character.

Ctrl+Right Arrow

CursorToEOPAndXmit Moves the cursor to the end of the page and transmits 
the screen

- on the numeric keypad

CursorToStartOfField Moves the cursor to the first position in the FCC field 
in which the cursor is located

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte. 

If the first position is protected, the cursor moves to the 
next unprotected character.

Shift+Home
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CursorToStartOfLine Moves the cursor to the first position on the same row

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte. 

If the first position is protected, the cursor moves to the 
next unprotected character.

Ctrl+Left Arrow

Cut Removes the selected text and puts it on the PC Ctrl+Shift+Delete 

Keystroke Name Description
STEPDOS.EKM 
Keystroke
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Clipboard

DeleteFromLine Deletes the character that the cursor is on, shifts the 
remaining characters on the row to the left, and inserts 
a space in the last column of the row

In an FCC field, this keystroke deletes the character, 
shifts the remaining characters in that field to the left, 
and inserts a space in the last column of the field. 
Emphasis is unchanged, and the characters in the rest 
of the row aren’t shifted.

Delete

DeleteFromPage Deletes the character that the cursor is on and shifts 
all the remaining characters one position to the left

If the cursor is in an FCC field, the characters in that 
field are shifted to the left, but the characters beyond 
the current field aren’t shifted. A space is inserted in 
the last position of the page or field.

Shift+Delete
Ctrl+Delete

DeleteLine Deletes the row containing the cursor

Subsequent rows move up one row. The bottom row is 
filled with spaces.

Page Up
Ctrl+Shift+Delete on the 
numeric keypad

Down Moves the cursor down one row in the same column

If the cursor is in the bottom row of a page, it moves to 
the top row. 

If there is a protected character below, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Down Arrow

DuplicateLine Copies the row containing the cursor to the row below, 
overwriting whatever was on that row

The cursor moves to the same column on the 
duplicated row.

Alt+Insert
Ctrl+Down Arrow

F1 ... F10 Perform host-defined functions F1...F10
Ctrl+1 ... Ctrl+0
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F11 Performs the host-defined function Shift+F1
Ctrl+ -

F12 Performs the host-defined function Shift+F2
Ctrl+ =

F13 Performs the host-defined function Shift+F3

F14 Performs the host-defined function Shift+F4

Keystroke Name Description
STEPDOS.EKM 
Keystroke
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F15 Performs the host-defined function Shift+F5

F16 Performs the host-defined function Shift+F6

F17 Performs the host-defined function Shift+F7

F18 Performs the host-defined function Shift+F8

F19 Performs the host-defined function Shift+F9

F20 Performs the host-defined function Shift+F10

F21 Performs the host-defined function Alt+F1

F22 Performs the host-defined function Alt+F2

FCCClear Deletes all text in the FCC field at the cursor location

If there isn’t an FCC at the cursor location, this 
keystroke clears the closest FCC to the left of the 
cursor.

Alt+k
Ctrl+c

FCCDialogBox Displays the Generate FCC dialog box used to create 
FCCs

Alt+Shift+g

FCCEnable Re-enables FCCs so that you can enter data in them Alt+b
Ctrl+f

FCCGenerate Initiates the FCC definition process using the 
keyboard instead of the Generate FCC dialog box

Alt+q
Ctrl+g

FCCLocate Moves the cursor to the first character of the next FCC, 
whether it is protected or not

If this character is protected, protection is cleared.

Ctrl+o

FileToPage Displays the File To Page dialog box Alt+Shift+f

FormFeed Inserts a form feed character at the cursor location

The cursor moves to the next unprotected position.

Alt+7
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Home Moves the cursor home

If the home position is protected, this keystroke moves 
the cursor to the first unprotected field on the page.

Home

Ins Toggles insert mode on and off Ctrl+Insert

InsertInLine Inserts a space at the cursor location, moving 
subsequent characters in the row one column to the 

Insert

Keystroke Name Description
STEPDOS.EKM 
Keystroke
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right

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the row aren’t shifted. 

If there is a character in the last column of the row or 
FCC field, it is lost.

InsertInPage Inserts a space at the cursor location, moving 
subsequent characters on the page one column to the 
right

Any character in the rightmost column moves to the 
first position on the next row. 

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the page aren’t shifted. 

If there is a character in the last column in the page or 
field, it is lost.

Shift+Insert

InsertLine Inserts a row at the cursor location and shifts 
subsequent rows down one

The last row on the page is lost.

Page Down
Ctrl+Shift+Insert on the 
numeric keypad

Left Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If it is in the first 
column of the first row of the page, it moves to the last 
column of the last row of the page. 

If there is a protected character to the left, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Left Arrow

LineFeed Inserts a line feed character at the cursor position

The cursor moves to the next unprotected position.

Alt+6

MessageWait Displays the waiting host message Alt+1
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PageDown Displays the next page

If the last page is already displayed, this keystroke 
displays the first page.

Page Down on the 
numeric keypad

PageToFile Displays the Page To File dialog box Alt+Shift+p

PageUp Displays the previous page Shift+Page Up
Page Up on the numeric 

Keystroke Name Description
STEPDOS.EKM 
Keystroke
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If the first page already is displayed, this keystroke 
displays the last page.

keypad

Paste Pastes the cut or copied text at the cursor location Ctrl+Shift+Home

PrintRange Performs the equivalent of a host print command Alt+r
* on the numeric keypad

Right Moves the cursor one column to the right

If the cursor is in the last column of a row, it moves to 
the first column of the next row. If it is in the last column 
of the last row of the page, it moves to the first column 
of the first row of the page.

If there is a protected character to the right, the cursor 
moves to the next unprotected character to the left of 
the protected character.

Right Arrow

SelectDown Selects the character where the cursor is currently 
located and the character beneath it

Shift+Down Arrow

SelectHostApplication Displays the Open Application dialog box, which lists 
available host applications

This list of applications is specified in the UTS Host 
Applications key in the Windows registry.

Alt+Shift+a

SelectLeft Selects the character where the cursor is currently 
located and the character to the left of it

Shift+Left Arrow

SelectRight Selects the character where the cursor is currently 
located and the character to the right of it

Shift+Right Arrow

SelectUp Selects the character where the cursor is currently 
located and the character above it

Shift+Up Arrow

SetStartOfEntry Inserts a start-of-entry (SOE) character at the cursor 
position

In insert mode, characters after the SOE character 
shift to the right. In overwrite mode, the SOE character 
replaces any character at the cursor position.

Alt+2 
Alt+Shift+o
5 on the numeric keypad
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Start/Stop Blind Key 
Programming

Starts or stops blind key programming

If blind key programming is not in progress, this 
keystroke initiates it. If blind key programming is in 
progress, this keystroke ends it.

Ctrl+F12

Strikethrough Places a horizontal line through the middle of the 
character at the cursor position

Ctrl+l

Keystroke Name Description
STEPDOS.EKM 
Keystroke
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Strikethroughs are the full width of the character and 
connect with adjacent strikethroughs (if any) to form a 
continuous line.

SystemMode Puts the session in system mode so that you can send 
and receive certain commands to and from a System 
80 host

Alt+5
Alt+Shift+y

Tab Moves the cursor to the next tab stop (either an FCC 
tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Tab

TabBack Moves the cursor to the previous tab stop (either an 
FCC tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Shift+Tab

TabSet Places a tab on the screen at the cursor location and 
moves the cursor one column to the right

Ctrl+5 on the numeric 
keypad

ToggleMsgWaitBeep Toggles the message wait beep on and off

If the beep is turned off, NoBp appears on the status 
line.

Print Screen

Transmit Sends data to the host

Depending on the session configuration, this 
keystroke sends either all data, only unprotected data, 
or only changed data.

Scroll Lock 
Alt+Shift+t 
+ on the numeric keypad

Underscore Places a horizontal line under the character at the 
cursor position and moves the cursor to the right

Underscores are the full width of the character and 
connect with adjacent underscores (if any) to form a 
continuous line.

Ctrl+k

UnlockKeyboard Restores keyboard functionality when it is locked due 
to a communication error

Esc
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Up Moves the cursor up one row in the same column

If the cursor is in the top row of a page, it moves to the 
bottom row. 

If there is a protected character above, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Up Arrow

Keystroke Name Description
STEPDOS.EKM 
Keystroke
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WorkstationMode Exits system mode and restores the session page Alt+4 
Alt+Shift+w
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LINKUP.EKM Keystrokes

The following table lists the keystrokes that you can use with the 
LinkUp keyboard map (LINKUP.EKM).

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key. For all 
keystrokes that involve the numeric keypad, Num Lock must be 
off.
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Keystroke Name Description LINKUP.EKM Keystroke

BackSpace Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If the cursor is 
home, it moves to the last column of the last row of the 
page.

Backspace 
Alt+Shift+b

CancelTransfer Cancels in-progress Extended Control Page file 
transfers for System 80 hosts

Ctrl+Alt+c

CarriageReturn Moves the cursor to the first column of the next row Enter

ClearChange Resets the changed-field indicator to zero on all FCC 
fields, thereby indicating that all the fields are 
unchanged and should not be transmitted

Ctrl+r
Ctrl+/

ClearPageAndFCCs Deletes all protected and unprotected data and all 
FCCs from the cursor to the end of the page

F7
Alt+e
Alt+ =

ClearPageCursorHome Deletes all text and FCC fields in the current page and 
moves the cursor home

F12
Shift+F7
Alt+h
Ctrl+Home

ClearToEndOfField Deletes all unprotected characters in an FCC field 
from the cursor to the end of the FCC field

F8
Alt+f
Alt+o

ClearToEndOfLine Deletes all text from the cursor to the end of the row 
or the end of an FCC field, whichever comes first

F9
Shift+F12
Alt+9
Ctrl+Shift+End on the 
numeric keypad

ClearToEndOfPage Deletes all text from the cursor to the end of the page 
except protected fields

F11 
Shift+F9
Alt+g
Alt+ -
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ClearUnprotCharacter Deletes the unprotected character at the cursor 
position

If emphasis is protected, the emphasis characteristic 
isn’t removed.

Shift+F10
Shift+Space

CloseHostApplication Closes the host application Alt+Shift+x

ColumnSeparatorLeft Places a vertical bar in the leftmost area of a character 
position

Ctrl+j

Keystroke Name Description LINKUP.EKM Keystroke
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ColumnSeparatorRight Places a vertical bar in the rightmost area of a 
character position

Ctrl+h

ControlPageToggle Displays or hides the Control Page or Extended 
Control Page, depending on how the session is 
configured

Page Up
Alt+3

Copy Copies the selected text and puts it on the PC 
Clipboard

Alt+Insert

CursorToEndOfField Moves the cursor to the end of the FCC field

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte.

If the last position is protected, the cursor moves to 
the next unprotected character.

Shift+End

CursorToEndOfLine Moves the cursor to the last position of the current row

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte.

If the last position is protected, the cursor moves to 
the next unprotected character.

Ctrl+Backspace
End on the numeric 
keypad

CursorToEndOfPage Moves the cursor to the last position on the current 
page

If the last position is the trail byte of a DBCS character, 
the cursor moves to the lead byte.

If the last position is protected, the cursor moves to 
the next unprotected character.

Ctrl+Right Arrow

CursorToEOPAndXmit Moves the cursor to the end of the page and transmits 
the screen

- on the numeric keypad
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CursorToStartOfField Moves the cursor to the first position in the FCC field 
in which the cursor is located

If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte.

If the first position is protected, the cursor moves to 
the next unprotected character.

Shift+Home

CursorToStartOfLine Moves the cursor to the first position on the same row Ctrl+Left Arrow

Keystroke Name Description LINKUP.EKM Keystroke
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If the first position is the trail byte of a DBCS character, 
the cursor moves back to the lead byte. 

If the first position is protected, the cursor moves to 
the next unprotected character.

Cut Removes the selected text and puts it on the 
Clipboard

Ctrl+Shift+Delete

DeleteFromLine Deletes the character that the cursor is on, shifts the 
remaining characters on the row to the left, and 
inserts a space in the last column of the row

In an FCC field, this keystroke deletes the character, 
shifts the remaining characters in that field to the left, 
and inserts a space in the last column of the field. 
Emphasis is unchanged, and the characters in the 
rest of the row aren’t shifted.

Delete

DeleteFromPage Deletes the character that the cursor is on and shifts 
all the remaining characters one position to the left

If the cursor is in an FCC field, the characters in that 
field are shifted to the left, but the characters beyond 
the current field aren’t shifted. A space is inserted in 
the last position of the page or field.

Shift+Delete

DeleteLine Deletes the row containing the cursor

Subsequent rows move up one row. The bottom row 
is filled with spaces.

Ctrl+Delete
Ctrl+Shift+Delete on the 
numeric keypad

Down Moves the cursor down one row in the same column

If the cursor is in the bottom row of a page, it moves to 
the top row. 

If there is a protected character below, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Down Arrow
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DuplicateLine Copies the row containing the cursor to the row below, 
overwriting whatever was on that row

The cursor moves to the same column on the 
duplicated row.

Ctrl+Down Arrow
Ctrl+ + on the numeric 
keypad

F1 ... F10 Perform host-defined functions Ctrl+F1 ... Ctrl+F10

F11 Performs the host-defined function Ctrl+1

Keystroke Name Description LINKUP.EKM Keystroke
120 LINKUP.EKM Keystrokes

F12 Performs the host-defined function Ctrl+2

F13 Performs the host-defined function Ctrl+3

F14 Performs the host-defined function Ctrl+4

F15 Performs the host-defined function Ctrl+5

F16 Performs the host-defined function Ctrl+6

F17 Performs the host-defined function Ctrl+7

F18 Performs the host-defined function Ctrl+8

F19 Performs the host-defined function Ctrl+9

F20 Performs the host-defined function Ctrl+0

F21 Performs the host-defined function Ctrl+ -
Alt+F1

F22 Performs the host-defined function Ctrl+ =
Alt+F2

FCCClear Deletes all text in the FCC field at the cursor location

If there isn’t an FCC at the cursor location, this 
keystroke clears the closest FCC to the left of the 
cursor.

Ctrl+ c
Ctrl+ '

FCCEnable Re-enables FCCs so that you can enter data in them Alt+b
Ctrl+ `

FCCGenerate Initiates the FCC definition process using the 
keyboard instead of the Generate FCC dialog box

Ctrl+g 
Alt+q
Alt+Shift+g

FCCLocate Moves the cursor to the first character of the next 
FCC, whether it is protected or not

If this character is protected, protection is cleared.

Ctrl+o
Ctrl+ ;

FileToPage Displays the File To Page dialog box Alt+Shift+p
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FormFeed Inserts a form feed character at the cursor location

The cursor moves to the next unprotected position.

Alt+7
Ctrl+e
Ctrl+f

Home Moves the cursor home

If the home position is protected, this keystroke moves 
the cursor to the first unprotected field on the page.

Home

Ins Toggles insert mode on and off Ctrl+i

Keystroke Name Description LINKUP.EKM Keystroke
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Ctrl+Insert

InsertInLine Inserts a space at the cursor location, moving 
subsequent characters in the row one column to the 
right

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the row aren’t shifted. 

If there is a character in the last column of the row or 
FCC field, it is lost.

Insert

InsertInPage Inserts a space at the cursor location, moving 
subsequent characters on the page one column to the 
right

Any character in the rightmost column moves to the 
first position on the next row. 

If the cursor is in an FCC field, the subsequent 
characters in that field are shifted to the right, but the 
characters in the rest of the page aren’t shifted. 

If there is a character in the last column in the page or 
field, it is lost.

Shift+Insert

InsertLine Inserts a row at the cursor location and shifts 
subsequent rows down one

The last row on the page is lost.

Ctrl+Shift+Insert on the 
numeric keypad

Left Moves the cursor one column to the left

If the cursor is in the first column of a row, it moves to 
the last column of the preceding row. If it is in the first 
column of the first row of the page, it moves to the last 
column of the last row of the page. 

If there is a protected character to the left, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Left Arrow
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LineFeed Inserts a line feed character at the cursor position

The cursor moves to the next unprotected position.

Ctrl+a
Ctrl+1
Alt+6

MessageWait Displays the waiting host message Alt+1
Shift+ - on the numeric 
keypad

PageDown Displays the next page Shift+F2

Keystroke Name Description LINKUP.EKM Keystroke
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If the last page already is displayed, this keystroke 
displays the first page.

Page Down on the 
numeric keypad

PageToFile Displays the Page To File dialog box Alt+Shift+f

PageUp Displays the previous page

If the first page already is displayed, this keystroke 
displays the last page.

Shift+Page Up
Page Up on the numeric 
keypad

Paste Pastes the cut or copied text at the cursor location Ctrl+Shift+Insert

PrintRange Performs the equivalent of a host print command Alt+r
* on the numeric keypad

Right Moves the cursor one column to the right

If the cursor is in the last column of a row, it moves to 
the first column of the next row. If it is in the last 
column of the last row of the page, it moves to the first 
column of the first row of the page. 

If there is a protected character to the right, the cursor 
moves to the next unprotected character to the left of 
the protected character.

Right Arrow

SelectDown Selects the character where the cursor is currently 
located and the character beneath it

Shift+Down Arrow

SelectHostApplication Displays the Open Application dialog box, which lists 
available host applications

This list of applications is specified in the UTS Host 
Applications key in the Windows registry.

Alt+Shift+a

SelectLeft Selects the character where the cursor is currently 
located and the character to the left of it

Shift+Left Arrow

SelectRight Selects the character where the cursor is currently 
located and the character to the right of it

Shift+Right Arrow

SelectUp Selects the character where the cursor is currently 
located and the character above it

Shift+Up Arrow
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SetStartOfEntry Inserts a start-of-entry (SOE) character at the cursor 
position

In insert mode, characters after the SOE character 
shift to the right. In overwrite mode, the SOE 
character replaces any character at the cursor 
position.

Alt+2
Alt+Shift+o
5 on the numeric keypad

Start/Stop Blind Key Starts or stops blind key programming Ctrl+F12

Keystroke Name Description LINKUP.EKM Keystroke
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Programming
If blind key programming is not in progress, this 
keystroke initiates it. If blind key programming is in 
progress, this keystroke ends it.

Strikethrough Places a horizontal line through the middle of the 
character at the cursor position

Strikethroughs are the full width of the character and 
connect with adjacent strikethroughs (if any) to form a 
continuous line.

Ctrl+Shift+l

SystemMode Puts the session in system mode so that you can send 
and receive certain commands to and from a System 
80 host

Alt+5
Ctrl+[

Tab Moves the cursor to the next tab stop (either an FCC 
tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Tab

TabBack Moves the cursor to the previous tab stop (either an 
FCC tab or a tab on the screen)

If tabs were not set, this keystroke moves the cursor 
home.

Shift+Tab

TabSet Places a tab on the screen at the cursor location and 
moves the cursor one column to the right

Ctrl+Tab
Ctrl+5 on the numeric 
keypad

ToggleMsgWaitBeep Toggles the message wait beep on and off

If the beep is turned off, NoBp appears on the status 
line.

Print Screen

Transmit Sends data to the host

Depending on the session configuration, this 
keystroke sends either all data, only unprotected data, 
or only changed data.

Scroll Lock 
Alt+Shift+t 
+ on the numeric keypad
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Underscore Places a horizontal line under the character at the 
cursor position and moves the cursor to the right

Underscores are the full width of the character and 
connect with adjacent underscores (if any) to form a 
continuous line.

Ctrl+k

UnlockKeyboard Restores keyboard functionality when it is locked due 
to a communication error

Esc

Keystroke Name Description LINKUP.EKM Keystroke
124 LINKUP.EKM Keystrokes

Up Moves the cursor up one row in the same column

If the cursor is in the top row of a page, it moves to the 
bottom row. 

If there is a protected character above, the cursor 
moves to the next unprotected character to the right of 
the protected character.

Up Arrow

WorkstationMode Exits system mode and restores the session page Ctrl+] 
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PEP QuickPads

The following table describes the predefined QuickPads that come 
with PEP.

You can load these QuickPads whenever a PEP session is open, 
and perform various terminal emulation tasks simply by clicking 
the buttons on the QuickPad.
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File Name Function

UTSEDIT.EQP Provides buttons that perform editing functions, such as 
clearing the page and moving the cursor home 

UTSKEYBD.EQP Provides buttons that perform keyboard functions, such 
as setting the start-of-entry character or accessing the 
Control Page

UTSFCC.EQP Provides buttons that perform several FCC functions, 
such as locating and clearing FCCs

UTSFUNC.EQP Provides buttons representing the UTS 20/40/60 function 
keys F1 through F22

UTS60FK.EQP Provides buttons representing the UTS 20/40/60 function 
keys F1 through F22, as well as other functions, such as 
putting the session in system mode

UTSTB_H.EQP Provides the toolbar buttons that were originally included 
with UniStation (Windows).  This QuickPad displays the 
buttons horizontally on your screen.

UTSTB_V.EQP Provides the toolbar buttons that were originally included 
with UniStation (Windows).  This QuickPad displays the 
buttons vertically on your screen.
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PEP File Transfer Protocols

PEP comes with two file transfer protocols that you can use to 
send and receive files to and from the host:

■ OS2200—lets you transfer files between your PC and an 
OS 2200 Editor

For example, you can create a text file using a word processor 
on your PC and upload the file to the OS 2200 Editor.  The 
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resulting file appears just as it would if you had entered the 
text directly into the OS 2200 Editor. Conversely, you can 
download OS 2200 files from the host to be used on your PC.

■ MAPPER—lets you upload PC files to the host as MAPPER® 
reports or download MAPPER reports to your PC

You should be able to transfer files using these tools without 
making any modifications to their configurations.  However, you 
can customize the configurations to optimize the performance of 
these protocols at your site.

Configuring PEP’s 
File Transfer 
Protocols

To configure the PEP file transfer protocols, follow these steps:

1 With a PEP session open, click Session Type from the Options 
menu.

2 From the File transfer protocol list box, click the file transfer 
protocol that you want to configure and use.

3 When the focus is on the File transfer protocol list box, click 
Settings.

The file transfer section of the Settings dialog box appears.

4 Click the desired tabs and complete each one.

For information about any item on this dialog box, click  in the 
upper right corner of the dialog box and then click the desired 
item.
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Sending a File 
Using the OS2200 
File Transfer 
Protocol

To send a file using the OS 2200 file transfer protocol, follow these 
steps:

1 Open a PEP session open and connect to the host.  (You do not 
have to run the OS 2200 Editor.)

Note:  If the session is not already configured to use the 
OS 2200 file transfer protocol, click Session Type from the 
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2 From the Tools menu, click Send File.

3 Complete the OS2200 Send File dialog box.

For information about any item on this dialog box, click  in the 
upper right corner of the dialog box and then click the desired 
item.

4 Click Transfer.

If you configured the OS 2200 file transfer protocol to display the 
contents of the file, that information appears on the screen during 
the transfer.

Receiving a File 
Using the OS2200 
File Transfer 
Protocol

To receive a file using the OS 2200 file transfer protocol, follow 
these steps:

1 Open a PEP session open and connect to the host.  (You do not 
have to run the OS 2200 Editor.)

2 From the Tools menu, click Receive File.

3 Complete the OS2200 Receive File dialog box.

Options menu and click OS2200 Editor from the File Transfer 
Protocol list box.

Note:  If the session is not already configured to use the 
OS 2200 file transfer protocol, click Session Type from the 
Options menu and click OS2200 Editor from the File Transfer 
Protocol list box.
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For information about any item on this dialog box, click  in the 
upper right corner of the dialog box and then click the desired 
item.

4 Click Transfer.

If you configured the OS 2200 file transfer protocol to display the 
contents of the file, that information appears on the screen during 
the transfer.
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Sending a File 
Using the 
MAPPER File 
Transfer Protocol

To send a file using the MAPPER file transfer protocol, follow 
these steps:

1 Open a PEP session open, connect to the host, and log on to 
MAPPER.

2 From the Tools menu, click Send File.

3 Complete the MAPPER Send File dialog box.

For information about any item on this dialog box, click  in the 
upper right corner of the dialog box and then click the desired 
item.

Likewise, you cannot upload a file that was downloaded from one 
drawer into another drawer.  For example, you cannot download a 
file from drawer A and upload it into drawer B.

4 Click Transfer.

Note:  If the session is not already configured to use the 
MAPPER file transfer protocol, click Session Type from the 
Options menu and click MAPPER from the File Transfer 
Protocol list box.

Note:  The format of the PC file must match the format of the 
MAPPER report.  For example, you cannot upload a 256-column 
PC file into a MAPPER report that supports only 132 columns.
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Receiving a File 
Using the 
MAPPER File 
Transfer Protocol

To receive a file using the MAPPER file transfer protocol, follow 
these steps:

1 Open a PEP session, connect to the host, and log on to MAPPER.

Note:  If the session is not already configured to use the 
MAPPER file transfer protocol, click Session Type from the 
Options menu and click MAPPER from the File Transfer 
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2 From the Tools menu, click Receive File.

3 Complete the MAPPER Receive File dialog box.

For information about any item on this dialog box, click in the 
upper right corner of the dialog box and then click the desired 
item.

4 Click Transfer.

Protocol list box.
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PEP HotSpots

PEP comes with two predefined HotSpot schemes:

■ MAP80.EHS

■ MAP132.EHS

These schemes consist of ten region HotSpots that correspond to 
the functions listed at the bottom of a MAPPER screen.  
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MAP80.EHS is for use with an 80-column screen; MAP132.EHS is 
for use with a 132-column screen.

When you load and enable these HotSpot schemes, you can 
perform the functions listed at the bottom of the MAPPER screen 
simply by double-clicking the desired function.  For example, to 
exit MAPPER, you can double-click the word Exit rather than 
pressing F10.
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About EXTRA! Office for Accessory Manager

EXTRA!® Office for Accessory Manager is a suite of terminal 
emulators (3270, 5250, and VT) and non-INFOConnect connection 
tools that let your PC communicate with IBM, UNIX®, or DEC 
hosts.

Unlike InterCom, PEP, and ALC, EXTRA! Office for Accessory 
Manager is a standalone product that exists in a separate 
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directory. You can run this product by itself, or you can create and 
open EXTRA! Office for Accessory Manager sessions within 
Accessory Manager. To ensure the integration of the two 
applications, the EXTRA! Office for Accessory Manager (E!OAM) 
Merge Utility runs automatically when you install EXTRA! Office 
for Accessory Manager. You can also run this utility manually at 
any time.

To use EXTRA! Office for Accessory Manager with Accessory 
Manager, you must keep both applications installed. When you 
open an EXTRA! Office for Accessory Manager session within 
Accessory Manager, the session still requires files from the 
EXTRA! Office for Accessory Manager folder in order to run. If you 
install both products, run the E!OAM Merge Utility, and then 
deinstall EXTRA! Office for Accessory Manager, you will not be 
able to open those sessions using Accessory Manager.

Once you have merged EXTRA! Office for Accessory Manager and 
Accessory Manager, the relationship between the two is similar to 
the relationship between a document and a word processor. When 
you run a word processor, you have a single application window, 
and no matter which document you open, there are functions that 
are common to all the documents. Likewise, when you run 
Accessory Manager, you have a single application window, and no 
matter which terminal emulation session you open, there are 
functions that are common to all the emulators.

Just as a word processor can open multiple documents at once, 
Accessory Manager can open multiple terminal emulation sessions 
at once. For example, using Accessory Manager, you can open one 
session using EXTRA! Office for Accessory Manager to connect to 
an IBM host, then open a second session using PEP to connect to a 
Unisys 1100/2200 Series host. Or you can open multiple sessions 
using one emulator, such as four sessions to an IBM host.
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E!OAM Merge Utility

When you run the E!OAM Merge Utility, the following things 
happen:

■ All the keyboard maps, QuickPads, toolbars, and schemes 
currently in the EXTRA! Office for Accessory Manager 
SCHEMES subfolder are copied to the ACCMGR32 folder (or 
whatever folder is specified as the folder for local schemes on 
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the Global Preferences dialog box). This ensures that when you 
open an EXTRA! Office for Accessory Manager session from the 
Accessory Manager application window, you can use all the 
default files and any files you created.

■ All the default session profiles for EXTRA! Office for Accessory 
Manager sessions are copied from the EXTRA! Office for 
Accessory Manager TEMPLATE folder to the 
ACCMGR32\TEMPLATE folder. This ensures that you can run 
the New Session Wizard from the Accessory Manager 
application window to create new 3270, 5250, or VT sessions.

■ The data about the terminal emulation sessions contained in 
the TOOLCOMP.INI and GI32.INI files in the EXTRA! Office 
for Accessory Manager folder is merged into those files in the 
ACCMGR32 folder. This ensures that Accessory Manager 
recognizes that 3270, 5250, and VT sessions are valid sessions. 
When you open one of these sessions, the Accessory Manager 
menu changes to include commands that are specific to those 
emulators, such as Finish Printing and Transfer Multiple Files.
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Running the 
E!OAM Merge 
Utility

To run the E!OAM Merge Utility manually, follow these steps:

1 If Accessory Manager or EXTRA! Office for Accessory Manager is 
running, exit the application.

2 Using My Computer or File Manager, go to the ACCMGR32 folder 
in the INFOConnect folder.
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3 Double-click EPCMERGE.EXE.

4 At the message box, click Continue.

Additional message boxes indicate which files are being copied.

5 When all the files have been copied, click OK.
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EXTRA! Office for Accessory Manager Limitations

Although you can create and open EXTRA! Office for Accessory 
Manager sessions within Accessory Manager and perform most of 
the functions that you can with any other emulator, there are 
some limitations:

■ The copying of files occurs only when you run E!OAM Merge. If 
you subsequently create additional keyboard maps, QuickPads, 
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toolbars, or schemes in the EXTRA! Office for Accessory 
Manager SCHEMES subfolder, they will not be copied to the 
ACCMGR32 folder until you run E!OAM Merge again.

■ Any keyboard maps, QuickPads, toolbars, or schemes located in 
the remote folder (as specified on the Global Preferences dialog 
box) are not copied. To use any of these files, you must copy 
them manually to the ACCMGR32 folder or whatever folder is 
specified as the local or remote folder on the Global Preferences 
dialog box.

■ You can create and open only terminal emulation (.EDP) 
sessions. You cannot create or open printer (.EPP) sessions.

■ When you display the Open Session dialog box using Accessory 
Manager, only .ADP files are displayed by default. To view a 
list of .EDP files in the EXTRA! Office for Accessory Manager 
SESSIONS folder, type *.EDP in the File Name text box and 
click Open. (Any 3270, 5250, or VT sessions that you create 
using Accessory Manager automatically use the .ADP file 
extension and will be immediately visible in the Open Session 
dialog box.)

■ Edit Settings and File Transfer Settings do not appear in the 
Apply Settings category on the Action dialog box, so you cannot 
apply edit schemes or file transfer schemes using keyboard 
maps, QuickPads, toolbars, or HotSpots. However, you can 
create these schemes and use them in your session using the 
Settings dialog box.

■ You cannot associate file transfer schemes with recorded host 
screens. File Transfer Schemes does not appear in the Available 
Settings list box on the Settings tab on the Page Settings dialog 
box.
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■ Any data about the session that was typed on the Properties 
dialog box using EXTRA! Office for Accessory Manager is not 
available from the Accessory Manager application window.

■ Accessory Manager does not support EXTRA! Office for 
Accessory Manager layout files (.EWL).

■ Accessory Manager does not support EXTRA! Basic macros. If 
you open an EXTRA! Office for Accessory Manager session that 
is configured to run an EXTRA! Basic macro at session start-up, 
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the macro will fail to run.

■ If you remove EXTRA! Office for Accessory Manager, the files 
that were copied and data that was merged as a result of 
running E!OAM Merge will not be deleted. You must delete 
these files and edit the TOOLCOMP.INI and GI32.INI file to 
remove references to the EXTRA! Office for Accessory Manager 
products.

■ Although context-sensitive Help is available for all dialog 
boxes, no other online Help for EXTRA! Office for Accessory 
Manager is accessible from within Accessory Manager. To 
access additional online Help for this product, you must run 
EXTRA! Office for Accessory Manager as a standalone product 
and click the desired item from its Help menu.
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About HiBrow

INFOConnect Host Internet Browser (HiBrow) for Windows 95 
and Windows NT is a program that lets you view HTML 
documents, including web pages on the Internet or a corporate 
intranet.

HiBrow runs within Accessory Manager. The relationship 
between the two is similar to the relationship between a document 
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and a word processor. When you run a word processor, you have a 
single application window, and no matter which document you 
open, there are functions that are common to all the documents. 
Likewise, when you run Accessory Manager, you have a single 
application window, and no matter which terminal emulation or 
browser session you open, there are functions that are common to 
all.

Just as a word processor can open multiple documents at once, 
Accessory Manager can open multiple sessions at once. For 
example, using Accessory Manager, you can open one session 
using HiBrow to connect to a corporate intranet, and then open a 
second session using PEP to connect to a Unisys 1100/2200 Series 
host. Or you can open multiple sessions of the same type, such as 
four sessions using HiBrow.

In addition to providing standard browsing capabilities, HiBrow 
also lets you integrate Internet sites or other HTML pages with 
host applications accessed using other Accessory Manager 
emulators. For example, you can link a recorded host screen in an 
Intercom session to a URL so that, when you display that host 
screen, a HiBrow session opens and displays that URL. With this 
technique, you can display context-sensitive online Help for 
specific host screens, graphics that host applications don't 
support, or other information that would otherwise not be 
accessible.
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HiBrow also provides the following features:

■ Default keystrokes that perform common browsing activities, 
such as moving forward or backward between URLs

■ A navigation bar that remains available for all sessions

■ A customizable home page and search page

■ A mechanism for directly accessing URLs
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■ The ability to limit Internet access to specific URLs
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About the HiBrow Toolbars 

HiBrow comes with two toolbars:

■ HiBrow toolbar
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■ Navigation bar

The HiBrow toolbar provides access to standard functions such as 
New Session, Open Session, and Save Session, as well as special 
HiBrow functions, such as moving forward and backward between 
URLs or displaying the home page. You can customize this toolbar 
in a number of ways:

■ Display color or monochrome buttons

■ Display large or small buttons

■ Show or suppress ToolTips

The navigation bar provides access to essentials (URLs that you 
want to access directly) and the address bar (a text box where you 
can type the name of the URL that you want to display).

The navigation bar is not an .ETB file and cannot be modified 
using the Toolbar Editor or the Settings dialog box. However, you 
can specify whether to display the navigation bar and which items 
to include on it by clicking Navigation Bar from the View menu 
and completing the Navigation Bar dialog box.

The navigation bar is not session-specific. It is available for all 
sessions, including InterCom, PEP, and other terminal emulation 
sessions.

You can move both HiBrow toolbars to any desired location on the 
screen.
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Displaying URLs

HiBrow provides many mechanisms for displaying URLs:

■ In the address bar on the navigation bar, type the Universal 
Resource Locator (URL) that you want to access and press 
Enter.

■ On the navigation bar, click Essentials, point to the desired 
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category (a collection of URLs), and then click the desired URL 
from the submenu.

When you do either of these, one of the following occurs:

■ To display a previous URL, click on the toolbar or press 
Alt+Left Arrow when a HiBrow session is open.

You can do this only if you have navigated to another URL (and 
therefore have one to go back to).

■ To display the next URL, click on the toolbar or press 
Alt+Right Arrow when a HiBrow session is open.

You can do this only if you have displayed a previous URL (and 
therefore have one to go forward to).

■ To display the home page, click on the toolbar or press 
Home when a HiBrow session is open.

■ To display the search page, click on the navigation bar, or 
press Ctrl+f when a HiBrow session is open.

In this case This happens

No HiBrow sessions 
are open

A HiBrow session is dynamically created, and the 
URL appears in that session window

If Auto-Save Session Settings is selected on the 
Global Preferences dialog box, this dynamically 
created session is saved automatically.

One HiBrow session 
is open

The URL appears in the open HiBrow session

More than one HiBrow 
session is open

The URL appears in the HiBrow session that has 
focus

If focus is on a non-HiBrow session (such as an 
InterCom or PEP session), the URL appears in the 
first HiBrow session that was opened.
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About Essentials 

You can specify that certain URLs should be essentials. An 
essential is simply a URL that you want to access by clicking 
Essentials in the navigation bar.

Essentials are organized into categories. When you click 
Essentials, the list displays all the categories. When you point to a 
category, the list of URLs in that category appears.
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HiBrow comes with three sample categories:

You can limit users’ access to specific URLs by making those 
URLs essentials and then enabling security for the address bar 
and Add/Organize Essentials. In this way, users can access only 
those URLs that appear in the Essentials list. For information 
about security, click Administrative Help from Accessory 
Manager’s Help menu. (This item appears in the Help menu only 
in standalone installations or for the administrator of a shared 
installation or multi-user installation.)

Category URLs

INDUSTRY Microsoft (http://www.microsoft.com/)

Attachmate (http://www.attachmate.com/)

Unisys (http://www.unisys.com/)

IBM (http://www.ibm.com/)

NEWS NBC (http://www.nbc.com/)

ABC (http://www.abc.com/)

CNN (http://cnn.com/)

CBS (http://w3.cbsnew.com/)

ATM Attachmate Products
(http://www.attachmate.com/Products/default.asp)

Attachmate Unisys Home Page
(http://www.attachmate.com/Unisys/)

Attachmate: Desktop connectivity (http://www.attachmate.com/)

Attachmate SupportWeb! (http://supportweb.attachmate.com/)

Attachmate International
(http://www.attachmate.com/International/)
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Adding a URL to 
the List of 
Essentials

To add a URL to the list of favorites, follow these steps:

1 If a session is not already open, open one.

2 On the navigation bar, click Essentials, and then click Add/
Organize Essentials.

3 Do one of the following:
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4 Do one of the following:

5 Click Close.

The next time you click Essentials on the navigation bar, the new 
URL appears in the specified category.

For more information about essentials, refer to the online Help.

In this case Do this

The Categories list box is empty, it 
contains only two items labeled 
Local Categories and Remote 
Categories, or it contains categories 
but you want to put the URL in a 
different category

Create a category.

To do this, click New, type a name for 
the category, and click OK on the New 
Category dialog box.

If the Categories list box contains 
folders called Local Categories and 
Remote Categories, click Local 
Categories to create the category in 
your local folder or click Remote 
Categories to create the category in 
your remote folder. Then click New, type 
a name for the category, and click OK 
on the New Category dialog box.

The Categories list box contains a 
category that you want to use

Click the category where you want to 
add the URL

To do this Do this

Add the displayed URL to the 
selected category

Click Add.

Add a different URL to the selected 
category

Type the URL in the URL text box, type 
a descriptive title for the URL in the 
Title text box, and then click Add.
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HiBrow Keystrokes

The following table lists HiBrow’s default keystrokes.

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key.

Keystroke Name Description Default Keystroke

Back Displays the previous URL Alt+Left Arrow
144 HiBrow Keystrokes

Forward Displays the next URL Alt+Right Arrow

Home Displays the URL specified as the 
home page on the Settings dialog 
box

Home

Refresh Refreshes the screen, redrawing 
any graphics or text elements

F5

Search Displays the URL specified as the 
search page on the Settings dialog 
box

Ctrl+f

Stop Stops the current process (such as 
accessing a particular URL, 
displaying graphics, etc.)

Esc
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About ALC

INFOConnect ALC for Windows 95 and Windows NT is a terminal 
emulation program that makes your PC operate like an ALC 
terminal. When you run ALC, your PC can communicate with any 
major Computer Reservation System (CRS).

ALC runs within Accessory Manager.  The relationship between 
the two is similar to the relationship between a document and a 
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word processor.  When you run a word processor, you have a single 
application window, and no matter which document you open, 
there are functions that are common to all the documents.  
Likewise, when you run Accessory Manager, you have a single 
application window, and no matter which terminal emulation 
session you open, there are functions that are common to all the 
emulators.

Just as a word processor can open multiple documents at once, 
Accessory Manager can open multiple terminal emulation sessions 
at once. For example, using Accessory Manager, you can open one 
session using ALC to connect to a Computer Reservation System, 
then open a second session using PEP to connect to a Unisys 
1100/2200 Series host. Or you can open multiple sessions using 
one emulator, such as four sessions using ALC.

ALC also provides the following features:

■ Five different column/row combinations for the display

■ Default terminal keystrokes that let you perform ALC functions

■ A predefined keyboard map 
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ALC Keyboard Map

With ALC, you can use the default keystrokes to perform various 
terminal emulation tasks, or you can load the keyboard map 
(ALC.EKM) that is also provided. The default keystrokes and the 
keystrokes in ALC.EKM are the same.

When you create an ALC session, the ALC.EKM keyboard map is 
loaded by default.
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ALC Keystrokes

The following table lists ALC’s default keystrokes. The default 
keystrokes are the same as the keystrokes in ALC.EKM.

When you see two keys connected by a plus sign (+), press and 
hold down the first key, then press the second key.

Note:  If you’re using a keyboard map that has defined these 
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keystrokes to perform different functions, the functions 
associated with the keyboard map override the default 
functions described here.

Keystroke Name Function Keystroke

ARNK Creates the itinerary of a PNR when two segments are not 
connected

For example, if the first segment is LHR-JFK, and the third 
segment is DFW-SFO, pressing ARNK between the two indicates 
that the passenger traveled from JFK to DFW independently.

Ctrl+a

Backspace Moves the cursor one column to the left

If the cursor is in the first column, it moves to the last column of 
the previous row. If the cursor is home, it moves to the last column 
of the last row.

Backspace

Clear Clears the entire screen and moves the cursor home Ctrl+Home
Ctrl+m

ClearBroadcast Clears the SITA broadcast message Ctrl+b

Colon Inserts a colon (:) at the cursor position and moves the cursor one 
position to the right

;

CrossOfLorraine Inserts the cross of lorraine character at the cursor position and 
moves the cursor one position to the right

Ctrl+l

Delete Deletes the character at the cursor and shifts the subsequent 
characters to the left

Delete

Delline Deletes the row where the cursor is currently positioned

Subsequent rows move up one row, and the last row is filled with 
spaces.

Ctrl+Delete

Display Inserts the display character (*) at the cursor position and moves 
the cursor one position to the right

=

Dollar Inserts the U.S. dollar sign character ($) at the cursor position and 
moves the cursor one position to the right

]
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Down Moves the cursor to the row below in the same column Down Arrow

EEOL Erases all data and from the cursor position to the end of the line Ctrl+End

End Moves the cursor to the end of the line End

EndItem Inserts the end item character (#) at the cursor position and 
moves the cursor one position to the right

, (comma)

EndTransaction Closes the PNR Ctrl+t

Keystroke Name Function Keystroke
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Type this keystroke when the booking is complete. The host 
returns the record locator. If any fields have been missed, the 
host responds with an error.

GBPound Inserts a British pound mark at the cursor position and moves the 
cursor one position to the right

Alt+p

Home Moves the cursor to the top left corner of the screen Home

Ignore Cancels any changes made to the current PNR Ctrl+i

Insert Inserts a single character at the cursor position, moving 
subsequent characters one column to the right

Insert

InsertLine Inserts a row at the cursor position and shifts subsequent rows 
down one

The last row on the page is lost.

Ctrl+Insert

Left Moves the cursor one column to the left Left Arrow

Newline Inserts the new line character at the cursor position and moves 
the cursor one position to the right

\

Pillow/Lozenge Inserts a pillow character at the cursor position and moves the 
cursor one position to the right

[

PrintEnter Sends the response to the designated printer instead of the 
screen (Sabre only)

Ctrl+Enter

ProtReset Moves the cursor home and then to the start of the field

Use this keystroke on protected screens.

Ctrl+p

RecallNextIp Recalls the next input or entry

The number of entries you can save depends on the number 
specified for the Saved Inputs option on the Settings - Display 
dialog box.

Ctrl+Up Arrow

RecallPrevIp Recalls the previous input or entry

The number of entries you can save depends on the number 
specified for the Saved Inputs option on the Settings - Display 
dialog box.

Ctrl+Down Arrow
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Reenter Searches back through the screen for the previously sent 
message and resends it to the host

The previous message must still be on the screen.

Alt+z

Repeat Redisplays the result of the last transaction, but does not repeat 
the transaction itself

This is primarily used when a “Press Rpt” error occurs.

Ctrl+r

Keystroke Name Function Keystroke
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Reset Sends a host-specific sequence to the host Escape

Right Moves the cursor one column to the right in the same row Right Arrow

SOM Inserts a start-of-message character at the cursor position and 
moves the cursor one position to the right

' (apostrophe)

Start/Stop Blind 
Key Programming

Start or stop blind key programming

If blind key programming is not in progress, this command 
initiates it. If blind key programming is in progress, this command 
ends it.

Ctrl+F12

Statistics Provides gateway communication statistics F12

Tab Moves the cursor to the beginning of the next unprotected field Tab

TabBack Moves the cursor to the beginning of the previous field Shift+Tab

Transmit Sends the data on the screen to the host Enter

UMSG Issues a Retrieve Unused Message command

If the unsolicited message (UMSG) indicator appears, this 
keystroke displays the waiting message. If UMSG does not 
appear, the response indicates that there are no messages 
waiting.

Ctrl+u

Up Moves the cursor up one row in the same column Up Arrow

XITN Cancels the itinerary from the current PNR Ctrl+x
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About INFOConnect WinFTP

INFOConnect WinFTP for Windows 95 and Windows NT is an 
application that you can use to transfer files between your PC and 
any host (such as a PC running Windows NT, a Unisys 1100/2200 
Series host, or a UNIX host) that is running FTP server software. 
The PC must communicate with the host via a WinSock-
compatible TCP/IP network.
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WinFTP runs within Accessory Manager. The relationship 
between the two is similar to the relationship between a document 
and a word processor. When you run a word processor, you have a 
single application window, and no matter which document you 
open, there are functions that are common to all the documents. 
Likewise, when you run Accessory Manager, you have a single 
application window, and no matter which file transfer or terminal 
emulation session you open, there are functions that are common 
to all the sessions.

Just as a word processor can open multiple documents at once, 
Accessory Manager can run multiple sessions at once. For 
example, using Accessory Manager, you can open one session 
using WinFTP to perform file transfers with a Unisys 1100/2200 
Series host, and open a second session using PEP to perform 
terminal emulation. Or you can open multiple sessions at once, 
such as four WinFTP sessions.
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The following figure shows the WinFTP session window:
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For information about the items on this session window, refer to 
the online Help.
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Using WinFTP

Opening a 
WinFTP Session

To open a WinFTP session, click Open Session from the File menu. 
Then double-click the session that you want to open.

Depending on which connection type you're using, a subsequent 
dialog box might appear when the session opens. Complete any 
subsequent dialog box. For information about any item on any 
dialog box, click in the upper right corner of the dialog box and 
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then click the desired item.

When you have successfully logged on to a host, the status bar on 
the session window changes from red to green, indicating that a 
successful connection has been made.

Sending a File To send a file, follow these steps:

1 If a WinFTP session is not already open, open one.

2 Select the PC file to send.

3 Click Send.

Depending on which connection type you’re using, a subsequent 
dialog box might appear. Complete any subsequent dialog box. For 
information about any item on this dialog box, click in the 
upper right corner of the dialog box and then click the desired 
item.

Receiving a File To receive a file, follow these steps:

1 If a WinFTP session is not already open, open one.

2 Select the host file that you want to transfer to the PC.

3 Click Receive.

Depending on which connection type you’re using, a subsequent 
dialog box might appear. Complete any subsequent dialog box. For 
information about any item on this dialog box, click  in the 
upper right corner of the dialog box and then click the desired 
item.
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About INFOConnect Connectivity Services

INFOConnect Connectivity Services is a package developed by the 
Unisys Corporation that includes a number of components:

■ INFOConnect Manager—this application ties all 
INFOConnect products together.

You can use this application to modify your INFOConnect 
database, which is the file that includes information about 
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where your INFOConnect products are installed and 
configuration options that control communication between your 
PC and the host.

■ Communication software—INFOConnect Connectivity 
Services comes with the following communication software 
(also called libraries):

For more information about these libraries, refer to the online 
Help for each library.

■ Applications—INFOConnect Connectivity Services comes 
with the following applications (also called accessories):

❏ INFOConnect Quick Configuration

❏ INFOConnect Installation Manager

❏ INFOConnect Installation Shell

For more information about these accessories, refer to the 
online Help for each accessory.

Note:  It is recommended that you use the INFOConnect 
Database Editor rather than the INFOConnect Manager to 
configure your communication options. The Database Editor 
is described in more detail in Chapter 2, “INFOConnect 
Accessory Manager.”

❏ AAPI32 ❏ NetBIOS ❏ Trace
❏ Diagnostic ❏ SOSWITCH ❏ TRACELOG
❏ IPC32 ❏ STACK ❏ WinSock
❏ ITC32 ❏ StackIc16
❏ Local ❏ TELNET
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INFOConnect Database

The INFOConnect database is a file (IC32.CFG) usually located in 
the Windows directory that contains information about all the 
INFOConnect packages that have been installed, as well as all the 
path templates, library channels, and paths that have been 
created.

If you installed PEP or InterCom, you create paths using either 
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INFOConnect Accessory Manager, the Database Editor, or the 
Add Path Wizard. You can also use the Database Editor to modify 
existing paths and path-related data and to delete paths. 
Accessory Manager and the Database Editor can read both the 16-
bit and 32-bit databases simultaneously.

You can also use the INFOConnect Manager to modify the 
INFOConnect database. However, the Manager can read only one 
database at a time. To modify data for 16-bit products, you have to 
run the 16-bit Manager; to modify data for 32-bit products, you 
have to run the 32-bit Manager.
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INFOConnect Manager

The INFOConnect Manager is part of the INFOConnect 
Connectivity Services package developed by Unisys Corporation. 
This applications runs in the background each time you run an 
INFOConnect product and controls interaction between 
accessories  and transports.
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Running the 
Manager

The Manager automatically runs in the background each time you 
run any INFOConnect application. You can also run the Manager 
at any time using the following procedures:

■ If you’re running Windows 95 or Windows NT 4.0, click the 
Start button, point to Programs, point to INFOConnect, and 
click Manager32.

■ If you’re running Windows NT 3.51, double-click Manager32 in 
the INFOConnect program group.

Using the Manager You can use the Manager to modify your INFOConnect database, 
which is the file that includes information about where your 
INFOConnect products are installed and all the configuration 
information about your INFOConnect paths.

The procedures you use to configure paths must be performed in a 
specific order. For example, you cannot create a path until you 
create a path template. You cannot create a path template until 
you add the library to the INFOConnect database. The following 
list indicates the order to follow.

1 Add the library to the INFOConnect database.

2 Create a library channel (if one is required by the library).

3 Create a path template.

4 Create a path.

Normally, steps 1 through 3 are completed automatically when 
you install a transport. If you installed one of Attachmate’s 
emulators (such as InterCom or PEP), you can create paths using 
either Accessory Manager, the Database Editor, or the Add Path 
Wizard. However, you might need to customize your configuration 
in ways that you can only do using the Manager.
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For example, you should use the Manager for the following tasks:

■ Specifying the location of a library (for example, if you move it 
to a directory other than the one where it was installed)

■ Creating customized path templates (for example, ones that 
include the Trace service library or other specialized service 
libraries)

■ Specifying the location of an accessory (for example, if you move 
it to a directory other than the one where it was installed)
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For information about these tasks, use My Computer or File 
Manager to open the INFOConnect folder and double-click the 
AMXPORTS.HLP file.
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Libraries

An INFOConnect library is a piece of communications software 
that can be used singly or in combination with other libraries to 
enable communication between a PC and a host, and between 
applications on the PC. Libraries are the building blocks of 
INFOConnect paths.

There are four types of libraries:
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■ External interface library (EIL)—this provides the link 
between the INFOConnect Manager and an external transport 
service. For example, the TCP external interface library 
provides the link with the Winsock TCP/IP network stack.

■ Service library (SL)—this provides additional 
communications processing. For example, the TCP-A service 
library provides additional processing so that a PC can 
communicate with a Unisys A Series host.

■ Application interface library (AIL)—this provides special 
interaction with applications. AILs are not included in path 
templates and are not used to create paths. For example, the 
ADMIN32 library sets aside space in the 32-bit INFOConnect 
database for the groups and users created by the INFOConnect 
Database Editor.

■ Hook library—this type of library is used by or with a path 
during a session but is not actually inserted into the path. It 
connects (hooks) into the path via special interfaces. For 
example, the TRACELOG library works with existing paths to 
create trace logs.

Each INFOConnect path must include an external interface 
library. The documentation for your transport indicates which 
libraries are included in each package.

When you install a transport, the location of each library is added 
to the INFOConnect database automatically. If you move the 
library to a folder other than the one where it was installed, you 
must use the INFOConnect Manager to modify the INFOConnect 
database accordingly.
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Library Channels

An INFOConnect library channel is a named collection of 
configuration data for a particular library, typically (though not 
exclusively) hardware-related. Only certain libraries—such as 
Uniscope, Poll/Select, INT1, X.25, and HLCNTS—use library 
channels.

For most transports, a library channel is created automatically 
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when you install the transport. However, in some cases, you might 
want to create more than one library channel. For example, each 
Uniscope library channel includes configuration settings for the 
communication adapter. If you have more than one 
communication adapter in your PC, you would have to create a 
library channel for each one.

Each INFOConnect path or path template can specify which 
library channel to use. If you specify the library channel in the 
path template, all paths that use that path template will use that 
library channel.



Appendix A  INFOConnect Connectivity Services

Path Templates

An INFOConnect path template is a named combination of one or 
more libraries. For example, the TCP-A path template contains 
both the TCP-A service library and the TCP/IP external interface 
library.

If a library in the path template can have library channels, the 
path template can also indicate which library channel to use.
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For Attachmate's transports, at least one path template is created 
automatically when you install the transport. (The documentation 
for each transport includes information about what path 
templates are created and what they contain.)

In some cases, you might want to create additional path 
templates. For example, to use a service library developed by a 
company other than Attachmate, you would have to create a 
customized path template that includes this library. You must use 
the INFOConnect Manager to create path templates.

Each path template must include one external interface library, 
and this library must be the last library on the list of included 
libraries.

When you create a path template, you can specify an application 
type. This is a code that indicates which accessories can use the 
paths that use this path template.

When you log into the INFOConnect Manager as an 
administrator, you can mark path templates as Traced, Hidden, or 
System. When you trace a session, you can specify whether to 
trace only those paths whose path template is configured as 
Traced. A hidden path template will appear in list boxes and 
windows only when you are logged in as an administrator; it will 
not be visible to those logged in only as users. A system path 
template is generally intended for paths used internally by other 
transports. For example, INT1 can use TCP/IP or OSI paths 
internally to connect to a host; the path templates for these paths 
are marked for system use.



Appendix A  INFOConnect Connectivity Services

Application Types

Not all paths can be used with all INFOConnect accessories. For 
example, INT1 paths can be used with PEP but not with 
InterCom.

When you open a terminal emulation or file transfer session that 
is not associated with a particular INFOConnect path, you are 
prompted to click the desired path from a displayed list. Only 
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those paths that have the correct application type for that 
accessory in their path or path template appear in that list.

For example, when you open an PEP session, you are presented 
with only those paths that have UTS60 as the application type. 
Paths that have MT as the application type (that is, paths 
designed for use with InterCom) do not appear on the list. For this 
reason, you should always be sure to assign the correct application 
type to any paths or path templates you create:

For these applications Use this application type

PEP UTS60

InterCom MT

ALC ALC

Note:  TCP/IP or OSI paths used with the INFOConnect INT1 
Transport must use INT1 as their application type. 

NetBIOS paths used with HLCNTS must use HLCNTS as their 
application type.
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Paths

An INFOConnect path is a named collection of configuration 
settings. To enable your PC to communicate with a host, you must 
create at least one path and use this path in a session.

If the path contains configuration data about the PC (such as a 
terminal ID, station ID, or other similar identifier), you must 
create one path for each communication session that you plan to 
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open with a host or host application. For example, to open four 
terminal emulation sessions simultaneously, you would need four 
paths. INT1, TCP-A, HLCNTS, and LCW paths fall into this 
category.

However, paths that do not contain configuration data about the 
PC are reusable. In other words, you can create only one path and 
use that same path for several simultaneous sessions. TELNET 
paths fall into this category.

Path Architecture Each path consists of a path template and other configuration 
data associated with the libraries included in that path template.

The following figure shows the architecture of a simple path. Only 
one library is used, and there are no library channels. The 
configuration prompts that appear when you create the path 
relate back to the library used.
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The next figure shows the architecture of more complicated paths 
that include multiple libraries and library channels. Either the 
path configuration or the path template can indicate which library 
channel to use.
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Path Options When you create a path using the INFOConnect Manager, you can 
specify an application type. This is a code that indicates which 
accessories can use this path.

When you log into the INFOConnect Manager as an 
administrator, you can mark paths as Traced, Hidden, or System. 
When you trace a session, you can specify whether to trace all 
paths or only paths configured as Traced. A hidden path will 
appear in list boxes and windows only when you are logged in as 
an administrator; it will not be visible to those logged in only as 
users. A system path is generally intended for internal use by 
other transports. For example, INT1 can use TCP/IP or OSI paths 
internally to connect to a host. The path templates for these paths 
are marked for system use.



Appendix A  INFOConnect Connectivity Services

Accessories

An INFOConnect accessory is an executable file (either an .EXE or 
.DLL) that usually runs in conjunction with the INFOConnect 
Manager. InterCom and PEP are both accessories.

When you install an accessory, the location of that accessory is 
added to the INFOConnect database automatically. If you move 
the accessory to a folder other than the one where it was installed, 
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you must use the INFOConnect Manager to modify the 
INFOConnect database accordingly.
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Packages

An INFOConnect package is one or more pieces of software that 
provide specific communications capabilities.

Transport packages typically consist of one or more external 
interface libraries or service libraries. For example, the 
INFOConnect TCP/IP Transport package includes the TCP 
external interface library and the TP0 service library.
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Accessory packages typically consist of a terminal emulator or file 
transfer application and other related products. For example, the 
InterCom package includes InterCom, InterCom Print Services, 
and the InterCom Print Services Configuration Utility.

When you install a package, the package name and description 
appear in the INFOConnect Manager’s INFOConnect Installed 
Packages window. From this window, you can remove (deinstall) 
packages and perform Quick Config. (You can perform Quick 
Config on the 32-bit products, but no dialog boxes appear.)
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General Troubleshooting Procedures

If you have problems running Accessory Manager or related 
accessories, complete the following steps:

1 Check to see that your system meets the minimum hardware and 
software requirements necessary to use this product. 

Refer to the Readme file for each product for additional details.
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2 Check the configuration options. Most problems are caused by 
incorrect software configuration. Check to make sure you have 
selected the correct configuration options.

3 Check your network software. For example, if you’re using 
TCP/IP, the problem might be in one of the routers in your 
network.

4 Check your connections. Check your cable connections or other 
adapters to make sure that they are securely attached.

5 Check your system. You may be using peripheral equipment or 
other software that may not be compatible with this product. Try 
disabling some of the other memory-resident programs.

6 Resolve errors. If you are receiving error messages, refer to 
Appendix C, “Error Messages,” and Appendix E, “Copy 
Protection,” for help resolving these messages.

7 Consult your distributor. If you cannot identify and solve the 
problem without assistance, contact your product distributor. Call 
from a location where you have access to the problem PC.

8 Contact Customer Support. Refer to the card included with your 
package for details.
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Tracing INFOConnect Sessions

By tracing a session, you can gather diagnostic information about 
communication between the PC and the host.

To trace a session, follow these steps:

1 Start the INFOConnect Manager.
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If you’re running Windows 95 or Windows NT 4.0, click the Start 
button, point to Programs, point to INFOConnect, and click 
Manager32.

If you’re running Windows NT 3.51, double-click Manager32 in 
the INFOConnect program group.

2 From the Administer menu, click Administrator Login and type 
your password. (The default password is no password.)

3 From the Administer menu, click Trace.

4 On the Trace Log Options dialog box, select all the options and 
click OK.

The INFOConnect Trace Log application window opens 
minimized.

5 Display the INFOConnect Trace Log window.

If you’re using Windows 95 or Windows NT 4.0, click the icon in 
the task bar. If you’re using Windows NT 3.51, double-click the 
icon.

6 From the Options menu, click Session Trace.

7 Verify that Enable Session Trace is selected. If it isn’t, select it.

8 For each category (All Paths, Paths with Trace, and Templates 
with Trace), click Libraries.

9 Click OK.

10 Open the session that you want to trace and duplicate the problem 
that you want to trace.
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Diagnostic information about communication between the PC and 
the host is gathered in the TRACE.LOG file in the folder where 
your INFOConnect database is located (usually the Windows 
folder).

11 When you have completed the actions that you want to trace, close 
the session.

12 Display the INFOConnect Trace Log window.
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13 From the Options menu, click Trace Log.

14 Clear Enable Trace Log.

15 Close the INFOConnect Trace Log window.

Note:  The TRACE.LOG file can become very large, so be sure 
to delete it after you complete each trace.



Error Messages C
173

In This Appendix This appendix lists the error messages that might appear while 
you are using Accessory Manager, PEP, or ALC. (InterCom has no 
error messages.)

For a list of error messages generated by INFOConnect 
transports, refer to the online Help.
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Accessory Manager Error Messages

The tables on the following pages list the error messages that 
might appear while you are using Accessory Manager, as well as 
possible solutions to these problems.

Classes of Error 
Messages

The following table lists error message classes and a description of 
each class. A class number precedes each error number.
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Class Description

10 Internal errors

12 Compiler errors

13 Input/output errors

14 Mathematical and range errors

15 State errors

16 Critical errors

17 Macro execution errors

18 Compatibility errors

19 Upload/download errors 

21 Missing information errors

23 Multiple Document Interface errors 

28 Emulator or file transfer protocol error 

33 DLL errors 

40 Generic module errors

45 File transfer errors

50 Navigation errors
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Error Code Error Message Explanation

10-08 Internal error:  Cannot find a 
connection, file transfer, or 
terminal tool. All tools must be 
installed to the frame directory 
before running Accessory 
Manager.

When you run Accessory Manager, it refers to 
the GI32.INI file for a list of installed 
connection, terminal, and file transfer 
protocols. There must be at least one of each. 
This error can occur under the following 
circumstances: 

■ No terminal emulator has been installed. 
Install a terminal emulator (such as PEP or 
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InterCom) before running Accessory 
Manager. 

■ The GI32.INI file has been moved or 
deleted. Put a copy of the GI32.INI file in 
your Windows directory, or reinstall 
Accessory Manager. 

■ The GI32.INI file has been modified, and 
the Accessory Manager cannot read it. 
Delete the GI32.INI file and reinstall 
Accessory Manager.

10-12 Internal error:  Unknown GI 
error.

An internal error has occurred. Contact 
Customer Support.

10-49 Internal error:  Bad row number. Your CASL macro has set an invalid row 
number. Edit the macro to ensure that the row 
number is valid.

10-50 Internal error:  Bad column 
number.

Your CASL macro has set an invalid column 
number. Edit the macro to ensure that the 
column number is valid.

10-51 Internal error:  Bad length. The length of data in your CASL macro is 
invalid. Edit the macro to ensure that the data 
length is valid.

10-96 Unrecognized error code. An internal error has occurred. Contact 
Customer Support.

12-001 Too few arguments to <procedure/ 
function> '<procedure/ function 
name>'.

When calling a previously defined function or 
procedure, you specified more arguments 
than you originally defined. Check the 
definition of the referenced procedure or 
function, and correct your macro.

12-002 Too many arguments to 
<procedure/ function> 
'<procedure/ function name>'.

When calling a previously defined function or 
procedure, you did not specify all the 
arguments that you originally defined. Check 
the definition of the referenced procedure or 
function, and correct your macro.
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12-003 Array '<array name>' is too 
large.

Arrays are limited to a size of 32K. The 
referenced array exceeds that size. You can 
calculate the size of an array by multiplying the 
size of the data elements by the total number 
of elements in the array. Redefine the size of 
your array.

12-004 Invalid left hand side of 
assignment statement.

The operand on the left side of the assignment 
statement is invalid and cannot be assigned a 

Error Code Error Message Explanation
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value. This operand must be a variable. You 
cannot assign a value to a procedure, 
function, or constant. Correct the assignment 
statement and try again.

12-005 Bad combination of type 
modifiers.

The modifiers of this declaration are mutually 
exclusive. Modify the statement and try again.

12-006 No more cases allowed after the 
default case.

The default case must be the last value in a 
case statement. Check the structure of the 
case statement.

12-007 This format of the <statement 
name> statement is not supported 
in this version.

The statement in the macro is not supported or 
is incorrectly formatted. Refer to the 
INFOConnect CASL Script Language Guide  
for information about macro syntaxes.

12-008 End of file was encountered in a 
comment.

The compiler reached the end of the source 
file while processing a comment. Check to see 
if the end-of-comment delimiter was 
accidentally deleted.

12-009 <language element> must be a 
compile time constant.

You must use a constant here. You cannot use 
a variable.

12-018 Duplicate declaration of 
'<variable>'.

You have declared this variable twice. Only 
one declaration is allowed.

12-019 Reference to undeclared variable 
'<variable>'.

This variable has not been declared, and the 
compiler was unable to determine its data type 
from the context. Declare the variable in your 
macro.

12-020 Division by zero. In evaluating the expression in this statement, 
you attempted to divide by zero. This is not 
allowed. Correct your macro and try again.

12-021 Unable to open file '<bad 
file>'.

The compiler received an error when it tried to 
open this file. Check that the file name is 
specified correctly.
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12-022 Error reading file '<bad file>'. The compiler encountered an error while trying 
to read this file. Make sure the file exists and 
is not damaged.

12-023 For loop needs assignment. You did not set the initial value of the loop 
control variable in a for statement. Correct the 
for statement in your macro. 

12-024 '<procedure/ function name>' was One of two possibilities occurred: 
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declared forward as <procedure 
or function>, not <procedure or 
function>.

■ You declared this procedure or function as 
a procedure in the forward declaration, but 
defined it as a function in the actual 
definition. 

■ You declared this procedure or function as 
a function in the forward declaration, but 
defined it as a procedure in the actual 
definition. 

Correct your macro so the forward declaration 
and the definition match.

12-025 Too few parameters to 
'<procedure/ function name>' to 
match forward declaration.

The definition of this procedure or function has 
fewer parameters than its forward declaration. 
Make sure the forward declaration and the 
actual definition match exactly.

12-026 Too many parameters to 
'<procedure/ function name>' to 
match forward declaration.

The definition of this procedure or function has 
more parameters than its forward declaration. 
Make sure the forward declaration and the 
actual definition match exactly.

12-027 Unresolved forward <procedure or 
function> '<procedure/ function 
name>'.

You made a forward declaration for this 
procedure or function, but you never provided 
an actual definition of it. Provide a definition for 
this procedure or function in your macro.

12-028 '<identifier>' is not a function 
name.

You have used an identifier as a function, but 
it is not a function. You must use a valid 
function name. 

12-029 genlabels directive must be on 
to use a computed goto.

At some point in your macro, you specified the 
GENLABELS OFF directive. This directive 
must be turned on (its default state) to use the 
computed goto statement in a macro.

12-030 '<identifier>' is not a label. You have used identifier as a label, but it is not 
a label. You must use a valid label.
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12-031 Input statement needs a 
variable, not a constant.

You must specify a variable rather than a 
constant for the input statement. The input 
statement will use this variable to process 
keyboard input.

12-032 Internal error: <compiler 
module> line <number>.

An internal error has occurred in the compiler. 
Contact Customer Support and be prepared to 
furnish a copy of the macro that caused the 
error along with the exact information in this 
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message.

12-033 Invalid time interval. You specified a time interval incorrectly. Check 
the way you expressed the time.

12-034 Unresolved label: 
'<identifier>'.

This label was never defined anywhere in your 
macro. Add the label to the appropriate 
section of your macro.

12-035 Lexical analysis error: 
<specific error>.

This error occurred during the lexical analysis 
phase of the compilation process. Check this 
section of your macro for syntax errors.

12-036 List box contents must be 
<string> or one-dimensional 
<string> array.

The variable that contains the list of items to 
be included in a list box must be either a string 
of items separated by commas or a one-
dimensional array of strings.

12-037 Compiler out of memory. The compiler ran out of memory while 
compiling your macro. Close any unneeded 
applications and try again.

12-038 Too many arguments to Nextline. Too many arguments were specified for the 
nextline statement. Check the list of 
arguments you are passing to this statement.

12-040 Second operand of mod operator 
must be positive.

The modulus function allows only positive 
numbers for its second operand. Revise your 
statement to use a positive number.

12-042 Cannot have more than one OK or 
Cancel button.

A dialog box can have only one OK button and 
one Cancel button. Revise your macro 
accordingly.

12-043 Could not open module file '<bad 
file>'.

Accessory Manager could not open the 
module file you specified. Make sure that the 
file name is correct and that the file resides in 
the proper location.

12-044 Parsing error: <specific error>. This error occurred during the syntactic 
analysis phase of the compilation process. 
Check this section of your macro for syntax 
errors.
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12-045 Print format specification is 
not supported in this version.

Accessory Manager does not support print 
format specifications. Revise your macro to 
eliminate these specifications.

12-046 '<identifier>' is not a 
procedure name.

You have used an identifier as a procedure, 
but it is not a procedure. You must use a valid 
procedure name.

12-047 Exit can only be used inside a The compiler encountered an exit statement 
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procedure. outside of a procedure. Check the procedures 
and functions in your macro and make sure 
that they begin and end properly.

12-048 Return with value can only be 
used inside a function.

The compiler encountered a return with a 
value outside of a function. Values can only be 
returned from functions. Check the procedure 
and functions in your macro and make sure 
that they begin and end properly.

12-049 Exit cannot be used in a 
function.

The exit statement cannot be used to leave a 
function. It can only be used to leave 
procedures. Use the return statement instead 
of the exit statement in a function.

12-050 Return in a procedure cannot 
return a value.

Procedures cannot return values. The return 
statement is used to return a value inside a 
function. Either redefine your procedure as a 
function, or change the return statement in 
your procedure.

12-051 Bad use of '^' in string 
constant.

The caret symbol followed by a control 
character indicates an unprintable control 
character in a string constant. The character 
following the caret is not a valid control 
character. Check the character following the 
caret in the string constant.

12-052 String constant too long. The maximum length of a constant is 256 
characters. Shorten your string to fit within this 
limit.

12-053 String subscript out of range. The subscript you specified to access a 
character in this string is beyond the end of the 
string. Make sure the subscript is within the 
bounds of the string.

12-054 Too few subscripts to <array 
name>.

You have not specified enough subscripts to 
reference this array. You specified more 
dimensions when you declared the array than 
you used when you referenced it. Correct 
either the declaration or the reference.
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12-055 Too many subscripts to <array 
name>.

You have specified too many subscripts to 
reference this array. You specified fewer 
dimensions when you declared the array than 
you used when you referenced it. Correct 
either the declaration or the reference.

12-056 Syntax error at '<bad token>'. The compiler found an error in your macro 
near bad token. Make sure that all language 
elements in this section of your macro are 
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specified properly.

12-057 Bad token: '<string>'. The compiler did not recognize a string in your 
macro. Make sure that all language elements 
in string and in the instructions surrounding it 
are specified properly.

12-058 Track procedure cannot take 
parameters.

The procedure you named to the track 
statement cannot have any parameters. Make 
sure that both the track statement and the 
procedure definition are specified properly.

12-059 Track procedure cannot be a 
function.

The procedure you named to the track 
statement must be a procedure, not a function. 
Make sure that both the track statement and 
the procedure definition are specified properly.

12-060 Track procedure can only be a 
label or user procedure.

The procedure you named to the track 
statement may only be a procedure or a label. 
Make sure that both the track statement and 
the procedure definition are specified properly.

12-061 Type error:  Assume file name 
must be a <string> constant.

The file name you specified in the assume 
statement must be a string constant, not a 
variable. Make sure that the name is a string 
and a constant.

12-062 Type error: cannot perform 
"<operator>" on types <type 1> 
and <type 2>.

This operation cannot be performed on 
variables of these types. Check the operation 
and make sure that the operands are of 
compatible types.

12-063 Type error:  case selector 
cannot be <bad type>.

The type specified in the message cannot be 
used for the selector in a case statement. Use 
a different type for the selector.

12-064 Type error: cannot convert <type 
1> to <type 2>.

The compiler cannot convert the values 
specified. Check the operation and make sure 
that the operands are of compatible types.



Appendix C  Error Messages

12-065 Type error: "<string>" cannot be 
converted to <type>.

The compiler encountered an error when 
attempting to convert this string into type. This 
conversion was required by the usage of the 
string in your macro. Make sure the value in 
this string is compatible with the data types 
required by this statement. Perhaps a string is 
not required in this case and some other data 
type could be used.
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12-066 Type error: <language element> 
must be <good type>, not <bad 
type>.

You used an invalid type for language element. 
You must use the type specified in good type.

12-067 Type error: <language element> 
must be a <type> variable.

You used an invalid type for language element. 
You must use a variable of the type specified 
in type. A constant is not allowed in this 
situation. 

12-068 Type error: Parameter <number> 
of '<procedure/ function name>' 
was declared forward as <good 
type>, not <bad type>.

In the forward declaration of this procedure or 
function, this parameter was declared to be of 
a different type than in the actual definition. 
Make sure the forward declaration and the 
actual definition match exactly.

12-069 Type error: Return type of 
'<function name>' was declared 
forward as <good type>, not <bad 
type>.

In the forward declaration of this function, the 
return value was declared to be of a different 
type than in the actual definition. Make sure 
the forward declaration and the actual 
definition match exactly.

12-070 Type error: colors must be 
<integer> or specific color 
names.

You must either use an integer expression or 
specific color names, such as “red,” to specify 
a color.

12-071 Type error: argument <number> of 
<procedure or function> 
'<procedure/ function name>' 
must be <good type>, not <bad 
type>.

One of the arguments for this procedure or 
function is of the wrong type. Check the 
definition of the procedure or function and 
make sure that you are calling it properly.

12-072 Type error:  cannot subscript 
<variable>.

This variable is not an array variable and 
cannot be subscripted. Either declare the 
variable to be an array, or use an existing array 
variable.

12-073 Type error: subscript '<number>' 
of '<array name>' must be <good 
type>, not <bad type>.

This subscript is of the wrong type. Make sure 
the subscript is of the type specified in good 
type.
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12-074 Type error: subscript '<string 
name>' must be <good type>, not 
<bad type>.

This subscript is of the wrong type. Make sure 
the subscript is of the type specified in good 
type.

12-075 Type error: cannot perform 
'<operator>' on type <bad type>.

This operation cannot be performed on a 
variable of a bad type. Check the operation 
and make sure that the operand’s type is 
compatible with the operation.

12-076 Type error: <procedure> must be 
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a user procedure>.
A user-defined procedure is required here. 
You cannot use a CASL built-in procedure.

12-077 The number of buttons is limited 
to four.

An alert box can have only four buttons. You 
have tried to put too many buttons in your box. 
Limit the number of buttons to four.

12-078 Statement or expression is too 
complex.

This statement or expression is too complex 
for the compiler to compile. Simplify the 
statement or expression, or break it up into 
smaller parts.

12-079 Type error: cannot assign 
<right-side type> to <left-side 
type>.

The type of expression on the right side of the 
assignment statement is not compatible with 
the variable on the left side. Correct the 
assignment statement to make the types 
agree.

12-080 Error writing file '<bad file>'. The compiler received an error from the file 
system when it tried to write to the specified 
file. Possible reasons for this error are as 
follows: 

■ Your disk is full. Free up space on this disk 
or use another disk. 

■ You have too many files open in other 
applications. Close any applications you 
are not using. 

■ Your disk is bad. Check to make sure your 
disk is not damaged. 

■ A removable disk or a network disk is no 
longer online. Make sure the disk you are 
trying to write to is online.

12-081 String constant must be one 
line.

A string constant must be entirely on one line. 
It cannot extend across multiple lines. Your 
string is too long. Make sure the string has a 
closing quotation mark.
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12-082 Keyword '<bad-keyword>' cannot 
be used here.

The referenced CASL keyword cannot be 
used in this context. If you were not aware that 
this was a CASL keyword, you can correct this 
problem by adding the or my to the word. For 
example, you can use my_password rather 
than password.

12-255 Unrecognized keyword: '<bad 
keyword>'.

The keyword is not known by the compiler. 
Revise your macro to eliminate this keyword.
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13-05 The file number is invalid or 
missing.

Make sure you specify a file number in the get, 
put, read, and write statements. You must 
precede the number with the pound symbol 
(#).

13-06 The specified file channel 
number is already open. You must 
first close the channel or use 
another one.

The specified file channel number is already 
open. You must first close the channel or use 
another one.

13-07 The specified channel number is 
not open.

You tried to manipulate a file using read, write, 
get, or put without first opening the file, or the 
file was previously closed. Open the file before 
using read, write, get, or put.

13-08 Accessory Manager cannot read an 
output file.

You opened this file for output only and tried to 
issue a read or get statement. Modify your 
macro and try again.

13-09 Accessory Manager cannot write 
to an input file.

You opened this file for input only and tried to 
write to it using the write or put statements. 
Modify your macro and try again.

13-10 Accessory Manager cannot get/put 
a text file.

You opened the file for input or output. These 
are read and written to sequentially using the 
read and write statements. Use get and put for 
random files.

13-11 Accessory Manager cannot read 
from or write to a random file.

You opened the file in random mode and tried 
to use the read or write statements. Use get 
and put for random files.

13-16 Window coordinates out of range. The coordinates you have specified for 
accessing a window are not valid. The 
coordinates must access a valid portion of the 
window or display.

13-18 The specified window is not 
open.

You have specified a window that is not open. 
You cannot perform operations on a window 
unless it is open.
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13-28 Attempt to send output to the 
display failed.

An error occurred while Accessory Manager 
was trying to write information to the screen. 
Try running the macro again. If it still fails, 
close Accessory Manager and Windows and 
try again.

13-29 A file copy failed. Accessory Manager was unable to copy a file. 
The following are possible reasons for this 
error: 
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■ Your disk is full. Delete unneeded files and 
try again. 

■ You have too many files open in other 
applications. Close the open files and try 
again. 

■ Your disk is bad. Contact your system 
administrator. 

■ A removable disk or a network disk is no 
longer online. Try again when the 
specified disk is online.

13-30 The script attempted a seek in a 
sequential file; you can use 
seek only with random files.

The file was not opened properly for 
performing the seek function. Open the file 
using the appropriate mode.

13-31 Multiple windows in a session 
are not supported in this 
version.

This feature is not currently supported. Revise 
your macro to use other language elements.

13-32 An error has occurred in 
attempting to create a new 
window.

An error occurred with the new command in 
your macro. If you are using this command to 
open an existing session, be sure to specify 
the file name of the existing session.

13-33 There is already a file that has 
the name selected.

You must use a unique name for each file. 
Change the file name and try again.

13-48 File creation error. Accessory Manager was unable to create a 
file. Verify that you have adequate space on 
your disk and that you have write privileges.

13-64 You must use -k or -c when using 
-p command line parameter.

The -p command line parameter specifies 
which INFOConnect path to use for a 
particular session. You must first open a 
session using the -k or -c command line 
parameters before you can specify a path for 
the session.
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13-65 The caption specified is too 
long. It will be truncated.

The caption specified for the session window 
title bar is greater than 128 characters. 
Accessory Manager will truncate the caption 
unless you reduce its size.

13-66 Administration utility file not 
found. See your administrator 
for further instructions.

If the file AMFULL.RCF is not in the Windows 
directory, Accessory Manager cannot run. 
Copy this file to the Windows directory, or 
reinstall Accessory Manager.

Error Code Error Message Explanation
Accessory Manager Error Messages 185

14-03 Division by zero was attempted. You tried to divide by zero. Check your macro 
and the expression used for the divisor to 
determine why the divisor contained a value of 
zero.

14-05 The expression is not valid for 
the variable.

You tried to assign a different variable type to 
this variable. Be sure to use valid expressions 
for each variable.

14-06 The value is outside the 
permissible range.

You specified a range for the indexes in an 
array variable. The index falls outside that 
range.

14-09 A string was truncated. Accessory Manager truncated a string 
because it was too long. Strings can be up to 
32K.

14-10 Invalid characters were found in 
a numeric string.

You tried to make an assignment to an integer 
value. The expression contained alphabetic or 
non-numeric characters. If you are using 
hexadecimal representation, make sure the 
number ends in h.

14-11 The specified value is outside 
the acceptable range.

You specified a range for the indexes in an 
array variable. The index falls outside that 
range. Increase the size of the array. If you are 
using a variable for the index, make sure that 
the variable contains a value inside the 
defined array range.

14-18 An invalid string was specified 
for the quote function.

A string specified for the quote function cannot 
contain both single and double quotation 
marks. Make sure that both types of marks are 
not used in the string you pass to the quote 
function.

15-01 The specified command is 
applicable only when you are 
online.

You were running a macro meant to be used 
online, and you were not connected to a host. 
You may want to use the trap, error, and online 
functions in the macro to determine if you are 
connected.



Appendix C  Error Messages

15-07 The specified session does not 
currently exist.

This function requires a session number as a 
parameter. Make sure the session exists by 
using the sessno function to get its session 
number.

15-08 Feature is not supported by the 
current terminal.

Modify your macro to ensure that only valid 
functions for the specified terminal type are 
executed.

16-02 Drive is invalid or unknown.
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Specify a valid drive and try again.

16-03 Drive is not ready. Insert a disk or close the drive door.

16-07 A seek error has occurred. Accessory Manager could not find the 
specified data. Use the SCANDISK utility to 
make sure your disk has not been corrupted.

16-11 A write fault has occurred. Accessory Manager could not find the 
specified data. Use the SCANDISK utility to 
make sure your disk has not been corrupted.

16-12 A read fault has occurred. Accessory Manager could not find the 
specified data. Use the SCANDISK utility to 
make sure your disk has not been corrupted.

17-01 The specified label cannot be 
found.

Make sure the label you specified in the gosub 
or goto statements has a corresponding label 
statement where you want it to go. Labels are 
not case-sensitive.

17-03 'gosub' statements are nested 
too deep.

You can have only a certain number of gosub 
statements without issuing a return. Refer to 
the CASL Script Language Guide for the 
correct syntax.

17-05 A data type mismatch for an 
external variable was found.

You are referencing a variable declared in 
another macro. Check the other macro for the 
appropriate data type for that variable.

17-07 The script was canceled by the 
user.

This is an informational message. You can run 
the macro again.

17-08 A reference to an unresolved 
external variable was found.

This variable is declared as external in this 
macro. It must be declared as public in a 
macro that calls this macro using the do 
statement.
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17-10 An unavailable module variable 
was found.

You used the assume statement to specify 
settings that are used by certain connection, 
terminal, and file transfer protocols. The 
module in the assume statement is not yet 
loaded. Use the device, terminal, or protocol 
statements to load a given module. The 
assume statement only makes these variables 
and settings known to the compiler; it does not 
load the module to make them accessible to 
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running macros.

17-12 A 'return' statement without a 
corresponding 'gosub' statement 
was found.

While executing the macro, a return statement 
was encountered, but the macro is not in a 
gosub. There may be a logic error in the 
macro. Examine the logic of the macro 
carefully and revise it.

17-14 A script compilation failed when 
'chain', 'do', or 'compile' 
statement was executed.

When a chain, do, or compile statement is 
issued, Accessory Manager checks to see if 
the macro needs compiling. If it does, 
Accessory Manager recompiles it before it 
runs. This error message appears when a 
macro is compiled in this manner but has an 
error and cannot continue. Use the CASL 
Macro Editor to correct errors in the macro, 
and try again.

17-15 A return value was missing in 
the return from a function.

You declared a function but never used the 
return statement to return a value. The value 
must be the same data type you used when 
you declared the function.

17-16 Generic error. This error can occur when the PC is out of 
memory. Close any unneeded applications, 
and try again.

17-17 An internal error occurred. 
Delete the .xwc file and 
recompile the script.

The .XWC file has become corrupted. Delete 
the file and recompile the macro.

17-18 An invalid count expression was 
used.

The count expression used in this statement is 
not valid. Correct this portion of the statement.

17-19 A string expression is too long. Strings are limited to 32K in size. Change the 
logic of your macro so that you do not create 
strings exceeding this length.

17-20 There is not enough global 
memory available.

Accessory Manager does not have enough 
memory to perform the function. Try closing 
sessions, QuickPads, and other windows that 
you are not currently using.
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17-21 A 'dialogbox' keyword was used 
outside a 'dialogbox' statement.

The keywords which describe a dialog box can 
only be used inside a dialogbox statement. 
Revise your macro to eliminate this 
occurrence of the keyword.

17-22 'dialogbox' statements are 
nested. These statements cannot 
be nested.

Revise your macro to eliminate nested 
dialogbox statements.

17-23 The dialog cannot be displayed.
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The dialog box is too complex to be displayed. 
Simplify the dialog box or break it into multiple 
dialog boxes.

17-24 No pushbutton was specified for 
a dialog box.

Every dialog box must have at least one button 
so that the user can close the dialog box. Add 
at least one button to your dialog box.

17-25 'watch' statements cannot be 
nested.

Revise your macro so that a second watch 
statement is not called while another watch is 
active.

17-26 Too many track channels are 
open.

Check your usage of the track statement and 
reduce the number of channels being used at 
once.

17-27 A stack overflow has occurred. 
Procedures or functions are 
nested too deep.

You have made too many nested calls to 
procedures and functions. Revise your macro 
so that calls are not nested as deeply.

17-28 The specified QuickPad file 
cannot be found.

Make sure that you have specified the correct 
drive, directory, file name, and file extension 
for the QuickPad. If you are trying to access 
the QuickPad file from a network drive, make 
sure that you are still connected to the 
network.

17-29 The specified QuickPad file has 
not been loaded.

You have referred to a QuickPad file that is not 
loaded. Load the QuickPad file and then 
perform other operations on it.

17-30 Cannot compile script because 
the compiler is already 
compiling another script.

You can compile only one macro at a time. 
Wait for the first compilation to finish before 
starting another.

18-01 One or more specified modules 
are of an incompatible version.

Your GI.DLL file is incompatible with 
Accessory Manager. Reinstall Accessory 
Manager.

18-03 The .XWC file is bad. Recompile 
the .XWS file.

You must recompile the .XWS file.
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18-05 The specified feature is not 
supported in this version.

Modify your macro to ensure that only valid 
functions for the specified terminal type are 
executed.

18-16 Invalid profile. A problem has been detected in your file. 
Create a new file and try again.

18-17 Section not found in profile. A problem has been detected in your file. 
Create a new file and try again.
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18-19 Keyword not found in profile. A problem has been detected in your file. 
Create a new file and try again.

18-20 Invalid keyword in settings. A problem has been detected in your file. 
Create a new file and try again.

18-21 Invalid value in settings A problem has been detected in your file. 
Create a new file and try again.

18-22 Profile section read error. A problem has been detected in your file. 
Create a new file and try again.

19-01 An unexpected DOS error has 
occurred.

Contact Customer Support.

19-02 The specified file cannot be 
found.

Verify that the specified drive, directory, and 
file name are correct.

19-03 The specified path cannot be 
found.

Verify that the specified drive and directory are 
correct.

19-05 Access has been denied to the 
specified file.

You do not have access privileges to the 
specified file, or the file is write-protected. 
Make sure the attributes for the file are not 
read-only and that the disk is not write-
protected.

19-13 An invalid file name was 
specified.

The file name is not valid. Correct the file 
name and try again.

19-14 Nonexistent file specified. The specified file name does not exist. Enter a 
valid file name and try again.

19-15 Nonexistent directory specified. The specified directory name does not exist. 
Enter a valid directory name and try again.

19-19 Diskette is write-protected. You cannot write to the specified disk. Use a 
different disk, or obtain write privileges.

19-21 Disk full. The disk is full. Delete unneeded files from the 
disk and try again.

19-22 Invalid filename. The specified file name is not valid. Enter a 
valid file name and try again.
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19-23 Invalid directory name. The specified directory name is not valid. 
Enter a valid directory name and try again.

19-24 Cannot run application 
specified.

The specified application cannot be run. Make 
sure that the application name is specified 
properly or try another application.

21-01 The specified script file cannot 
be found. Check the name and 

Accessory Manager cannot find the specified 
macro file. Check the name, make sure the file 
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make sure the file is in the 
ACCMGR directory.

is in the Accessory Manager directory, and try 
again.

21-09 There is no default file name; 
'filefind' must be used to set 
up a default file.

The first time that you call filefind you must 
specify a legal file specification that can 
include drive specifiers and directory names 
as well as wildcard characters. Only on 
subsequent calls can you omit the string to 
receive additional file names in the list.

21-10 The ADP file contains a 
reference to an unknown tool.

The session profile is using a connection type, 
terminal type, or file transfer protocol that 
Accessory Manager no longer recognizes. 
Open the session and reconfigure it using 
valid tools, or edit the .ADP file using the Text 
Editor.

23-08 Unable to create an MDI document 
window. Try freeing some memory.

Before trying this operation again, close other 
open applications.

28-16 Invalid module or module not 
found.

A connection, terminal type, or file transfer 
protocol specified in your session profile 
cannot be found. Make sure the tools have 
been installed. If this error persists, re-create 
the session.

33-01 DLL file could not be found. Accessory Manager could not find a required 
DLL file. Verify that all the files are in 
Accessory Manager directory.

33-02 Path for DLL was not valid. The directory specified for a required DLL file 
does not exist. Verify that all the files are in 
Accessory Manager directory.

33-03 DLL file was invalid or corrupt. Reinstall Accessory Manager to overwrite the 
corrupt DLL file.

33-04 Unable to use requested DLL 
file.

Accessory Manager could not access a 
required DLL file. Make sure that you have 
read privileges to Accessory Manager 
directory and try again.
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33-05 Unable to use requested DLL 
function.

Accessory Manager could not access a 
required DLL function. Make sure that you 
have read privileges to Accessory Manager 
directory and try again.

33-06 Attempt to use a data type that 
is not supported.

Refer to the INFOConnect CASL Script 
Language Guide for information about the 
types of data supported.

40-16 Invalid module or module not 

Error Code Error Message Explanation
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found.
You tried to open a session that uses a 
terminal type that has not yet been installed or 
is not listed in the GI32.INI file. Use a different 
session, or install the desired terminal 
emulator, or modify the GI32.INI file to indicate 
that the terminal emulator has been installed.

40-17 [No error message] No printer is currently associated with this 
session. From Accessory Manager’s File 
menu, click Print Screen and select a printer.

40-18 Could not locate and load 
library.

Accessory Manager cannot find the error 
strings .DLL (DCAAMERR.DLL). Reinstall 
Accessory Manager and try again.

45-01 General time-out. A general time-out has occurred. The host's 
protocol did not respond. You may need to 
increase the timing specified for your file 
transfer protocol.

45-02 Host not responding. The host is not responding. Accessory 
Manager tried to transfer the file but received 
no response from the host. Check the 
communications link and try the transfer 
again.

45-04 Too many errors - transfer 
canceled.

Accessory Manager automatically canceled 
the transfer because the maximum number of 
errors was reached. Try again. If the problem 
persists, change the timing for the file transfer 
protocol or raise the number of errors that are 
allowed.

45-06 Sequencing failure - transfer 
canceled.

Accessory Manager canceled the transfer 
because of a sequencing failure. The file 
transfer protocol encountered an internal 
error. Try the transfer again. If the problem 
persists, contact Customer Support.

45-07 Transfer canceled by local 
operator.

The user canceled the file transfer. This is an 
informational message only. You can transfer 
the file again.



Appendix C  Error Messages

45-08 Transfer canceled by host. The host canceled the file transfer. Too many 
errors may have occurred, or the host disk 
may be full. Check the host disk or increase 
the maximum number of errors allowed.

45-09 Protocol can't do wildcard 
transfers.

You used a file transfer protocol that does not 
support a wildcard transfer for the file name. 
Transfer a single file at a time or use a protocol 
that allows wildcard transfers.

Error Code Error Message Explanation
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45-11 Local disk full. The file transfer cannot take place or was 
canceled because the local disk is full. Clear 
some space on the specified disk drive or 
change drives.

45-12 Host disk full. The file transfer did not occur because the 
host disk is full. Clear some space on the 
specified host drive or change drives.

45-16 Bad protocol selection. Accessory Manager does not support the file 
transfer protocol you selected. Choose a 
supported protocol and try again.

45-18 The server command is not valid. You issued a Kermit command that is not 
currently supported. Revise your macro to 
remove this command.

50-176 Error in navigation. An attempt 
to follow a path took us to an 
unknown screen. Playback is 
terminated.

While using the recorded navigation paths, 
Accessory Manager got to an screen that it 
could not identify. This can occur if the original 
recording included data that does not always 
appear on the host screen or that has changed 
since the original recording was made. You 
might have to delete or truncate an 
identification field and try again. Refer to the 
online Help for information on this procedure.

50-177 Error in navigation. An attempt 
to follow a path took us back to 
the same screen. Playback is 
terminated.

You recorded a procedure that invokes the 
same host screen, or Accessory Manager 
cannot distinguish between two very similar 
host screens. Re-record the host screens and 
try again, or modify the identification fields for 
the recorded screens and try again.
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50-178 Error in navigation. An attempt 
to follow a path took us to an 
unexpected screen. Playback is 
terminated.

While using the recorded navigation paths, 
Accessory Manager went to a screen that 
could be identified, but this was not the screen 
it expected to arrive at as a result of following 
the navigation path. Re-record the procedure 
to arrive at the desired host screen and try 
again.

50-182 No path exists from the current You clicked the name of a recorded host 

Error Code Error Message Explanation
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screen to the destination 
screen.

screen on the Bookmarks/Pages dialog box, 
but no navigation path exists to get to that 
screen. Re-record the procedure to get from 
the current screen to the desired screen and 
try again.
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PEP Error Messages

The following tables list the error messages that might appear 
while you are using PEP and possible solutions to these problems.

Error Message Solution

A 'Y' should be specified in the XMT or 
RCV field for transfer to occur.

Type Y so that the transfer will be initiated.
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Buffer passed to Common Dialog too 
small to accommodate string

Contact Customer Support. An internal error has 
occurred.

Cannot find Application list. Create a 
[UTS Host Applications] section in the 
Registry. See documentation for 
details.

Add a UTS Host Applications key to the Windows 
registry. Refer to the online Help for more 
information.

Could not write to file. Check the read/write attributes of the file you are 
writing to.

Creation of Common Dialog failed on 
call to DialogBox()

Contact Customer Support. An internal error has 
occurred.

Data in DEVMODE contradicts data in 
DEVNAMES

Contact Customer Support. An internal error has 
occurred.

Error in creating file. The filename 
may be invalid or this file may have a 
read only attribute or the disk may be 
full.

Check for a valid file name, check for a read-only 
attribute, and/or check your disk for available 
space.

Error in file transfer. Try the transfer again.

Error in reading from the disk on 
MAPPER Upload.

Check the disk from which you are attempting to 
read to ensure it is functioning properly.

Error in writing to the disk on MAPPER 
Download.

Check the disk to which you are attempting to write 
to ensure it is functioning properly and space is 
available.

Error occurred while accessing entry in 
the registry.

Check for the existence and location of the UTS 
Host Applications or UTS Options key in the 
Windows registry. Refer to the online Help for more 
information.

Error. Currently the Terminal Index 
should be 1.

Ensure a 1 is entered in this field. PEP does not 
support indexes other than 1.

Error. Invalid Blocksize specified. Type a valid value for the Blocksize. It must be a 
decimal value.

Error. Invalid Drive Letter specified. Select the correct drive containing the file.
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Error. Invalid Prompt specified. Type a valid value for the Prompt character. It must 
be a hexadecimal character.

Error. Invalid Separator specified. Type a valid value for the Separator. It must be a 
hexadecimal character.

Error. The Options field contains 
invalid characters.

Verify the available options and enter a valid value.

Error. The Specified file Does not Provide the proper file name.

Error Message Solution
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Exist.

Failure allocating memory for internal 
Common Dialog structure

Contact Customer Support. An internal error has 
occurred.

Failure creating an IC Contact Customer Support. An internal error has 
occurred.

Failure finding custom template for 
Common Dialog

Contact Customer Support. An internal error has 
occurred.

Failure finding specified resource Contact Customer Support. An internal error has 
occurred.

Failure initializing Common Dialog. 
Possibly due to insufficient memory.

Contact Customer Support. An internal error has 
occurred.

Failure loading specified resource Contact Customer Support. An internal error has 
occurred.

Failure loading specified string Contact Customer Support. An internal error has 
occurred.

Failure loading the printers device 
driver

Contact Customer Support. An internal error has 
occurred.

Failure locking memory for internal 
Common Dialog structure

Contact Customer Support. An internal error has 
occurred.

Failure locking specified resource Contact Customer Support. An internal error has 
occurred.

Failure parsing strings in [devices] 
section of WIN.INI

Your WIN.INI file may be corrupt. Re-install your 
print drivers.

Failure setting up resources for Common 
Dialog

Contact Customer Support. An internal error has 
occurred.

Failure subclassing during 
initialization of Common Dialog

Contact Customer Support. An internal error has 
occurred.

File I/O related errors occurred while 
trying to convert the data. Conversion 
aborted. 

Check the read/write attributes of the files that are 
being converted.
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File not opened in FILE TO PAGE 
transfer.

Check for the existence of the file you are 
accessing, as well as its location. In addition, check 
the read/write attributes of the file.

Filename does not contain characters. Select the Characters option on the Page To File 
dialog box to save the specified file with 
Characters.

Filename does not contain emphasis Select the Emphasis option on the Page To File 
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information. dialog box to save the specified file with Emphasis.

Filename does not contain FCC 
information.

Select the FCCs option on the Page To File dialog 
box to save the specified file with FCCs. 

Filename is not a binary dump file. Try to display the specified text file using the File To 
Page dialog box. The file was not originally saved 
using the Page to File dialog box, and the signature 
is not recognized.

Filename was not saved from a screen 
having the same dimensions as the 
current screen.

Change the dimensions of your current screen to 
the same or greater than those of the saved screen.

Global Lock has failed Close unneeded applications to free additional 
memory.

Instance handle not passed to Common 
Dialog 

Contact Customer Support. An internal error has 
occurred.

Internal Control Page Error. Check your Extended Control Page options to 
ensure they are correct.

Internal error in accessing the file. 
Check on disk space and/or file read/
write attributes for the given file.

Check your available memory, as well as the read/
write attributes of the file you are accessing.

Invalid filename or file does not 
exist.

Check the file name for correct entry, or try a new 
file.

Invalid filename passed to FileOpen or 
FileSave

Contact Customer Support. An internal error has 
occurred.

Invalid structure size passed to Common 
Dialog

Contact Customer Support. An internal error has 
occurred.

Invalid Transmit Mode Select a valid Transmit Mode and try again.

Invalid value for Sequence Handler Type a valid value for the Sequence Handler and try 
again.
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MAPPER file transfer cannot be 
performed unless the Screen dimensions 
are 80 cols by 24 rows or 132 cols by 
24 rows.

Set your terminal dimensions (rows and columns) 
to either 24 x 80 or 24 x132 to perform MAPPER file 
transfers.

No default printer was found Access the Printers section of the Windows Control 
Panel and assign a default printer.

No fonts exist Access the Fonts section of the Windows Control 
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Panel to ensure that you have the PEP emulation or 
UTS emulation fonts installed. If not, re-install PEP.

No hook function passed to Common 
Dialog but ENABLEHOOK was passed as a 
flag

Contact Customer Support. An internal error has 
occurred.

No printer device drivers were found Access the Printers section of the Windows Control 
Panel to install necessary printer drivers.

Not enough memory available to create 
Host application list. Please close 
down some applications and try again.

Close unneeded applications to free additional 
memory.

Number Beeps is greater than Max Beeps Type a valid value for the number of beeps.

Number of Columns is greater than Max 
Columns

Type a valid value for the number of columns.

Number of FCCs is greater than Max FCCs Type a valid value for the number of FCCs.

Number of Lines is greater than Max 
Lines

Type a valid value for the number of rows.

Number of Pages is greater than Max 
Pages

Type a valid value for the number of pages.

PD_RETURNDEFAULT flag was set but 
either the hDevMode or hDevNames field 
was on zero

Contact Customer Support. An internal error has 
occurred.

Print Common Dialog failed during 
initialization

Close open applications to free memory and try 
again. If error persists, contact Customer Support 
for additional assistance.

Printer DID is greater than MAX Printer 
DID

Type a valid value for the printer Device Identifier.

Printer not found Access the Printers section of the Windows Control 
Panel to install necessary printer drivers.

Read DID is greater than MAX Read DID Type a valid value for the read Device Identifier.

Sufficient Memory is not available for 
performing TIP30 transfer, please close 
down applications and try again.

Close down any applications you are not currently 
using to free memory.
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The printer driver failed to initialize 
a DEVMODE data structure

Contact Customer Support. An internal error has 
occurred.

The Rid does not contain as many lines 
as specified in the Mapper download 
options dialog box. Cannot download!

Specify a Start At Line value (for a partial transfer) 
that is less than or equal to the number of line in the 
MAPPER RID.

There is not enough memory to open the 
profile file. Please free up some 

Close unneeded applications to free additional 
memory.

Error Message Solution
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memory and try again.

There is not enough memory to process 
all present FCCs correctly. Close down 
a few screens and try again, or 
increase the default FCCs/Line option 
in configuration for this screen.

Close unneeded applications to free additional 
memory.

Unable to access specified record in 
the registry.

Check the Windows registry to ensure that the 
appropriate value is listed. Refer to the online Help 
for more information.

Unable to create a timer. Hence 
blinking will not be supported. All 
blinking characters will appear in 
italics. Shutdown some applications 
that use the timer and try again.

Close unneeded applications to free the timer.

Unable to locate keyword. Check the Windows registry to ensure the data for 
each value is correct.

Unable to locate section. Check the Windows registry to ensure the key 
exists and is properly named.

Unable to locate the path in the 
registry. Please generate a string 
named 'Directory' with the path to the 
product directory as the data under the 
Workstation key in the registry. See 
on-line help for more details.

Run the Windows Registry Editor and add a 
Directory string to HKEY_CURRENT_USER\
Software\Attachmate\Accessory Manager\
Workstation. The value for this string should be the 
path to the executable files (for example, 
C:\INFOCN32\ACCMGR32).

Unable to open this file Specify a new file to open.

Unable to read from this file Specify a new file to read.

Unable to read this file Specify a new file to read.

Unable to retrieve report format 
information from the host. Mapper LZ 
command failed.

Check the value of the MAPRequestLineZero 
option in the UTS OPTIONS key in the Windows 
registry.

Unable to Transmit Check all transmission settings and try again.
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You are not on a valid MAPPER Report. 
Please open a MAPPER Report and try 
again. 

Ensure that you have a valid MAPPER report open 
in order to complete this procedure.

Your destination disk does not have 
enough space to accommodate the data to 
be downloaded from the host. Do you 
wish to continue?

Choose to continue with the download, or cancel 
and specify a new destination or make additional 
space available.

Error Message Solution
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ALC Error Messages

The following table lists the error message that might appear 
while you are using ALC and possible solution to this problems:

Error Message Solution

Model has changed. You must save these 
settings then re-start this session 

Finish selecting all the configuration options you want 
for this session, click Save Session from the File 
200 ALC Error Messages

for the new model to take effect. menu, and close the session. The next time you open 
the session, it will use the new model you selected.
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About Removing INFOConnect Packages

You can remove either a single package (such as PEP) or all 
INFOConnect packages, including INFOConnect Connectivity 
Services.

In a shared installation, you can remove access to all 
INFOConnect packages at the networked PC. In this case, the 
products will no longer be accessible at that PC, but they remain 
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installed on the file server, and all other users will still be able to 
share the products.

In a multi-user installation, you can remove access to all 
INFOConnect packages for a particular user. In this case, the 
products will no longer be accessible to that user, but they remain 
installed on the PC, and all other users will still be able to share 
the products.

When you remove all packages, your INFOConnect database is 
deleted. Reinstalling your packages will not restore any paths that 
previously existed in the database.
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Removing a Single INFOConnect Package

To remove a single INFOConnect package, follow these steps.

This procedure applies to standalone installations and shared and 
multi-user installations when the administrator is removing the 
package for all users.

1 Start the INFOConnect Manager.
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If you’re using Windows 95 or Windows NT 4.0, click the Start 
button, point to Programs, point to INFOConnect 32-bit, and click 
Manager.

If you’re using Windows NT 3.51, double-click Manager in the 
INFOConnect 32-bit program group.

2 From the Install menu, click Packages.

3 Click the package to remove.

4 Click Delete.

5 If you’re removing a copy-protected package, you will be prompted 
to insert a disk for the copy protection unit. Type the letter of the 
disk drive that contains the disk where you want to store the unit.
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Removing All INFOConnect Products at a Networked PC

To remove all INFOConnect products from a PC that is sharing 
these products from a file server, do one of the following at the PC 
where NETSETUP was run.

■ If you’re using Windows 95 or Windows NT 3.51, click the Start 
button, point to Settings, and then click Control Panel. Double-
click Add/Remove Programs, and then double-click 
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INFOConnect Workstation.

■ If you’re using Windows NT 3.51, double-click Uninstall 
INFOConnect Workstation in the INFOConnect program 
group.

Note:  If these items do not appear in the Control Panel or 
program group, run NETSETUP.EXE /UNINSTALL from the 
shared INFOConnect folder on the file server.

These procedures remove the products only at the PC where 
NETSETUP was run; the products remain on the file server 
and can still be shared by all other users.
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Removing All INFOConnect Packages for a User

To remove all INFOConnect packages from a particular user in a 
multi-user installation, log onto the PC as that user and do one of 
the following:

■ If you’re using Windows 95 or Windows NT 4.0, click the Start 
button, point to Settings, and then click Control Panel. Double-
click Add/Remove Programs, and then double-click 
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INFOConnect Workstation.

■ If you’re using Windows NT 3.51, double-click Uninstall 
INFOConnect Workstation in the INFOConnect program 
group.

Note:  If these items do not appear in the Control Panel or 
program group, run USRSETUP.EXE /UNINSTALL from the 
INFOConnect folder. (Whether the user can access this folder is 
determined by the PC operating system and the user privileges 
specified by the PC administrator.)

These procedures remove access to the products only for the 
currently logged-on user; the products remain on the PC and 
can still be shared by all other users.
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Removing All INFOConnect Packages

To remove all INFOConnect packages, including INFOConnect 
Connectivity Services, do one of the following.

This procedure applies to standalone installations and shared and 
multi-user installations when the administrator is removing the 
package for all users.

■
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If you’re using Windows 95 or Windows NT 4.0, click the Start 
button, point to Settings, and then click Control Panel. Double-
click Add/Remove Programs, and then double-click 
INFOConnect 32-bit.

■ If you’re using Windows NT 3.51, double-click Uninstall 
INFOConnect 32-bit in the INFOConnect program group.

When you are prompted about removing all INFOConnect 
packages, click Yes.

If you are removing any copy-protected packages, you will be 
prompted to insert a disk for the copy protection unit. Type the 
letter of the disk drive that contains the disk where you want to 
store the unit.

Note:  If these items do not appear in the Control Panel or 
program group, go to your Windows folder and run 
ATM_RM_R.EXE /32.
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About Copy Protection

Attachmate’s INFOConnect products include a copy protection 
mechanism. When you install a copy-protected product, the copy 
protection unit is automatically installed on one of two places:

■ The Enable Security Adapter

■ The PC hard disk (if Enable is not used)
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Each copy protection unit allows the product to be run on a 
particular PC. It does not limit the number of sessions or other 
functions of the product. (You can also remove a copy-protected 
product from one PC and move it to another.)

You might experience problems with copy protection if any of the 
following situations occur:

■ You remove your Enable Security Adapter when copy 
protection units are still located on that hardware.

■ You replace or reformat your hard disk when copy protection 
units are still located on the disk.

■ You remove your communication adapter when copy protection 
units are still located on that hardware.

■ You try to re-install a copy-protected product that has already 
been installed once.

If you plan on removing your Enable hardware, hard disk, or 
communication adapter, or reformatting your hard disk, you must 
take one of the following actions:

■ Remove the product and put the copy protection unit on a 
floppy disk. Refer to Appendix D, “Removing 
INFOConnect Packages” for instructions on this procedure.

■ Move the copy protection unit to another location. Refer to 
“Moving Copy Protection Units” on page 209 for more 
information.
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Moving Copy Protection Units

To move copy protection units from one location to another, follow 
these steps:

1 Close any open INFOConnect paths and close the INFOConnect 
Manager.

2 Run the Unit Control Utility.
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If you’re using Windows 95 or Windows NT 4.0, click the Start 
button, point to Programs, point to INFOConnect, and click Unit 
Control Utility.

If you’re using Windows NT 3.51, double-click Unit Control Utility 
in the INFOConnect program group.

3 On the Device 1 dialog box, click the first device that you want to 
move copy protection units between.

For example, to move units between the Enable Security Adapter 
and your PC hard disk, you would click Enable on the Device 1 
dialog box.

This device is identified as Device 1 in the Unit Control Utility 
application window.

4 Click OK.

The Device 1 dialog box remains on the screen, and the Device 2 
dialog box appears.

5 Click the second device that you want to move copy protection 
units between.

For example, to move units between the Enable Security Adapter 
and your PC hard disk, you would click 1st Hard Drive on the 
Device 2 dialog box.

This device is identified as Device 2 in the Unit Control Utility 
application window.
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6 Click OK on the Device 2 dialog box.

Both Device 1 and Device 2 dialog boxes close, and the Unit 
Control Utility application window appears, displaying the 
number of copy protection units on each device.

7 Click the name of the product whose units you want to move.

8 Click the left arrow or right arrow between the Units text boxes to 
indicate which units to move.
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To move units from Device 2 to Device 1, click the left arrow. To 
move units from Device 1 to Device 2, click the right arrow.

9 Repeat steps 7 and 8 until you have specified how you want to 
move the desired copy protection units for all products.

To undo any changes you have made for a selected product, click 
that product and click Restore. To undo all the changes you have 
made for all the products, click Restore All.

10 Click Write.

If Confirm On Write is selected in the Options menu, click Yes 
when you are prompted about writing the copy protection units to 
the new device.

11 To exit the Unit Control Utility, click Exit from the File menu or 
press Alt+F4.
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Common Copy Protection Error Messages

The following table lists some common error messages generated 
by copy protection problems, as well as an explanation of their 
meaning and possible solutions. For help with any other copy 
protection (CP) error messages, contact Customer Support. 

Error Code Error Message Explanation
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CP501 Target media for units is 
full.

The location where the copy protection units 
would normally be stored is full. Remove any 
residual units for any unused products.

CP503 Overwriting newer units 
with older version is not 
permitted.

Once you install an upgrade of a particular 
product, you cannot reinstall a previous version 
of that product on the same PC until you deinstall 
the newer product.

CP504 Overwrite flag is false: 
attempt to overwrite 
older units failed.

Deinstall your existing product before installing a 
new version of that product.
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Accessory Manager An application that you can use to concurrently run different 
types of terminal emulators to connect to different types of hosts, 
all within a single framework.

Accessory Manager also provides access to editors that can be used 
to remap your PC keyboard, create and modify QuickPads, create 
and modify toolbars, and write and compile CASL macros.

accessory An application used with INFOConnect Connectivity Services to 
perform various functions.

PEP and InterCom are both accessories.

address bar The text box in the navigation bar where you type a URL.

blind key
programming

A mechanism for changing the function of a keystroke on a 
keyboard map without using the Keyboard Map Editor.

bookmark A recorded host screen that you have identified as one that you 
want to access directly.
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CASL macro A series of instructions for performing specified tasks 
automatically.

These instructions use a special script language called the 
Common Accessory Script Language (CASL).

CASL Macro Editor An Accessory Manager program that you can use to create and 
edit CASL macros.

The CASL Macro Editor is similar to a text editor but also 
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provides menu items for compiling and running CASL macros.

category A collection of URLs.

A list of categories appears when you click Essentials on the 
navigation bar.

You can create and organize categories by clicking Essentials on 
the navigation bar and then clicking Add/Organize Essentials.

Categories are saved as .EUL files in your local or remote folder.

Common
Accessory Script
Language (CASL)

A special script language used in all CASL macros.

You can view or print a copy of the INFOConnect CASL Script 
Language Guide by installing Adobe® Acrobat® Reader, running 
Acrobat Reader, and opening the CASL20GD.PDF file.

combination
keystroke

A keystroke preceded by a Shift, Alt, or Ctrl, or any combination of 
those keystrokes.

For example, Alt+u, Ctrl+u, and Alt+Shift+u are all combination 
keystrokes.

connection type The communication mechanism used by the PC to establish a 
connection with a host.

Database Editor An application that you can use to add, modify, and delete 
INFOConnect paths or path-related components in your 
INFOConnect database.
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default keyboard
map

A keyboard map associated with a particular terminal type that 
appears in the bottom half of the Keyboard Map Editor application 
window.

When the default keyboard map is displayed, you can copy 
functions from the default keyboard map into the working 
keyboard map.

Enable Security
Adapter

A DB-25 male-to-female adapter used to store copy protection 
usage allowance units. This adapter connects to your PC’s female 
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DB-25 parallel printer port.

essentials One or more URLs that you can access by clicking Essentials on 
the navigation bar.

file transfer protocol A mechanism for exchanging files between a PC and a host.

Each file transfer protocol is suited to a particular purpose or host 
type.

home page The URL that first appears when you open a HiBrow session.

You can specify which home page to use when you configure 
HiBrow, and you can access the home page at any time by clicking 

on the navigation bar.

host A mainframe, mini-computer, or information hub with which the 
PC communicates.

HotSpot A portion of the session window that, when you double-click it 
using the left mouse button, transmits keystrokes, runs a macro, 
or performs other commands.

HotSpots can be either text-based or region-based.

INFOConnect
Accessory Manager

See Accessory Manager.

INFOConnect
Connectivity

Services

A package of INFOConnect products that includes the 
INFOConnect Manager and other INFOConnect software.
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INFOConnect
database

A file (IC32.CFG) usually located in the Windows directory that 
contains information about all the INFOConnect packages that 
have been installed, as well as all the path templates, library 
channels, and paths that have been created.

INFOConnect
Database Editor

See Database Editor.

INFOConnect The application that runs in the background each time you run an 
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Manager INFOConnect product and controls interaction between 
accessories and transports.

You can also use this application to create, modify, and delete 
paths; set administrator and user-level security; control user 
access to configuration; and set user preferences. The 
INFOConnect Manager also lets you switch between sessions, 
clear sessions, and view session status.

keyboard map A file that contains information about which keys perform which 
functions. Keyboard maps use the file extension .EKM.

Keyboard Map
Editor

An Accessory Manager program that you can use to create and 
edit keyboard maps.

The Keyboard Map Editor displays a graphical representation of a 
PC keyboard. You can drag-and-drop functions from one key to 
another, and from the default keyboard map to the working 
keyboard map. By double-clicking on a key on the keyboard map, 
you can assign keystrokes, macros, and other commands to keys.

layout file A file that contains complete Accessory Manager screen layouts, 
including all windows in their specified sizes and positions.

All layout files use the .AWL file extension.

local area network
(LAN)

A collection of interconnected PCs, printers, disk drives, and 
peripheral equipment that can share information with other 
computers on the network.

macro A series of instructions for performing specified tasks 
automatically. These instructions use a special script language 
called the Common Accessory Script Language (CASL).
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multi-user
installation

An installation mode in which the product files are installed in a 
location (usually a PC hard disk) that multiple users will access. 
The product can be configured differently for each user at the 
same PC.

navigation bar A toolbar that provides access to essentials and the address bar.

The navigation bar is not an .ETB file and cannot be modified 
using the Toolbar Editor or the Settings dialog box. However, you 
can specify whether to display the navigation bar and which items 
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to include on it by clicking Navigation Bar from the View menu 
and completing the Navigation Bar dialog box.

The navigation bar is not session-specific. It is available for all 
sessions, including InterCom, PEP, and other terminal emulation 
sessions.

path A named set of configuration data required to establish 
communication between the PC and a host.

QuickPad A small window that can contain text, icons, buttons, and other 
graphics. By clicking buttons and icons on a QuickPad, you can 
send keystrokes, run macros, or perform other functions.

QuickPad Editor An Accessory Manager program that you can use to create and 
edit QuickPads.

Using the QuickPad Editor, you can place objects on a QuickPad 
and configure the attributes associated with each object.

search page The URL that appears when you click on the toolbar.

You can specify which search page to use when you configure 
HiBrow.

session A named communication connection between a PC and a host that 
operates according to the configuration information contained in 
the session profile.

session profile A file that contains the configuration information for a session.
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shared installation An installation mode in which the product files are installed on a 
file server, and each user who wants to run the products runs a 
separate installation utility. A minimal number of required files 
and registry settings are copied to the networked PC, and product 
configuration and management is handled centrally by an 
administrator.

standalone
installation

An installation mode in which the product files are installed in a 
location (usually a PC hard disk) that a single user will access.
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terminal keystroke A keystroke that a terminal sends to a host. Some terminal 
keystrokes are common to all terminal tools. Other terminal 
keystrokes, such as FCCGenerate for PEP or Mark for InterCom, 
are unique to their terminal type.

terminal type A terminal emulation product. For example, the accessory PEP 
comes with three terminal types: UNISYS UTS20, UNISYS 
UTS40, and UNISYS UTS60.

translation table A file that indicates which characters should be switched for other 
characters. Translation tables can be used to translate data into 
European and Asian languages. They can also be used to modify 
data sent to a printer.

Several translation tables are provided with Accessory Manager; 
they have the file extensions .TBL and .XTB.

Unit Control Utility A program that you can use to move copy protection units from 
one location to another.
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Universal Resource
Locator (URL)

An Internet or intranet site address.

URLs typically starts with a protocol name followed by the 
organization that maintains the site. The suffix identifies the kind 
of organization. For example, http://www.attachmate.com 
identifies the Web server at Attachmate Corporation. The 
http://www indicates that it is a Web server that uses the http 
protocol, and the .com suffix identifies Attachmate as a 
commercial site. Generally, commercial URLs end with .com, 
educational URLs end with edu., military URLs end with .mil, and 
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government URLs end with .gov. 

If the URL points to a specific page, additional information—such 
as a port name, the directory in which the page is located, and the 
name of the page file—is included. Web pages authored using 
HTML (Hypertext Markup Language) often end with an .htm or 
.html extension.

working keyboard
map

The keyboard map that is currently being created or modified.
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2200 Series hosts, INFOConnect solutions 4
3270 terminal emulation (see EXTRA! Office 

for Accessory Manager)
5250 terminal emulation (see EXTRA! Office 

for Accessory Manager)

A
A Series hosts, INFOConnect solutions 3
A Series LAN Workstation 3
Accessing host screens (see Host screen 

recordings)
Accessories 166
Accessory Manager

error messages 174-193
overview 8
running 8
running the Database Editor from 46

ActiveTerm 41-42
ActiveX 41
Add Path Wizard 10
Administrator-level security, Database 

Editor 51-52
ALC 146-150

error messages 200
keyboard maps 147
keystrokes 148-150

ALC.ADP 9
ALC.EKM 147, 148-150

Application interface libraries 160
Application start-up macro 28
Application types 163

B
BKM files 38
Blind key programming 16-18
Bookmark files 33, 38
Bookmarks 33, 39

accessing 37-38

C
CANDE file transfer protocol 73-74

configuring 73
receiving a file 74
sending a file 74

CASL Macro Editor 30
CASL macros 28-30

CASL Macro Editor 30
creating 29-30
running 28

Click areas (see HotSpots)
Computer Reservation Systems, 

INFOConnect solutions (see also ALC) 6
Control mode keystrokes 70-71
Copy ICS Database Utility 55-56
Copy protection 208-211

error messages 211
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Copy protection, continued
moving copy protection units 209-210

D
Database Editor 46-52

running 46
security 51-52
shared installations 48-50
standalone installations 47
trees 48-50

External interface libraries, continued
A Series hosts 3
Computer Reservation Systems 6

EXTRA! Basic macros 136
EXTRA! Office for Accessory 

Manager 5, 132-136
E!OAM Merge Utility 132, 133-134

F
File transfer protocols
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DCP 4
DEC hosts 5
DEC terminal emulation (see EXTRA! Office 

for Accessory Manager)
Default keystrokes

ALC 148-150
InterCom 60-62
PEP 80-86

Default session profiles 9
Deinstalling packages 202-206
Distributed Communications Processor 

(DCP) 4
Downloading files

using the CANDE file transfer 
protocol 74

using the MAPPER file transfer 
protocol 129

using the OS2200 file transfer 
protocol 127

E
E!OAM (see EXTRA! Office for Accessory 

Manager)
Edit schemes 135
EDP files 135
Enable Security Adapter 208
EPP sessions 135
Error messages 174-199

Accessory Manager 174-193
ALC 200
copy protection 211
PEP 194-199

Essentials 142-143
EWL files 136
Explorer, Internet 41-42
Export/Import Utility 53-54
External interface libraries 160

2200 Series hosts 4

InterCom 73-74
PEP 126-129

File transfer schemes 135
FTP server 152

G
GI32.INI 133, 136
Groups

Database Editor 49-50
host screens 39

H
Handshake keyboard map (see HSW.EKM)
Help, online xii-xiii, 136
HiBrow 41, 138-144

displaying URLs 141
keystrokes 144

HLC 4
HLCNTS 3
Home page 141
Hook libraries 160
Host Internet Browser (see HiBrow)
Host LAN Controller (HLC) 4
Host screen recordings 31-40

accessing host screens 37
copying 40
creating groups of host screens 39
how it works 32
modifying 39-39
recording delay 34
recording host screens 35-36
renaming host screens 39

HotSpots 25-27
appearance 26
creating 26
how they work 26-27
PEP 130
region HotSpots 25
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HotSpots, continued
schemes 26
text HotSpots 25

HSW.EKM 59, 66-69

I
IBM hosts 5
IBM terminal emulation (see EXTRA! Office 

for Accessory Manager)
IC32.CFG 157

Keyboard maps, continued
Keyboard Map Editor 15, 24
loading 14
PEP 79

KeyMaps (see Keyboard maps)
Keys, programming 16-18
Keystrokes

ALC 148-150
HiBrow 144
InterCom 60-71
PEP 80-124
223

INFOConnect ALC (see ALC)
INFOConnect Connectivity Services 156
INFOConnect database 157

copying 55-56
exporting and importing data 53-54

INFOConnect Database Editor (see Database 
Editor)

INFOConnect Host Internet Browser (see 
HiBrow)

INFOConnect InterCom (see InterCom)
INFOConnect Manager 156, 158-159

running 158
tracing a session 171-172
using 158-159

INFOConnect PEP (see PEP)
INFOConnect WinFTP 152-154
INT1 4
InterCom 58-76

file transfer protocols 73-74
InterCom Print Services 75-76
keyboard maps 59
keystrokes 60-71
QuickPads 72

InterCom Print Services 75-76
InterCom Print Services Configuration 

Utility 76
Internet support 41-42
IPX/SPX 3, 4

K
Keyboard Map Editor 15, 24
Keyboard maps 13-18

ALC 147
creating 15
editing 15
EXTRA! Office for Accessory 

Manager 133, 135
InterCom 59

L
Lanyon NetBIOS Gateway Transport 6
Layout files 12

EWL files 136
LCW 3
Learn Mode 29
Libraries 160

2200 Series hosts 4, 4
A Series hosts 3
Computer Reservation Systems 6

Library channels 161
Linking applications 44
LINKUP.EKM 79, 117-124

M
Macros 28-30

associating with recorded host 
screens 39

CASL Macro Editor 30
creating 29-30
running 28

MAP132.EHS 130
MAP80.EHS 130
MAPPER file transfer protocol 126

configuring 126
receiving a file 129
sending a file 128

Merge Utility (see EXTRA! Office for 
Accessory Manager)

Messages, error 174-199, 211
MT.ADP 9

N
Navigation (see Host screen recordings)
Navigation bar 140
NetBIOS 3, 4
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Netscape Navigator 41
New Session Wizard 10
NORMAL.ADP 10

O
Object Linking and Embedding (OLE) 43-44
Online Help xii-xiii, 136
OS2200 file transfer protocol 126

configuring 126
receiving a file 127

QuickPads, continued
editing 20
EXTRA! Office for Accessory 

Manager 133, 135
InterCom 72
loading 20
PEP 125
QuickPad Editor 21

R
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sending a file 127

P
Packages 167

removing 202-206
Pages (see Host screen recordings)
Paste Special function 44
Path templates 162
Paths 10, 164-165

creating 46
database-level 50
deleting 46
exporting/importing 53-54
group-level 50
modifying 46
user-level 50

PEP 78-130
error messages 194-199
file transfer protocols 126-129
HotSpots 130
keyboard maps 79
keystrokes 80-124
QuickPads 125

PEPGate LAN Workstation 4
PEPWIN.EKM 79, 87-93
Poll/Select 3
Printer (EPP) sessions 135
Printer emulator 75
Printing, using InterCom Print Services 75
Programming keys 16-18
Properties dialog box 136

Q
QuickPad Editor 21
QuickPads 19-21

associating with recorded host 
screens 39

creating 20

Receiving files
using the CANDE file transfer 

protocol 74
using the MAPPER file transfer 

protocol 129
using the OS2200 file transfer 

protocol 127
using WinFTP 154

Recording host screens (see Host screen 
recordings)

Region HotSpots 25
Removing packages 202-206

S
Schemes

associating with recorded host 
screens 39

edit schemes 135
EXTRA! Office for Accessory 

Manager 133, 135
file transfer schemes 135
HotSpots 26

Search page 141
Security, Database Editor 51-52
Sending files

using the CANDE file transfer 
protocol 74

using the MAPPER file transfer 
protocol 128

using the OS2200 file transfer 
protocol 127

using WinFTP 154
Service libraries 160

2200 Series hosts 4
A Series hosts 3

Session profiles 9-10
default 9
NORMAL session profile 10
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Session start-up macro 28
Sessions 9-11

creating 10
opening 11, 12
session window 11
tracing 171-172

Shared installations
Database Editor 48-50

STEPDOS.EKM 79, 109-116

Troubleshooting, continued
tracing a session 171-172

U
UDP for TPF Transport 6
Uninstalling packages 202-206
Uniscope 4
Unit Control Utility 209-210
UNIX hosts 5
UNIX terminal emulation (see EXTRA! Office 
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T
T 27 terminal emulation (see InterCom)
T27.EKM 59, 63-65
TCP/IP 3, 4, 5
TCP-A 3
Telcon 4
Text HotSpots 25
Toolbars 22-24

associating with recorded host 
screens 39

creating 23
editing 23
EXTRA! Office for Accessory 

Manager 133, 135
HiBrow 140
loading 23

TOOLCOMP.INI 133, 136
TP0/RFC1006 4
Tracing a session 171-172
Transferring files (see Receiving files, 

Sending files)
Transports

2200 Series hosts 4, 4
A Series hosts 3
Computer Reservation Systems 6
online Help xiii

Trees, Database Editor 48-50
Troubleshooting

general procedures 170

for Accessory Manager)
Uploading files

using the CANDE file transfer 
protocol 74

using the MAPPER file transfer 
protocol 128

using the OS2200 file transfer 
protocol 127

URLs, displaying 141
User-level security, Database Editor 51-52
Users, Database Editor 48-50
Utilities

Copy ICS Database Utility 55-56
E!OAM Merge Utility 133-134
Export/Import Utility 53-54

UTS 20/40/60 terminal emulation (see PEP)
UTS60.ADP 9
UTSDOS.EKM 79, 101-108
UTSWIN.EKM 79, 94-100

V
VT terminal emulation (see EXTRA! Office for 

Accessory Manager)

W
Web support 41-42
WinFTP 152-154
Wizards 10





We’d Like to Hear from You

After you have had a chance to use the documentation and/or 
online Help for this product, please take a moment to give us your 
comments. Please respond to the questions below, and return this 
form (or send comments via Internet E-mail) to Attachmate at 
your convenience. Thank you.

✔ What Attachmate product(s) are you using? (Please provide 

version numbers also.)
_____________________________________________________________

✔ What documentation do you refer to most often?
____ Manual ____ Online Help

✔ What chapters or Help topics do you refer to most often?
_____________________________________________________________

✔ How often do you expect to refer to the manual?
____ Often ____ Occasionally ____ Never

The online Help?
____ Often ____ Occasionally ____ Never

✔ How is the level of detail in the manual?
____ Too little ____ Just right ____ Too much

In the online Help?
____ Too little ____ Just right ____ Too much

✔ Does the documentation adequately explain how to install and 
configure the product?
____ Yes ____ No

If not, what information is missing?
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________

✔ How do you normally search for information in a manual?
____ Scan ____ Table of contents ____ Index



✔ Was there an index entry you looked for but couldn’t find?
____ Yes ____ No

If so, what was it? ____________________________________________

✔ Did you find any errors in the manual or online Help?
____ Yes ____ No

If so, please list the page number or online Help topic, and 

describe the error:
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________

✔ Any other comments about the manual or online Help?
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________

Please tell us 
about your 
yourself (optional)

Name: ______________________________________________________
Company name: _____________________________________________
Your title/position:___________________________________________
Years of PC experience: ______________________________________
Address: ____________________________________________________
____________________________________________________________
Country: _____________________ Phone:_______________________
E-mail address: _____________________________________________

May we contact 
you?

____ Yes ____ No

Send your 
comments

Please send your comments in any of the following ways:

By Mail: Attachmate
Attn: Documentation Manager
8230 Montgomery Road
Cincinnati, OH 45236-2200
U.S.A.

By Fax: (513) 745-0327

By Internet E-mail: docs@attachmate.com
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